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About this document

This document describes how to use the Preside Multiservice Data Manager 
Nodal Provisioning and Embedded Nodal Provisioning applications. 

Nodal Provisioning provides a graphical user interface for provisioning 
Passport components and selected services. Nodal Provisioning is intended 
for making large provisioning changes.

Embedded Nodal provisioning is launched from Passport Shelf View and lets 
you access a subset of the Nodal Provisioning functionality to make simple or 
limited provisioning changes to a node. This access is useful in 
troubleshooting situations where you want to change a few components or 
attributes. 

In this document, references to Passport refer to Passport 7400, Passport 
15000, and Passport 20000 devices.

The following topics are discussed in this section:

• “Who should read this document and why” (page 20)

• “What you need to know” (page 20)

• “How this document is organized” (page 20)

• “What’s new in this document” (page 20)

• “Text conventions” (page 22)

• “Related documents” (page 24)
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Who should read this document and why
You should read this document if you are responsible for managing and 
provisioning Passport devices with the Preside Multiservice Data Manager 
Nodal Provisioning application.

What you need to know
This document assumes that you have knowledge of the Preside Multiservice 
Data Manager and an understanding of the device being provisioned.

How this document is organized
This document contains the following sections:

• “Nodal provisioning overview” (page 25) 

• “Starting Nodal Provisioning” (page 37) 

• “Component tree view” (page 63)

• “Shelf view for Passport nodes” (page 85)

• “Nodal Provisioning forms” (page 107)

• “Navigating component hierarchy and shelf view” (page 117)

• “Component provisioning procedures overview” (page 149)

• “Post-provisioning procedures” (page 219)

• “Nodal Provisioning Template Editor” (page 227)

• “Template Generator” (page 321)

• “Report Generator” (page 329)

• “Embedded Nodal Provisioning” (page 379)

What’s new in this document
This document has been updated to include the following features:

• “Nodal Provisioning Enhancements” (page 21)

• “Nodal Provisioning Template from Existing Component” (page 21)

• “Operator Client” (page 22)

• “MPE Configuration Management” (page 22)
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• “NP Template for MPE” (page 22)

Nodal Provisioning Enhancements
This feature includes the following provisioning enhancements:

• the ability to preload an Edit view, see “Opening a view or configuration” 
(page 52) and “Setting User Preferences” (page 207).

• a more efficient method for preloading a view file. Where a backup 
server has been configured, Nodal Provisioning loads a view from the 
backup site rather than from the node. This method avoids a large amount 
of network traffic, particularly when there are a large number of journal 
files and reduces the impact on the device.

• a more efficient copy and paste method when these actions occur within 
a device. Nodal Provisioning now uses the Passport on-switch copy 
function. This method avoids cross interference of copied components 
and sets appropriate attribute values.

• a warning message when you attempt to save a view with a dated key 
older than the existing file, see “Opening a view or configuration” 
(page 52), “Saving the view for Passport devices” (page 220), and 
“Setting User Preferences” (page 207).

• the ability in Embedded Nodal Provisioning to edit subcomponents of an 
added component, see “Adding a subcomponent using the Shelf View 
tools” (page 416), “Adding a subcomponent using Embedded Nodal 
Provisioning” (page 419) and “Embedded Nodal Provisioning dialog 
boxes” (page 409).

Nodal Provisioning Template from Existing Component
This feature includes the following enhancements:

• In the Nodal Provisioning interface, the ability to generate a template 
based on an existing provisioned component. All the values of the 
attributes of the component and its subcomponents are preserved in the 
new template.

• In the Nodal Provisioning interface, the ability to edit and save an 
existing template from the main window.

• The ability to use Service Selection to run the Nodal Provisioning 
Template Editor from any workstation.
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• In the Nodal Provisioning Template Editor, the ability to add the first 
component without specifying a dropsite. If a non-root level component 
is placed, its parent designation will always be prompted. In addition, a 
component designation can be changed at any time. If this results in an 
error, the Nodal Provisioning Template Editor will prompt the user 
through the correction process.

Operator Client
Operator Client is a Java-based application that provides a common desktop 
environment to run a subset of Preside Multiservice Data Manager 
applications on both Windows and Solaris platforms. Operator client supports 
the Nodal Provisioning, Embedded Nodal Provisioning, and Nodal 
Provisioning Template Editor tools. Concepts and procedures were modified 
throughout the document, as required.

MPE Configuration Management
The Multiservice Provider Edge (MPE) Configuration Management feature 
adds MPE support to MDM configuration, network reporting, and backup 
and restore tools. This feature includes modifications to Nodal Provisioning 
and Embedded Nodal Provisioning to support the creation and modification 
of MPE configuration tasks. Concepts and procedures were modified 
throughout the document, as required.

NP Template for MPE
This feature extends the Nodal Provisioning template functionality to support 
Nortel Networks Multiservice Provider Edge 9500. Procedures were 
modified in “Nodal Provisioning Template Editor” (page 227), as required.

Text conventions
This document uses the following text conventions: 

• nonproportional spaced bold type

Nonproportional spaced bold type represents words that you should type 
or that you should select on the screen.
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• italics

Statements that appear in italics in a procedure explain the results of a 
particular step and appear immediately following the step.

Words that appear in italics in text are for naming.

• [optional_parameter]

Words in square brackets represent optional parameters. The command 
can be entered with or without the words in the square brackets.

• <general_term>

Words in angle brackets represent variables which are to be replaced with 
specific values.

• UPPERCASE, lowercase

Uppercase and lowercase letters that appear in UNIX commands and 
parameters must be matched exactly. The system matches upper and 
lowercase characters differently.

• |

This symbol separates items from which you may select one; for 
example, ON|OFF indicates that you may specify ON or OFF. If you do 
not make a choice, a default ON is assumed.

• ...

Three dots in a command indicate that the parameter may be repeated 
more than once in succession.

The term absolute pathname refers to the full specification of a path starting 
from the root directory. Absolute pathnames always begin with the slash ( / )
symbol. A relative pathname takes the current directory as its starting point, 
and starts with any alphanumeric character (other than /).
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Related documents
See the following documents for related information:

• 241-6001-100 Preside MDM Installation

• 241-6001-303 Preside MDM Administrator Guide

• 241-6001-310 Preside MDM Server Reference Guide

• 241-6001-600 Preside MDM Service Provisioning for ATM User Guide

• 241-6001-603 Preside MDM Service Provisioning for Frame Relay User 
Guide

• 241-6001-611 Preside MDM Nodal and Service Provisioning Reference 
Guide

• 241-6001-616 Preside MDM IP VPN Service Configuration User Guide

• 241-6001-801 Preside MDM Overview

• NN10600-060 Nortel Networks Multiservice Switch 7400/15000/20000 
Component Reference
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Chapter 1
Nodal provisioning overview

Nodal Provisioning is part of the Preside Multiservice Data Manager (MDM) 
set of configuration management tools. Use this tool to provision components 
and selected services and to create service templates. You can create new 
configurations or modify existing configurations.

Nodal Provisioning supports Passport and Nortel Networks Multiservice 
Provider Edge (MPE) network elements. The Nodal Provisioning tool is 
available through both the MDM Toolset and Operator Client environments. 
For details about these MDM environments, see 241-6001-801 Preside MDM 
Overview.

Navigation
• “Tool fundamentals” (page 25)

• “Capabilities” (page 26)

• “Nodal Provisioning architecture” (page 28)

• “Date Convention” (page 34)

• “Help options” (page 35)

Tool fundamentals
The Nodal Provisioning tool lets you view and provision a node’s 
components and services as well as create service templates. You can 
provision one device for each Nodal Provisioning session. To provision more 
than one device, you need to start another instance of Nodal Provisioning. 
With the Nodal Provisioning tool, you can create new configurations or 
modify existing configurations. 
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Nodal Provisioning provides details about a node’s component hierarchy 
using the component tree view. For Passport devices, you also have the option 
of viewing the node’s physical and logical representation using the shelf view. 
You can make provisioning changes from either view. Nodal Provisioning 
also provides a palette of service templates for provisioning a service on a 
selected device. The templates streamline the creation of a service by dealing 
with only the critical subset of component data.

To aid with provisioning changes, you can use cut, copy, and paste operations 
on components and subcomponents within and between supported devices. 
You can also set your own preferences for a selection of Nodal Provisioning 
settings. These user preference are specific to your user ID and remain in 
effect until you reset them.

The Nodal Provisioning Report Generator lets you create, compare, and save 
custom reports on component data. The Log Viewer lets you log and view 
real-time error and states.

Provisioning changes do not affect the operation of the device until you 
activate the configuration.

Capabilities
The Nodal Provisioning provides the following capabilities:

• “Component provisioning” (page 26)

• “Service provisioning” (page 27)

• “Service template creation” (page 27)

• “Component template generation” (page 28)

Component provisioning
You can create and edit components using Nodal Provisioning. Component 
creation forms let you add a single component or multiple instances of a 
component to the component hierarchy. Component edit forms let you edit a 
single component instance. For a description of the these forms, see 
“Component forms” (page 109).
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Service provisioning 
You can create and edit services using Nodal Provisioning’s palette of service 
templates for the following services:

• ATM access 

• VPN FR DTE access 

• Frame Relay access

• Succession services (UA-ALL1 and PT-AL)

• MPLS Infrastructure and Services 

To add a service, you use drag and drop operations to apply a template to a 
valid dropsite in the component hierarchy. When you do so, a service creation 
form opens with the provisionable attributes for the components in the 
service. Only those attributes that you need to provision are visible. All other 
component attributes are handled by the provisioning software. You also use 
the service creation form to add multiple instances of a service. For a 
description of the service creation form, see “Service template form for 
Passport devices” (page 112). For information on how to provision specific 
services, and a description of the service templates for each service, see 
241-6001-611 Preside MDM Nodal and Service Provisioning Reference 
Guide

To edit a provisioned service (such as ATMIf) you use the service edit form. 
This form contains all the components in the service, and displays the 
attributes that you can provision. You can edit only those services that 
correspond to a single sub-tree in the component hierarchy (for example, 
FRUNI and ATMIF). For a description of the service form, see the section 
“Service edit form for Passport devices” (page 115).

Service template creation
To create and modify your own service templates, use the Nodal Provisioning 
Template Editor. These templates, as well as the templates created by Nortel 
Networks, appear in the service template palette of the Nodal Provisioning 
window. For information on the template editor, see “Nodal Provisioning 
Template Editor” (page 227).
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Component template generation
You can generate a template from an existing provisioned component on a 
node. The template can be used to quickly configure other similar 
components on the same or other nodes. For information on the template 
editor, see “Template Generator” (page 321).

Service selection
You can set a service selection from both the Toolset and Operator Client 
environments. System-wide settings are determined by the network 
administrator, but you can set a user service selection for the duration of your 
session. For details about service selection, see the section about using the 
Service Selection tool in 241-6001-303 Preside MDM Administrator Guide.

If a service selection change occurs during a Nodal Provisioning, Embedded 
Nodal Provisioning, or Nodal Provisioning Template Editor session, these 
tools retain their communication with the original CONFIGMAN server for 
the duration of the session. The next time you start any of these tools, the new 
service selection host is used.

Nodal Provisioning architecture
For an illustration of the generic Nodal Provisioning architecture, see the 
figure “Nodal Provisioning architecture” (page 29). For details about device-
specific architecture, see the following sections:

• “Passport Nodal Provisioning architecture” (page 30)

• “MPE Nodal Provisioning architecture” (page 33)
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Figure 1
Nodal Provisioning architecture
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Passport Nodal Provisioning architecture
For an overview of the Nodal Provisioning architecture, see the following 
sections:

• “Nodal Provisioning graphical user interface” (page 30)

• “Configuration manager” (page 30)

• “Passport configuration server” (page 31)

• “Passport configuration access provider” (page 31)

• “Passport component model generator” (page 31) 

• “Passport model files” (page 32)

• “Nodal Provisioning Template Editor” (page 32)

• “Nodal Provisioning Template Generator” (page 33)

Nodal Provisioning graphical user interface
For a description of the Nodal Provisioning user interface, see the following 
sections:

• “Component tree view” (page 63)

• “Shelf view for Passport nodes” (page 85)

• “Nodal Provisioning forms” (page 107)

• “Nodal Provisioning Template Editor” (page 227)

• “Template Generator” (page 321)

 Configuration manager 
The configuration manager server for Nodal Provisioning supported devices 
nodes is the Nodal Provisioning Configuration Manager (CONFIGMAN) 
server. It provides configuration services and associated templates for the user 
interface. It also communicates with the Host Group Directory Server 
(HGDS) to get the host/node groups and members for managed devices. 

The CONFIGMAN server is selected using the Service Selection tool. For 
details about selecting a configuration manager server host, see the Service 
Selection tool section in 241-6001-303 Preside MDM Administrator Guide. 
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For details about the CONFIGMAN server, see the Nodal Provisioning 
Configuration Manager (CONFIGMAN) section in 241-6001-310 Preside 
MDM Server Reference Guide.

Passport configuration server 
The configuration server for Passport nodes is the Passport Nodal 
Provisioning Configuration Server (PCSERVER). This server connects to 
devices and translates configuration requests from the configuration manager 
server to device specific messages and vice versa. The PCSERVER also 
creates and manages the Passport configuration providers. This server also 
receives view activation alarms from Passport nodes.

For additional information on the configuration server, see the Passport Nodal 
Provisioning Configuration Server (PCSERVER) section in 241-6001-310 
Preside MDM Server Reference Guide.

Passport configuration access provider
The configuration access provider for Passport nodes is Passport 
Configuration Providers. Multiservice Provider Edge. The provider is created 
and managed by the Passport Nodal Provisioning Configuration Server 
(PCSERVER). Each configuration provider accesses a single node. It 
communicates with the node and provides all the functions related to 
configuration including loading, modifying, or saving the view. It also 
generates the model data files that are used by the Configuration Manager, the 
user interface, and other Preside Multiservice Data Manager configuration 
management applications.

Passport component model generator
The Passport component model generator receives and converts device-
specific component descriptions to component models that are used by the 
configuration manager and user interface. The standard format is based on 
eXtensible Markup Language (XML).

The attribute information for each type of component that can be configured 
on the device is used by the user interface to create a component form for that 
component, or to display a subset of the attributes for the component in a 
service template form.
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Passport model files
Passport model files are an XML representation of the attributes that make up 
a component or service. There are four types of models:

• Component model contains data description and the attribute information 
for each type of component that can be configured on the device. These 
files are used to create the component forms or to display a subset of a 
component’s attributes in a service template form.

• Hierarchy model contains the hierarchical relationship between 
components in a device.

• Service model describes a service that can be configured generically for 
a device. It contains information about components that make up the 
service.

• Service template model defines the specific attribute values that are used 
in creating an instance of a service. The service template model also 
defines the acceptable drop points for the service and whether the 
dropsite is the parent of the service, or a component to which the service 
is linked.

The component and hierarchy models are generated by the Passport model 
generator. The service and service template models are generated manually. 

Nodal Provisioning Template Editor
The Nodal Provisioning Template Editor is designed for advanced users who 
want to create new templates or modify existing templates. The template 
editor uses templates that are based on existing model files. If a service has a 
service model, you can create and modify the templates for that service. 

The template editor is data driven and uses the XML formatted service 
template (.st) files as input. Service template files are installed with the 
Preside Multiservice Data Manager (MDM). 

You can install and run the Nodal Provisioning Template Editor on any MDM 
workstation, or you can install in on the server workstation and run it on a 
client workstation.
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Nodal Provisioning Template Generator
The Nodal Provisioning Template Generator is a feature of the Nodal 
Provisioning tool. It provides a graphical user interface for generating 
templates based on the existing provisioned components on a node. All values 
of the attributes of the existing component and its subcomponents are 
preserved in the new template. The template can then be used to quickly 
configure other like components on the same node or other nodes.

The Nodal Provisioning Template Generator is designed for expert users who 
want to copy the configuration of an existing component and use it in a 
template for later use.

MPE Nodal Provisioning architecture
For an overview of the Nodal Provisioning architecture, see the following 
sections:

• “Nodal Provisioning graphical user interface” (page 30)

• “Configuration manager” (page 30)

• “MPE configuration server” (page 33)

• “MPE configuration access provider” (page 34)

•  “MPE component model retriever” (page 34)

• “MPE component model generator” (page 34)

• “MPE model files” (page 34)

MPE configuration server 
The configuration server for Nortel Networks Multiservice Provider Edge 
(MPE) network elements is the MPE Nodal Provisioning Configuration 
Server (NCSERVER). The NCSERVER creates and manages the MPE 
configuration access providers. This server also receives commit alarms from 
MPE network elements.

For additional information on the configuration server, see the MPE Nodal 
Provisioning Configuration Server (NCSERVER) section in 241-6001-310 
Preside MDM Server Reference Guide.
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MPE configuration access provider
The configuration access provider for Nortel Networks Multiservice Provider 
Edge (MPE) network elements is handled by the MPE Configuration Access 
Provider (NCAP). The provider is created and managed by the MPE Nodal 
Provisioning Configuration Server (NCSERVER).NCAP is a client/server 
process that communications with a specific MPE and provides all the 
functions related to configuration including loading, modifying, or saving the 
configuration.

MPE component model retriever
The MPE component model retriever obtains the specified model version 
from MPE network elements. The retriever then starts the model generation 
process. 

MPE component model generator
The MPE model generator creates the model files required by servers, 
graphical user interfaces, and a selection of other MDM tools.

MPE model files
Nortel Networks Multiservice Provider Edge (MPE) model files are retrieved 
and created by the mpegetmod and mpegenmod utilities. These utilities run 
automatically to create and deliver model files to the Nodal Provisioning 
Configuration Manager (CONFIGMAN) server.

Date Convention
To account for the year 2000 and beyond, when years are shown as two-digit 
numbers, for example in the format yymmdd, the following conventions 
apply: 

• Years 80 to 99 represent the twentieth century. For example, 800101 
represents January 1, 1980.

• Years 00 to 79 represent the twenty-first century. For example 010101 
represents January 1, 2001.
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 Help options
Help is available in most Preside Multiservice Data Manager tools from either 
a Help button or a Help menu item. General descriptive help is available for 
the main windows and many of the dialogs. General descriptive help provides 
information about the window or dialog box. It describes the user interface, 
menus and tool-bars.

Nodal Provisioning also provides the following types of help:

• attribute level help is accessed from a pop-up menu. The attribute help is 
displayed in a separate dialog and is based on the selected field. See the 
section “Displaying help on attributes” (page 146).

Note: Not all attributes have attribute help.

• tool tip help provides valid data ranges for some fields. Where the range 
is large, or not easily quantified, you are provided a text field in which to 
enter the information. When you save, the data that you entered is 
validated against the range specified in the model. See the section 
“Displaying tool tips for attribute ranges” (page 148).

Nodal Provisioning and Nodal Provisioning Template Editor provide various 
types of help. For information on using the help options, see “Displaying 
online help” (page 144). 
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Starting Nodal Provisioning

This section provides procedures for starting Nodal Provisioning. For more 
information, see:

• “Task list” (page 37)

• “Procedures” (page 38)

Task list
The task to start the Preside Multiservice Data Manager (MDM) Nodal 
Provisioning tool consists of the following procedures:

• “Choosing a starting point” (page 39)

• “Selecting a device” (page 48)

• “Authenticating to a device” (page 50)

• “Opening a view or configuration” (page 52)

• “Selecting a CDL version” (page 61), if required
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Procedures
• “Choosing a starting point” (page 39)

— “Starting Nodal Provisioning from the MDM Toolset” (page 40)

— “Starting Nodal Provisioning from the Operator Client” (page 41)

— “Starting Nodal Provisioning from a UNIX command line” 
(page 42)

— “Starting Nodal Provisioning from the service provisioning tools in 
MDM Toolset” (page 45)

— “Starting Nodal Provisioning from the fault management tools” 
(page 46)

• “Selecting a device” (page 48)

• “Authenticating to a device” (page 50)

• “Opening a view or configuration” (page 52)

• “Selecting a CDL version” (page 61)
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Choosing a starting point
There are various ways you can start Nodal Provisioning. You can start Nodal 
Provisioning from the MDM Toolset, Operator Client, and UNIX 
environments. You can also start Nodal Provisioning from the MDM service 
provisioning tools and a selection of fault management tools. 

To start Nodal 
Provisioning from...

Use the procedure...

MDM Toolset “Starting Nodal Provisioning from the MDM 
Toolset” (page 40)

Operator Client “Starting Nodal Provisioning from the Operator 
Client” (page 41)

UNIX command line “Starting Nodal Provisioning from a UNIX 
command line” (page 42)

MDM service provisioning 
tools

“Starting Nodal Provisioning from the service 
provisioning tools in MDM Toolset” (page 45)

MDM fault management 
tools

“Starting Nodal Provisioning from the fault 
management tools” (page 46)
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Starting Nodal Provisioning from the MDM Toolset 
You can start Nodal Provisioning from the Preside Multiservice Data 
Manager (MDM) Toolset window. Nodal Provisioning opens without 
component context, so you need to identify the node you want to provision. 

If you require a Configuration Management server other than the default, see 
“Service selection” (page 28). 

Procedure steps
1 Select one of the following actions, depending on the device you want to 

provision. 

The Nodal Provisioning - Device Selection dialog box opens.

2 Go to “Selecting a device” (page 48).

For... On the MDM Toolset window...

Passport Click Configuration, Passport, and then Nodal 
Provisioning.

MPE Click Configuration, MPE, and then Nodal 
Provisioning.
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Starting Nodal Provisioning from the Operator Client
You can start Nodal Provisioning from the MDM Operator Client 
environment. Nodal Provisioning opens without component context, so you 
need to identify the node you want to provision.

If you require a Configuration Management server other than the default, see 
“Service selection” (page 28). 

Procedure steps
1 Select one of the following actions, depending on the device you want to 

provision. 

The Nodal Provisioning - Device Selection dialog box opens.

2 Go to “Selecting a device” (page 48).

For... On the Operator Client Configuration menu...

Passport Click Passport Nodal Provisioning.

MPE Click MPE Nodal Provisioning.
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Starting Nodal Provisioning from a UNIX command line
You can start the nodal provisioning script without variables or with any 
combination of variables that are appropriate to the node type. 

If you do not specify any variables and you have predefined user preferences, 
Nodal Provisioning uses those preferences to open a provisioning session. 
Otherwise, Nodal Provisioning uses the default preferences 

If you do specify variables, their values override any predefined user 
preferences. For details about user preferences and how to set them, see 
“Setting User Preferences” (page 207). If you specify all the required 
variables when starting the nodal provisioning script and those values are 
correct, the Nodal Provisioning window opens. If you specify some variables, 
dialog boxes may open and prompt for required information. If the specified 
variables include the component name, Nodal Provisioning opens with 
component context. In this case, the Nodal Provisioning window opens with 
the relevant component information. 

Procedure steps
1 Use one of the following UNIX command lines from either the client 

workstation or the workstation where the Preside Multiservice Data 
Manager server is located. 
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For details about the command line variables, see the table “Variable 
definitions” (page 43).

Variable definitions

For... Use the command....

Passport /opt/MagellanNMS/bin/anpui
[-emcomp <node name> [component full name>]]
[-auth <group> <user ID> <password>]
[-loadview <view mode> <view name>]
[-access <ro | rw>]
[-action <select | edit>
[-help]

MPE /opt/MagellanNMS/bin/anpui
-devicetype SRS
[-emcomp <node name> [component full name>]]
[-auth <group> <user ID> <password>]
[-opencurrent | -rollback <relative rollback number> |

-loadview [key | date | user <name>]]
[-access <ro | rw>]
[-action <select | edit>
[-help]

Variable Value Applies to

Passport MPE

-access <ro | rw> specifies a configuration access 
mode of read-only (ro) or read-write 
(rw). 

x x

-action <edit | select> specifies how Nodal Provisioning 
opens. The edit option opens Nodal 
Provisioning with a component form 
displayed. The select option opens 
Nodal Provisioning with the 
specified component selected in 
the component tree view.

x x

 (Sheet 1 of 2)
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-auth <group> <userid> 
<password>

specifies the appropriate HGDS 
group, user ID, and password for 
authenticating to a specified node.

x x

-devicetype SRS specifies an MPE node. You need 
to specify -devicetype SRS for 
MPE, otherwise a device type of 
Passport is assumed.

x

-emcomp <node name>
[<component name>]

specifies the node name or the 
node name and the full component 
identifier of the device to which you 
want to connect, for example:
-emcomp EM/LONDON
-emcomp EM/LONDON AtmIf/11
-emcomp SRS/ WEST 
-emcomp SRS/WEST interfaces 

at-0/1:2

x x

-loadview <view mode> 
<view name>

specifies the service data view 
mode. Possible values for the view 
mode are commit, edit, current, key, 
date, or user. If you specify key, 
date, or user, then you also need to 
specify the view name.

x

-loadview [<key | date | 
user <name>]

specifies a named configuration 
file: Keyed, Dated, and User 
Specified. In all cases, the specified 
configuration file is stored in the 
user directory is loaded into MPE’s 
candidate configuration.

x

-opencurrent opens a configuration session 
based on a copy of the current 
running configuration.

x

-rollback <relative rollback 
number>

rolls back the configuration to the 
specified rollback number. The user 
ID needs sufficient privileges to 
load previous running 
configurations.

x

Variable Value Applies to

Passport MPE

 (Sheet 2 of 2)
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Starting Nodal Provisioning from the service provisioning 
tools in MDM Toolset

From the MDM Toolset environment, you can start Nodal Provisioning 
within any of the following service provisioning tools: 

• ATM 

• Frame Relay 

• IP VPN Service Provisioning

• IP VPN Provider Edge

Nodal Provisioning opens without component context, so you need to identify 
the node you want to provision.

If you require a Configuration Management server other than the default, see 
“Service selection” (page 28). 

Procedure steps
1 Start the desired service provisioning tool:

• To start the ATM service provisioning tool, see 241-6001-600 Preside 
MDM Service Provisioning for ATM User Guide.

• To start the Frame Relay service provisioning tool, see 241-6001-603 
Preside MDM Service Provisioning for Frame Relay User Guide.

• To start the IP VPN service provisioning tool, see 241-6001-616 
Preside MDM IP VPN Service Configuration User Guide.

2 On the Tools menu, click Nodal Provisioning.

The Nodal Provisioning - Device Selection dialog box opens. 

3 Go to “Selecting a device” (page 48).
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Starting Nodal Provisioning from the fault management 
tools

You can start the Nodal Provisioning tool from a selection of fault 
management tools. Nodal Provisioning opens with component context, 
displaying the specified node’s component information in the window.

If you require a Configuration Management server other than the default, see 
“Service selection” (page 28). 

Procedure steps
1 From a fault application listed in the preceding table, select a component, 

and then right-click.

A pop-up menu opens.

2 Select one of the following actions, depending on the device you want to 
provision. 

In MDM Toolset, you can start 
Nodal Provisioning from...

In Operator Client, you can start 
Nodal Provisioning from...

Network VIewer Network Browser

Alarm Display Alarm Display

Component Information Viewer Component Information Viewer

Passport Shelf View Passport Shelf View

MPE Shelf View MPE Shelf View

Network Status Bar

Component Status Bar

For... On the pop-up menu...

Passport Point to Start Tool, Configuration, and then click 
Nodal Provisioning

MPE Point to Start Tool, Configuration, and then click 
MPE Nodal Provisioning.
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The Group Authentication dialog box opens. 

3 Go to “Authenticating to a device” (page 50).
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Selecting a device
Select a device to identify which device you want to provision. You can select 
a device name from the list provided. However, if the network contains a large 
number of devices and you want to avoid scrolling through a long list, you can 
search the network based on certain criteria. By using search criteria, you can 
limit the list of device names.

Prerequisites
This procedure requires the following conditions:

• you have started Nodal Provisioning for the first time, or you have 
selected File -> New Device. 

Procedure steps
1 To use search criteria, omit this step and go to step 2. Otherwise, specify 

the device name directly. In the Device Name box, type or select a device 
name and then click OK.

An authentication dialog box opens. Go to “Authenticating to a device” 
(page 50).
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2 Click Search to expand the Nodal Provisioning - Device Selection 
dialog box.

3 In the Additional search capability panel, specify the search criteria:

• In the Device Name box, specify the device name search pattern. 
You can use wild-cards (*) in this search criteria.

• In the Max Num to Retrieve box, specify the maximum number of 
devices to retrieve. The default number is 100.

4 To start the retrieval, click Search.

The Search Results panel lists the device names that meet the search 
criteria.

5 In Search Results panel, click a device name.

6 Click OK.

An authentication dialog box opens. Go to “Authenticating to a device” 
(page 50).
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Authenticating to a device
Authenticating lets you access a group of nodes by using a valid user ID and 
password. 

Once you have successfully authenticated to a node within a group, then you 
do not have to authenticate to it again during your session. If you start Nodal 
Provisioning and specify a device that is already authenticated, then you will 
not be prompted with the Group Authentication dialog. In this case, omit this 
procedure and go to “Opening a view or configuration” (page 52). 

Prerequisites
This procedure requires the following conditions:

• Nodal Provisioning is started

• you have selected a device, either for the first time, or by clicking File 
-> New Device in the Nodal Provisioning window

• the Group Authentication dialog box is open

Procedure steps
1 In the Group Name field, select a group name from the drop-down list.

Depending on your previous activities and any defined preferences, the 
User ID and Password fields may be populated. If the entries are correct, 
go to step 4, otherwise continue with step 2 to edit the values.

2 In the User ID field, type a valid user ID or select a user ID from the drop-
down list.

3 In the Password field, type a valid password.

4 Click OK.

If the authentication is successful, the Open View dialog box opens, go to 
“Opening a view or configuration” (page 52).
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If the authentication fails, a message displays in the Group Authentication 
dialog. Click Details for information about the cause of failure. Correct the 
entries in the dialog box and click OK.
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Opening a view or configuration 
The dialog box that opens and the procedure that you need to use depend on 
the device type that you selected. Select one of the following procedures:

For... The dialog box that opens is... And the procedure to use 
is...

Passport Open View “Opening a view for Passport 
devices” (page 53)

MPE 9500 Open Configuration “Opening a configuration for 
MPE 9500 devices” (page 57)
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Opening a view for Passport devices
The Open View dialog box for Passport devices lets you specify the access 
and view modes, as well as preloading and log file options. Changes made in 
the Open View dialog box are valid for the duration of the provisioning 
session.

The Open View dialog box opens under the following circumstances:

• automatically, at start-up, after you successfully authenticate to a device

• automatically when you select the Open View command from the File 
menu

• when the preferences are set to always prompt when opening a view. For 
details, see “Setting User Preferences” (page 207).

If you have set and saved user preferences for the Open View, the Open View 
dialog box opens with these preferences. If you haven’t set user preferences, 
the dialog box opens with the default MDM settings. For information on 
setting user preferences, see the section “Setting User Preferences” 
(page 207).
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Figure 2
Open View dialog box

Procedure steps
1 In the Access Mode panel, select one of the following modes:

• Read and Write to modify the service data. 

• ReadOnly to view the provisioning data corresponding to the current 
operation of the node. You cannot perform any service data 
modifications while in this mode.

2 In the View Mode panel, upload one of the following service data views:

• Committed to upload the committed service data view.

• Current to upload the current service data view.

The access mode panel 
lets you specify whether 
or not you can modify 
the service data.

The View Mode panel 
lets you specify which 
service data view to 
upload. If you select 
Other you need to select 
a keyed, dated or user 
specified view.

The Other Options 
panel lets you turn 
automatic preloading on 
or off, select the option 
to propagate log files, 
and specify a location to 
store the log files.
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• Edit to upload the edit service data view. 

When a committed view is modified, but not saved, these 
modifications are displayed as a read only file the next time the 
committed view is opened in Edit mode.

• Other to upload the service data view according to a key, a date, or 
a user specified view name. 

3 In the Other Options panel, select or clear the check boxes depending 
on whether or not you want the following options: 

• Preload View to automatically preload the node service data view 
when you start a provisioning session. Preloading works best if you 
need to load or access a large number of components. If Preside 
Multiservice Data Manager has been configured with backup and 

If you select... then, in the adjacent field, type...

Keyed A valid key in the format <key>nnn, where <key> 
starts with a number or letter, can contain numbers, 
letters, or underscores for subsequent characters. 
The key cannot exceed 6 characters. If <key> 
contains only numbers, then its length must be at 
least three characters. The service data view that 
matches the pattern and has the highest index is 
found, and the next view in the sequence is created. 
Invalid date keys will cause a warning dialog box to 
open.

Dated “Today” or a date in the format <yymmdd> where yy 
is the year, mm is the month and dd is the day. When 
a provisioning view is saved with a dated key, Nodal 
Provisioning adds a two-digit index to the date to keep 
track of the number of saved views on the same date. 
So, when you enter a date, the service data view with 
the highest index is found. When an exact match 
does not exist, the most recent service data view, 
relative to the date is used.

User Specified A view name, or click Browse and select a user 
specified view from the list of views provided in the file 
browser dialog. Nodal Provisioning uploads the 
service data view according to a user-specified view 
name.
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restore functionality, then the view file is downloaded from the backup 
directory. For details on backup and restore, see 241-6001-807 
Preside MDM Network Backup and Restore. Otherwise, the view file 
is downloaded from the device. You do not need the preload option to 
load or access a small number of components.

• Propagation Logging To to create a log file of changes made to the 
service data during a provisioning session. Propagation log files are 
stored in the /opt/MagellanNMS/data/ANP directory. If you select 
Propagation Logging To and type a file name in the /opt/
MagellanNMS/data/ANP/ field, this log file name displays in the 
status bar of the Nodal Provisioning window.

4 Click OK. 

The Nodal Provisioning window opens.

Troubleshooting
• If the node indicates that the previous current view needs to be restored, 

an Open View Warning dialog box opens. Click Close View. To restore 
the previous current view, see “Resolving a restorePossible error 
condition” (page 201).

• If the node indicates that the journal log file could not be saved, an 
warning dialog box opens. Click Close View. See “Resolving a 
journalDisabledReason error condition” (page 203).
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Opening a configuration for MPE 9500 devices
The Open Configuration dialog box for MPE 9500 devices lets you specify 
the access mode and the configuration data to use. Changes made in the Open 
Configuration dialog box are valid for the duration of the provisioning 
session.

The Open Configuration dialog box opens under the following 
circumstances:

• automatically, at start-up, after you successfully authenticate to a device

• automatically when you select the Open Configuration command from 
the File menu

• when the preferences are set to always prompt when opening a 
configuration.

If you have set and saved user preferences for the Open Configuration, the 
Open Configuration dialog box opens with these preferences. If you haven’t 
set user preferences, the dialog box opens with the default MDM settings. For 
information on setting user preferences, see the section “Setting User 
Preferences” (page 207). 
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Figure 3
Open Configuration dialog box

Procedure steps
1 In the Access Mode panel, select one of the following modes:

• Shared to let multiple users edit the configuration at the same time 
and commit or rollback changes without interfering with each 
another’s changes. Conflicts can arise. If so, they must be resolved 
before the configuration can be committed. Shared is the default 
mode.

• Sole-commit to lock the MPE configuration until you commit it or until 
you end the configuration session. Other users can still share the 
configuration session and make changes to it, but they will not be 
able to commit their changes until you relinquish the sole-commit 
session.

• Read only to view the provisioning data corresponding to the current 
operation of the node. You cannot perform any service data 
modifications while in this mode.
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2 In the Configuration panel, upload one of the following service data 
views:

• Running to upload the current configuration. The candidate 
configuration is a copy of the running configuration.

• Previous Running to select a previous, or rollback, configuration. 
The user ID needs sufficient privileges to load previous running 
configurations. You can retrieve information about previous 
configurations by clicking the Show button.

• Other to upload the service data view according to a key, a date, or 
a user-specified view name. The specified file is loaded from the user 
directory into the MPE candidate configuration.

If you select... then, in the adjacent field, type...

Keyed A valid key in the format <key><index>. The value for 
<key> must start with a number or letter, can contain 
numbers, letters, or underscores for subsequent 
characters. The key cannot exceed 6 characters. If 
<key> contains only numbers, then its length must be 
at least three characters. The value for <index> is a 
two-digit number. The service data view that matches 
the pattern and has the highest index is found, and 
the next view in the sequence is created. Invalid date 
keys will cause a warning dialog box to open. Keyed 
configurations are useful for a particular user or 
group.

 (Sheet 1 of 2)
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3 Select an option to load the configuration file

• Merge to combine the specified configuration file with the candidate 
configuration. If conflicts arise, the specified configuration takes 
precedence over the candidate configuration.

• Overwrite to replace the candidate configuration with the specified 
configuration. 

4 Click OK. 

The Nodal Provisioning window opens.

Troubleshooting
• If the node indicates that the previous current view needs to be restored, 

an Open View Warning dialog box opens. Click Close View. To restore 
the previous current view, see “Resolving a restorePossible error 
condition” (page 201).

• If the node indicates that the journal log file could not be saved, an 
warning dialog box opens. Click Close View. See “Resolving a 
journalDisabledReason error condition” (page 203).

Dated “Today” or a date in the format <yymmdd> where yy 
is the year, mm is the month and dd is the day. When 
a provisioning view is saved with a dated key, Nodal 
Provisioning adds a two-digit index to the date to keep 
track of the number of saved views on the same date. 
So, when you enter a date, the service data view with 
the highest index is found. When an exact match 
does not exist, the most recent service data view, 
relative to the date is used. Dated configurations are 
useful for configurations that will be committed on a 
future date. 

User Specified A view name, or click Browse and select a user-
specified view from the list of views provided in the file 
browser dialog. Nodal Provisioning uploads the 
service data view according to a user-specified view 
name. Named configurations are useful to pre-
provision configurations that will be used by others.

If you select... then, in the adjacent field, type...
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Selecting a CDL version 
Use this procedure to select a Command Data Language (CDL) software 
version. When you select a device, the device version is automatically 
discovered and the model files are retrieved. However if the model files are 
unavailable, a Version Selection dialog box opens.

Version Selection dialog box
For an illustration of the Version Selection dialog, see the figure “Version 
Selection dialog” (page 61).

Figure 4
Version Selection dialog

The Version Selection dialog box warns you that the correct CDL version was 
not found, provides the option to accept the default CDL version, or to select 
another version, and advises of the potential error conditions that may result 
from choosing the wrong version.

This procedure applies to both the Toolset and Operator Client environments.

Procedure steps
1 Accept the suggested CDL version, or select a desired CDL version from 

the drop down list of available CDL versions.

2 To select the CDL version, click OK.

 To cancel the operation, click Cancel.
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Component tree view

The following sections describes the Nodal Provisioning window in 
component tree view: 

• “Nodal Provisioning window in component tree view” (page 63)

• “Menu bar” (page 67)

• “File menu” (page 67)

• “View menu” (page 70)

• “Selected menu” (page 71)

• “Options menu” (page 77)

• “External Tools menu” (page 77)

• “Help menu” (page 78)

• “Tool bar” (page 78)

• “View area” (page 79)

• “Service template palette” (page 80)

• “Status bar” (page 82)

• “Component hierarchy view pop-up menus” (page 83)

Nodal Provisioning window in component tree view
When you start Nodal Provisioning, the Nodal Provisioning window opens 
with the component tree view. Passport nodes also support a shelf view. When 
provisioning Passport, you can change from one view to another. For details 
about shelf view, see “Shelf view for Passport nodes” (page 85). You can also 
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change the user preferences so that Nodal Provisioning opens with the 
Passport’s shelf view. For details about setting user preferences for the main 
window display, see “Setting User Preferences” (page 207).

The component tree view provides a hierarchical representation of the 
components of a device. The Nodal Provisioning window contains a 
component tree and a service template palette. Based on the hierarchy model 
for the device and the software version, the component tree is populated to the 
first level of subcomponents and the service palette is populated with service 
creation templates. 

Changes you make in component tree view propagate to the shelf view, if the 
device supports shelf view. Accordingly, changes you make in shelf view 
propagate to the component tree view. For example, if you add a port to the a 
Passport node in the component tree view, the new port is visible on the 
corresponding logical processor (LP) in shelf view.

For additional information see the following sections:

• For a description of the parts of the Nodal Provisioning window in 
component hierarchy view, see the following sections:

— “Menu bar” (page 67)

— “Tool bar” (page 78)

— “View area” (page 79) 

— “Service template palette” (page 80)

— “Status bar” (page 82)

• For information on navigating in component hierarchy view, see 
“Navigating component hierarchy and shelf view” (page 117).

• For information on the forms to create and edit components, see 
“Component forms” (page 109).

• For information on the forms to edit services, see “Service edit form for 
Passport devices” (page 115).

• For information on the forms to create services, see “Service template 
form for Passport devices” (page 112).
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• For provisioning procedures, see “Nodal Provisioning procedures” 
(page 141)

• For post-provisioning procedures, see “Post-provisioning procedures” 
(page 219).

• For procedures to set user preferences for the Nodal Provisioning 
window, and for opening and saving the view, see “Setting User 
Preferences” (page 207).

• For information on the Nodal Provisioning Template Editor, and 
procedures to create service templates, see “Nodal Provisioning 
Template Editor” (page 227).

• For information on the template generator and procedures to create new 
component templates, see “Template Generator” (page 321)

• For information on creating custom reports, see “Report Generator” 
(page 329).

For an illustration of the main window with component hierarchy view, see 
the figure “Main window in component hierarchy view” (page 66).
Preside MDM Nodal Provisioning User Guide   15.1RSUP



66   Chapter 3 Component tree view
Figure 5
Main window in component hierarchy view
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Menu bar
The menu bar has the following menus:

• “File menu” (page 67)

• “View menu” (page 70)

• “Selected menu” (page 71)

• “Options menu” (page 77)

• “External Tools menu” (page 77)

• “Help menu” (page 78)

File menu
The contents of the File menu differs depending on the device type. For 
details, see “File menu commands” (page 68).
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Table 1
File menu commands

Command Description Applies to Related information

Passport MPE

New Device Opens a confirmation dialog 
box. Clicking the Yes button 
exits the current device and 
opens the Nodal 
Provisioning Device 
Selection dialog box which 
lets you select a new 
device.

x x “Selecting a device” 
(page 48)

“Migrating Passport 
software” (page 162)

Open View Opens a dialog box that lets 
you select a new view file. 
The dialog box displays 
either the default values or 
user preference values, if 
set.

If you make changes to a 
view file but do not save it, 
the changes display in read 
only access mode the next 
time you open the view file 
in Edit mode. If you do not 
want to view or use these 
changes, you must use the 
Open View command.

x “Opening a view for 
Passport devices” 
(page 53)

Open 
Configuration

Opens a dialog box that lets 
you select the access mode 
and candidate 
configuration. This dialog 
box does not display if your 
user preferences are set to 
turn off prompts before 
opening a configuration. In 
this case, the configuration 
specified in the preference 
file opens. 

x “Opening a configuration 
for MPE 9500 devices” 
(page 57)
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Check View Opens a confirmation dialog 
box that lets you confirm the 
operation. Clicking Yes 
begins the semantic check 
of the currently open view. 
A Check View dialog box 
opens specifying whether or 
not problems were found. 

x “Checking the Passport 
view during a 
provisioning session” 
(page 191)

Check 
Configuration

Opens a confirmation dialog 
box that lets you confirm the 
operation. Clicking Yes 
begins the semantic check 
of the candidate 
configuration. A Check 
Configuration dialog box 
opens specifying whether or 
not problems were found. 

x “Showing MPE 9500 
configuration conflicts” 
(page 205)

Show Conflicts Opens a Configuration 
Conflicts dialog box that 
lists the conflicts between 
the candidate and running 
configurations.

x “Showing MPE 9500 
configuration conflicts” 
(page 205)

Refresh 
Component 
Tree

Refreshes the component 
tree with the valid changes 
from the running 
configuration. 

x

Commit 
Configuration

Opens a dialog box that lets 
you specify commit options 
and then commit the 
configuration.

x “Committing an MPE 
9500 configuration” 
(page 206)

Confirm 
Commit

Confirms a commit that has 
been initiated by another 
user.

x

Table 1  (Continued)
File menu commands

Command Description Applies to Related information

Passport MPE
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View menu
The table “View menu commands” (page 71) describes the menu commands.

Save/Activate 
View

Opens the Save/Activate 
View dialog box so that you 
can save the active 
configuration.

x “Saving the view for 
Passport devices” 
(page 220)

Save 
Configuration

Opens a dialog box that lets 
you save a configuration. If 
your user preferences are 
set to turn off prompts 
before saving a 
configuration, then this 
dialog does not display and 
the configuration is saved 
according to the 
preferences.

x

Close View Closes the current view. 
The component hierarchy in 
the main window becomes 
unpopulated.

x “Closing the current 
view” (page 118)

Exit 
Configuration

Exits the configuration 
session. If you modify the 
candidate configuration, a 
confirmation dialog opens 
and prompts for 
confirmation before you can 
exit.

x

Exit Exits the configuration 
session and closes all 
windows.

x x

Table 1  (Continued)
File menu commands

Command Description Applies to Related information

Passport MPE
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Selected menu
The Selected menu provides the commands for component level provisioning 
as shown in the table “Selected menu commands” (page 72). The Selected 
menu commands are common to most components that you select in the 
component hierarchy. However, they are enabled only when they are valid for 
the component that you have selected in the component hierarchy. For 
example, at the node level, only Add and Paste menu commands are available.

Table 2
View menu commands

Command Description Applies to Related information

Passport MPE

History Opens the History of 
Changes dialog box. This 
dialog box displays a record 
of user actions and 
changes that have occurred 
to the view while the Nodal 
Provisioning is active.

x x “Viewing and saving a 
record of changes made 
during a provisioning 
session” (page 150)

Shelf Selects or deselects the 
shelf view. 

x “Switching between 
Passport component 
hierarchy and shelf view” 
(page 119)

Toolbar Shows or hides the tool bar. x x “Showing and hiding the 
toolbar” (page 120)

Statusbar Shows or hides the status 
bar. 

x x “Status bar” (page 82)

“Showing and hiding the 
status bar” (page 121)

Reload 
Templates

Populates Nodal 
Provisioning with all the 
templates. If you have 
created and saved a 
template, clicking Reload 
Templates adds the new 
template to the service 
template palette.

x “Updating the service 
template palette in Nodal 
Provisioning” (page 314)
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The same commands are available from a component’s pop-up menu, with 
the exception of the Start Tool command. The Start Tool command is 
available only from the pop-up menu. For additional information on the pop-
up menu, see “Component hierarchy view pop-up menu” (page 80)

When you select a folder in the component hierarchy, that is, a components 
that exceeds the maximum instances that can be displayed (shown visually as 
(x of y)), only the Search and Hide Children commands are available.

The table “Selected menu commands” (page 72) describes the menu 
commands. 

Table 3
Selected menu commands

Command Description Applies to Related information

Passport MPE

Search Opens the Search dialog 
box which lets you search 
for component instances or 
a subset of component 
instances. This command is 
available only for 
components with too many 
instances to display as 
show by the (x of y) next to 
the component.

x x “Searching for a 
component in a large 
instance set” (page 126).

Hide Children Hides all the component 
instances in the selected 
folder. This command is 
available only for 
components with too many 
instances to display as 
shown by the (x of y) next to 
the component.

x x “Hiding all component 
instances” (page 129).
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Add Opens the Add Component 
dialog box which displays a 
list of subcomponents that 
you can add to the selected 
component. When you 
select a component and 
click OK, a component form 
opens with the attributes 
that you can provision. The 
component form is 
dynamically generated.

x x “Adding a single 
component instance” 
(page 152).

Edit Opens the component edit 
form for the selected 
component. This form 
contains all the editable 
attributes for the selected 
component.

x x “Editing a component 
instance” (page 159).

Delete Deletes the selected 
component and all its 
subcomponents.

x x “Deleting a component” 
(page 165)

Rename Opens a dialog box which 
lets you specify a new 
name for the component.

x

Partial 
Semantic 
Check

Performs a limited check for 
semantic errors under the 
selected component. A 
Check View dialog box 
opens to indicate whether 
or not problems were 
found. If problems are 
found, they are listed in the 
dialog box.

x “Performing a full 
semantic check for 
Passport devices” 
(page 192)

Table 3 (Continued)
Selected menu commands

Command Description Applies to Related information

Passport MPE
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Apply Service 
Template

Provides a submenu of 
services that you can apply 
to the selected component. 
The submenus vary with 
the component that you 
select.

Selecting a service from the 
submenu provides a list of 
valid templates When you 
select a template from the 
list, a service template form 
opens.

x “Service template form 
for Passport devices” 
(page 112)

“Creating a service for 
Passport devices” 
(page 178)

Hide Hides the selected 
subcomponent in its parent 
folder. The Hide command 
is only available for children 
of a component with too 
many instances to display. 
These components are 
shown with a value of x of y 
in the component hierarchy.

x “Hiding a single Passport 
component instance” 
(page 128)

Table 3 (Continued)
Selected menu commands

Command Description Applies to Related information

Passport MPE
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Cut Removes the component 
from the component 
hierarchy. If the component 
has subcomponents, a 
dialog box opens and lets 
you specify which 
subcomponents to retain 
for a subsequent paste 
operation. 

The Cut command is 
enabled only if the target 
component of the cut action 
is a valid target. For 
example, the cut command 
is not enabled when you 
select the root component.

x x “Cutting, copying and 
pasting components” 
(page 166)

Copy Copies a selected 
component. If the 
component has 
subcomponents, a dialog 
box opens and lets you 
specify which 
subcomponents to copy. 

The Copy command is 
enabled only if the target 
component of the copy 
action is a valid target. For 
example, the copy 
command is not enabled 
when you select the root 
component.

x x “Cutting, copying and 
pasting components” 
(page 166)

Table 3 (Continued)
Selected menu commands

Command Description Applies to Related information

Passport MPE
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Paste Opens a dialog box which 
lets you paste copied 
components and their 
subcomponents into the 
target component. You can 
paste between Passports 
or between MPE devices.

The Paste command is 
enabled only if the target 
component of the paste 
action is a valid target.

x x “Cutting, copying and 
pasting components” 
(page 166)

Move Moves a component to a 
different location under its 
parent.

x

Place Before Places the moved 
component up one position 
in the component hierarchy

x

Place After Places the moved 
component down one 
position in the component 
hierarchy

x

Generate 
Template

Opens the Generate 
Template tool which allows 
you to create a new 
template based on an 
existing provisioned 
component.

x “Generating a template 
from an existing 
component” (page 326)

Table 3 (Continued)
Selected menu commands

Command Description Applies to Related information

Passport MPE

 (Sheet 5 of 6)
241-6001-610   15.1RSUP   



Chapter 3 Component tree view   77
Options menu
The Options menu contains the commands for opening the User Preferences 
dialog box to set and save preferences for subsequent provisioning sessions. 

 The table “Options menu commands” (page 77) describes the User 
Preferences command.

External Tools menu
The External Tools menu provides launch points for the Nodal Provisioning 
Template Editor and the service provisioning tools. The table “External Tools 
menu commands” (page 78) describes the menu commands.

Generate 
Report

Opens the Report 
Generator tool which allows 
you to create custom 
reports on component data.

x x “Report Generator” 
(page 329)

Find and select 
a component

Opens the Find a 
Component dialog box 
which lets you search for 
device names or 
component instances.

x x “Finding a component” 
(page 154)

Table 4
Options menu commands

Command Description Related information

User Preferences Opens the User Preferences dialog box. This 
dialog box lets you specify preferences for an 
access mode, a view mode, and the Nodal 
Provisioning window. 

See “Setting User 
Preferences” (page 207)

Table 3 (Continued)
Selected menu commands

Command Description Applies to Related information

Passport MPE
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Help menu
The Help menu provides access to online documentation for the Nodal 
Provisioning tool. The table “Help menu commands” (page 78) describes the 
menu commands.

Tool bar
The tool bar contains the following icons:

• The exit icon closes the Nodal Provisioning window.

Table 5
External Tools menu commands

Command Description Related information

Nodal Provisioning Template 
Editor

Provides a launch point for 
the Nodal Provisioning 
Template Editor.

“Nodal Provisioning Template 
Editor” (page 227)

Service Provisioning

(MDM Toolset only)

Opens a sub-menu of 
commands to start the 
following service 
provisioning tools:

• ATM

• Frame Relay

• IP VPN Service 
Provisioning

• IP VPN Provider Edge

For details, see 
241-6001-600 Preside MDM 
Service Provisioning for ATM User 
Guide

241-6001-603 Preside MDM 
Service Provisioning for Frame 
Relay User Guide

241-6001-616 Preside MDM IP 
VPN Service Configuration User 
Guide

Table 6
Help menu commands

Command Description Related information

Help on Window Accesses the online documentation for the 
Nodal Provisioning window.

“Displaying help on the 
Nodal Provisioning window” 
(page 145)
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• The shelf view icon lets you toggle between component hierarchy and 
shelf view.

• The reload all service templates icon populates the Nodal Provisioning 
window with all the templates. If you have created and saved a new 
template, clicking the reload all service templates icon adds the new 
template to the service template palette.

• The search icon opens the Find a component dialog box when in 
component view only. For information on finding a component, see 
“Finding a component” (page 154).

View area
In component hierarchy view, the Nodal Provisioning window displays the 
component hierarchy for the connected device. The component hierarchy 
displays all the device components that can be provisioned. A scroll bar lets 
you navigate the component hierarchy. 

At the start-up of a device provisioning session, the component hierarchy is 
populated to display the first level components and services under the root. 
The root is a device specific identifier. For example, the Passport root 
identifier is EM/<node name>, where <node name> is the name of the device 
to which you are connected.

The component hierarchy is constructed from information represented in the 
hierarchy model, and instance information retrieved from the server. The 
hierarchy model determines which type of instances can go under the parent. 
For components with many instances, the components appear as folders in the 
component hierarchy and only the folder is shown at start-up. A folder refers 
to any component in the component hierarchy that has children under it. 
Components that have children are identified by a plus (+) sign to the left of 
the folder. Instances are retrieved by expanding the folder. When you expand 
the folder, the plus sign changes to a minus (-) sign. For the procedure to 
expand a folder, see “Expanding a component” (page 124). 

For large devices, the number of instances may exceed a predefined 
configurable threshold. Expanding the parent folder does not fetch all the 
instances and add them to the component hierarchy. In these situations, a 
visual indicator appears to the right of the folder to show you that the number 
of instances are too many to display. The format of the information is (x of y), 
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where x is the maximum instances set through the configuration file and y is 
the total number of instances. For example, if the maximum number of 
instances is 20, and there is a total of 35 instances, you see (20 of 35) to the 
right of the folder.

The component hierarchy view may also display a network-wide icon to the 
left of the component name. This icon indicates global data. Components that 
have a scope attribute of “network” are considered global data by Nodal 
Provisioning. Use caution when deleting components marked as having 
global data since these components have network wide implications.

For components with many instances, Nodal Provisioning provides a search 
capability to search for component instances or a subset of component 
instances. For information on the search capability, see “Searching for a 
component in a large instance set” (page 126).

Component hierarchy view pop-up menu
Components in the component hierarchy view have a pop-up menu. You open 
the pop-up menu by positioning the mouse pointer over the component in the 
hierarchy and then right-clicking. 

The content of the pop-up menu corresponds to the content of the Selected 
menu in the menu bar, with the exception of the Start Tool command. The 
Start Tool command is available only from the pop-up menu. The Start Tool 
command displays a list of other Preside Multiservice Data Manager tools 
that you can start from Nodal Provisioning. The content of the list varies 
depending on component context and access control. For a description of the 
pop-up menu commands, see the section “Selected menu” (page 71).

Service template palette
The service template palette appears on the right side of the Nodal 
Provisioning window. The service template palette contains the service 
creation templates that apply to the selected device. These templates let you 
specify pre-determined configurations with default values and custom 
creation forms. 

Only the templates that apply to the software version of the connected device 
appear in the palette.
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A service template palette simplifies the creation of a service by requesting 
only a limited amount of critical component data for the service.

The service template palette is organized into tabbed panes. Each pane 
contains service templates for a related group of services. The Nodal 
Provisioning window contains the following tabbed panes: 

• ATM

• FRS

• FrAtm

• MPLS-Infrastructure

• MPLS-Services

• PT-AA1

• UA-IP

• VPN

• WUA-AA1

For a description of the templates found under each of the tabbed panes, see 
241-6001-611 Preside MDM Nodal and Service Provisioning Reference 
Guide.

When you click on a tabbed pane, icons representing the service templates for 
the selected service are displayed in the service template palette. If you right 
click on a template, a pop-up menu appears with three options:

• Launch opens a service template form. This command is enabled only 
when you select a valid dropsite in the component hierarchy.

• Description opens a window with a description of the service template. 
This description corresponds to the description of the template that is 
entered into the Nodal Provisioning Template Editor Description section. 
The description also identifies the prerequisites and dropsites for the 
template.

• Edit opens the Nodal Provisioning Template Editor so you can modify 
the template.
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You can provision the selected service by applying a service template in one 
of the following ways:

• dragging a template icon and dropping it on a valid dropsite. 

• selecting a valid dropsite in the component hierarchy, right clicking on a 
template icon in the service palette, then selecting Launch from the pop-
up menu.

• using the Apply Service Template command in the Selected menu, or 
component pop-up menu.

Applying a template from the palette to a valid drop point initiates the 
provisioning of a service using a service template form. The form lets you 
enter the necessary provisioning information. 

The dropsite component is specified as either a link or parent. A link 
component is one in which the component is taken to be the value of the 
specified component attribute in the template. Link drop components may 
also specify components higher in the hierarchy from the main drop 
component as valid dropsites. A template can be dropped on a component that 
contains a valid dropsite. In this case, you are provided a menu of available 
subcomponents beneath the chosen component. A parent component is taken 
to be the parent of a specified component in the template.

When an attempt to create a service fails, a dialog box opens with an error 
message and a list of components that were created before the error occurred. 
You need to resolve the error condition and return to the service creation 
procedure. See “Creating a service for Passport devices” (page 178) and 
“Repairing Passport service creation errors overview” (page 194).

You can delete a component using the service creation error dialog box. 
However, you cannot reverse any modifications that you have made to 
component attributes. 

Status bar
The status bar appears at the bottom of the Nodal Provisioning window, and 
shows the following information:

• connection status
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• shelf type of the node you are connected to. For example, 
“fabricBasedShelf” indicates the Passport 15000 family and 
“busBasedShelf indicates the Passport 7400 family.

• model version of the device you are connected to

• Edit or ReadOnly depending on the selection that you made when 
opening the view.

• view name. When you modify the working view, an “*” appears next to 
the View name in the status bar. If you have enabled the propagation 
logging option in the User Preferences dialog box, and specified a log file 
name, you can display the log file name by right clicking on the view 
name and selecting Log File Name.

• name of the device to which you are connected

Component hierarchy view pop-up menus 
Components in the component hierarchy view have a pop-up menu that 
corresponds to the menu options in the Selected menu. You can access pop-
up menus by right-clicking on a selected component. Only valid options are 
available from the pop-up menu. For a description of the pop-up menu 
commands, see “Selected menu” (page 71).
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Shelf view for Passport nodes

The following sections describe the Nodal Provisioning window in shelf 
view:

• “Nodal Provisioning window in shelf view” (page 86)

• “Menu bar” (page 91)

• “File menu” (page 91)

• “View menu” (page 92)

• “Selected menu” (page 93)

• “Options menu” (page 96)

• “External Tools menu” (page 97)

• “Help menu” (page 98)

• “Tool bar” (page 98)

• “Shelf panel” (page 98)

• “Sparing panel” (page 98)

• “Logical shelf panel” (page 99)

• “Shelf Details panel” (page 100)

• “Service template palette” (page 102)

• “Status bar” (page 104)

• “Shelf view pop-up menus” (page 105)
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Nodal Provisioning window in shelf view 
When you start Nodal Provisioning, the Nodal Provisioning window always 
opens with the component hierarchy view. For Passport nodes only, you have 
the option of changing to a shelf view at any time or setting the user 
preferences so that Nodal Provisioning opens with shelf view. To set user 
preferences, see “Setting User Preferences” (page 207).

The shelf view displays the following elements:

• a physical representation of the shelf and its cards

• a logical representation of the device

• card sparing through the logical processors (LPs)

The lower section of the shelf view window, contains the Shelf Details panel. 
This panel contains two areas:

• Components drill down panel
The Components drill down panel displays the component hierarchy for 
the component that you have selected in the shelf view panel.

• Services drill down panel
The Services drill down panel displays the component hierarchy, 
including subcomponents, for the services that are configured for the 
component that you have selected in the shelf view panel.

To maximize the shelf view real estate, both the Components and Services 
drill down panels can be detached from the shelf view panel. For the 
procedure to detach the drill down panels, see “Detaching and reattaching the 
component and service hierarchies” (page 131).

Shelf view provides the same capabilities as component hierarchy view. The 
capabilities offered through the Selected menu, and the popup menus in the 
component hierarchy view are available for all graphical and hierarchical 
representations of components in the shelf view. You can also access the 
subcomponents of all graphical and hierarchical representations of 
components.
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When you make changes to the shelf view, the changes are propagated to the 
component hierarchy view. Alternately, changes to the component hierarchy 
view are propagated to the shelf view. For example, if you add a port in shelf 
view, and then switch to component hierarchy view, you will see the new port 
on the corresponding logical processor (LP).

You can only provision one device at a time with a nodal provisioning session. 
If you want to provision more than one device you must start another instance 
of Nodal Provisioning.

To enable you to view and provision ports, channels, and the service 
interfaces associated with them, shelf view provides the following additional 
functionality, which is not available in component hierarchy view:

• display, graphically, all ports on a logical processor (LP), whether or not 
they are provisioned

• identify the service interfaces for a selected unchannelized port or 
channel to let you view and provision the service components and their 
subcomponents

• provide access to all provisionable subcomponents of the components 
graphically displayed to let you view and provision the subcomponents

 As in component hierarchy view, shelf view contains a service template 
palette on the right side of the Nodal Provisioning window. The service 
template palette contains the service creation templates. Shelf view lets you 
apply service templates to components in the following areas:

• the graphical representation of the shelf

• the component trees in the Shelf Details panel

You can also resize the window and the shelf view is unaffected. However, in 
shelf view, the graphical representations of the logical processors and their 
ports, and the EM root component are the only available dropsites for 
templates from the service template palette. Therefore, the template must 
contain a dropsite which specifies a logical processor or one of its port types. 
When you apply a template from the palette that has port dropsites, a service 
template form opens with the correct port. 
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You can also apply templates to the hierarchical representations of 
components in the Shelf Details drill down panels.

In shelf view, you can access the root component (EM) by left-clicking in the 
area to the left of the logical shelf panel. The Components and Services areas 
of the Shelf Details panel are populated.

For additional information, see the following sections:

• For a description of the parts of the Nodal Provisioning window in shelf 
view, see the following sections:

— “Menu bar” (page 91)

— “Tool bar” (page 98)

— “Shelf panel” (page 98)

— “Sparing panel” (page 98)

— “Logical shelf panel” (page 99)

— “Shelf Details panel” (page 100)

— “Shelf view pop-up menus” (page 105)

• For navigation in shelf view, see “Navigating component hierarchy and 
shelf view” (page 117).

• For information on the forms that you use to create and edit components, 
see “Component forms” (page 109).

• For information on the forms that you use to edit services, see “Service 
edit form for Passport devices” (page 115).

• For information on the forms that you use to create services, see “Service 
template form for Passport devices” (page 112).

• For provisioning procedures, see “Nodal Provisioning procedures” 
(page 141).

• For post-provisioning procedures, see “Post-provisioning procedures” 
(page 219).

• For procedures to set user preferences for the Nodal Provisioning 
window, and for opening and saving the view, see “Setting User 
Preferences” (page 207).
241-6001-610   15.1RSUP   



Chapter 4 Shelf view for Passport nodes   89
• For information on the Nodal Provisioning Template Editor, and 
procedures to create service templates, see “Nodal Provisioning 
Template Editor” (page 227).

• For information on the template generator and procedures to create new 
component templates, see “Template Generator” (page 321)

• For information on creating custom reports, see “Report Generator” 
(page 329).

For an illustration of the main window in shelf view, see “Main window in 
shelf view” (page 90).
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Figure 6
Main window in shelf view
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Menu bar
The menu bar has the following menus:

• “File menu” (page 91)

• “View menu” (page 92)

• “Selected menu” (page 93)

• “Options menu” (page 96)

• “External Tools menu” (page 97)

• “Help menu” (page 98)

File menu
The table “File menu commands” (page 91) describes the menu commands.

Note: The Check View, Open View, and Save View File menu commands 
are only available for Passport devices.

Table 7
File menu commands

Menu command Description of menu command Related information

New Device Opens a confirmation dialog box. Clicking Yes 
exits the current device and opens the Device 
Selection dialog box which lets you select a new 
device.

“Selecting a device” 
(page 48)

Open View Opens the Open View dialog box so that you can 
select a new view file. The dialog box displays 
either the default values which are set in through 
the user preferences, or if none are set, the 
default user preferences.

If you made changes to a view file but did not 
save these, the changes you made will be 
displayed in read only access mode the next 
time you open the view file in Edit mode. If you 
do not want to view or use these changes, you 
must use the Open View command.

“Opening a view or 
configuration” (page 52)

 (Sheet 1 of 2)
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View menu
The table “View menu commands” (page 93) describes the menu commands.

Check View Opens a confirmation dialog box to confirm the 
check view operation, and advising you that the 
check may take a few minutes. Clicking Yes 
proceeds with a check of the currently open 
view. If the view does not pass the check, an 
error dialog box opens stating that the view did 
not pass the check.

“Showing MPE 9500 
configuration conflicts” 
(page 205)

Close View Closes the current view. The component 
hierarchy in the Nodal Provisioning window 
becomes unpopulated.

“Closing the current view” 
(page 118)

Save/Activate 
View

Opens the Save/Activate View dialog box so that 
you can save the active configuration.

“Saving the view for 
Passport devices” 
(page 220)

Exit Closes all windows and the provisioning session.

When a view is edited, and the changes are not 
saved before you exit, the modifications are kept 
and can be displayed in read only access mode 
the next time you open the view in Edit mode.

Table 7  (Continued)
File menu commands

Menu command Description of menu command Related information

 (Sheet 2 of 2)
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Selected menu
With some exceptions, the Selected menu provides the commands displayed 
in “Selected menu commands” (page 94). The menu commands are enabled 
only when they are valid for the component that you have selected in the shelf 
view or drill down panels. 

The same commands are available from a component’s pop-up menu, with the 
exception of the Start Tool command. The Start Tool command is available 
only from the pop-up menu. For additional information on the pop-up menu, 
see “Shelf view pop-up menus” (page 105).

When you select a folder in the component hierarchy, that has too many 
instances to display, as shown visually as (x of y), the Search and Hide 
Children menu commands are enabled. They are otherwise disabled.

Table 8
View menu commands

Menu command Description Related information

History Opens the History of Changes dialog box. This 
dialog box displays, and lets you save a record 
of user actions and changes that have occurred 
to the view while Nodal Provisioning is active.

“Viewing and saving a 
record of changes made 
during a provisioning 
session” (page 150)

Shelf Selects or deselects the shelf view. “Switching between 
Passport component 
hierarchy and shelf view” 
(page 119)

Toolbar Shows or hides the tool bar. “Tool bar” (page 98)

“Showing and hiding the 
toolbar” (page 120)

Statusbar Shows or hides the status bar. “Status bar” (page 104)

“Showing and hiding the 
status bar” (page 121)

Reload 
Templates

Populates Nodal Provisioning with all the 
templates. If you have created and saved a 
template, clicking Reload Templates adds the 
new template to the service template palette.

“Updating the service 
template palette in Nodal 
Provisioning” (page 314)
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Selected menu for unconfigured Logical Processors
The Selected menu commands for unconfigured Logical Processors are:

• Add opens a component creation form on the new LP component. When 
you select OK, you create the new LP.

• Paste pastes a copied LP to provision this LP.

Selected menu for unconfigured ports
The Selected menu commands for unconfigured ports are:

• Add opens a component creation form if the port only supports a single 
port type. If the port supports more than a single port type, an Add 
Component dialog opens from which you can select a port type. Only the 
port types supported by this port are displayed in the Add Component 
dialog. Selecting a port type from the Add Component dialog, and 
clicking OK opens a component creation form. You can modify the 
attributes in the component creation form and then click OK to create the 
new port.

• Paste pastes a copied port to provision this port.

Table 9
Selected menu commands

Menu command Description of menu command Related procedure or 
information

Search Opens the a search dialog box which lets you 
search for component instances or a subset of 
component instances. The Search command is 
available only for components with too many 
instances to display as show by the (x of y) next 
to the component.

“Searching for a component 
in a large instance set” 
(page 126)

Hide Children Hides all the component instances in the 
selected folder. The Hide Children command is 
available only for components with too many 
instances to display as shown by the (x of y) next 
to the component.

“Hiding all component 
instances” (page 129)

 (Sheet 1 of 3)
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Add Opens the Add Component dialog box which 
displays a list of subcomponents that you can 
select and add to the selected component. Once 
you have selected a component and clicked OK, 
a component form opens with the attributes that 
you can provision.

“Adding a single component 
instance” (page 152)

Edit Opens the component edit form for the selected 
component so that you can edit component 
attributes. The form contains all the editable 
attributes for the selected component.

“Editing a component 
instance” (page 159)

Delete Deletes the selected component and all its 
subcomponents.

“Deleting a component” 
(page 165)

Partial Semantic 
Check

Performs a limited check for semantic errors 
under the selected component. A Check View 
dialog box opens to indicate whether or not 
problems were found. If problems are found, 
they are listed in the dialog box.

“Performing a full semantic 
check for Passport devices” 
(page 192)

Apply Service 
Template

Provides a submenu of services that can be 
applied to the selected component. The 
submenus vary with the component that you 
select.

Selecting a service from the submenu provides a 
list of valid templates When you select a 
template from the list, a service template form 
opens.

“Creating a service for 
Passport devices” 
(page 178)

“Service template form for 
Passport devices” 
(page 112)

Hide Hides the selected subcomponent in its parent 
folder. The Hide command is only available for 
children of a component with too many instances 
to display. These components are shown with a 
value of x of y in the component hierarchy.

“Hiding a single Passport 
component instance” 
(page 128)

Table 9  (Continued)
Selected menu commands

Menu command Description of menu command Related procedure or 
information
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Options menu
The Options menu contains the command for opening the User Preferences 
dialog box. 

 The table “Options menu command” (page 97) describes the Options menu 
command.

Copy Opens a copy component dialog box. This dialog 
box displays the selected component and all of 
its subcomponents. The copy dialog lets you 
select the subcomponents that you want to copy. 

The copy command is enabled only if the target 
component of the copy action is a valid target. 
For example, the copy command is not enabled 
when you select the root component.

“Cutting, copying and 
pasting components” 
(page 166)

Paste Opens a paste dialog box. The Paste command 
lets you paste copied components and their 
subcomponents into the target component. The 
paste command is enabled only if the target 
component of the paste action is a valid target.

“Cutting, copying and 
pasting components” 
(page 166)

Generate 
Template

Opens the Generate Template tool which allows 
you to create a new template based on an 
existing provisioned component.

“Template Generator” 
(page 321)

Generate Report Opens the Report Generator tool which allows 
you to create custom reports on component 
data.

“Report Generator” 
(page 329)

Find and select a 
component

Opens the Find a Component dialog box lets you 
search for device names or component 
instances

“Finding a component” 
(page 154)

Table 9  (Continued)
Selected menu commands

Menu command Description of menu command Related procedure or 
information
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External Tools menu
The External Tools menu provides launch points for the Nodal Provisioning 
Template Editor and the service provisioning tools. The table “External Tools 
menu commands” (page 97) describes the menu commands.

Table 10
Options menu command

Menu command Description of menu command Related procedure or 
information

User Preferences Opens the User Preferences dialog box. This 
dialog box lets you specify preferences for an 
access mode, a view mode, and other service 
data options. 

“Setting User Preferences” 
(page 207)

Table 11
External Tools menu commands

Menu command Description of menu 
command

Related procedure or 
information

Nodal Provisioning Template 
Editor

Provides a launch point for 
the Nodal Provisioning 
Template Editor.

“Nodal Provisioning Template 
Editor menu bar” (page 231)

Service Provisioning Opens a sub-menu of 
commands to start the 
following service provisioning 
tools:

• ATM

• Frame Relay

• IP VPN Service 
Provisioning

• IP VPN Provider Edge

For details, see 
241-6001-600 Preside MDM 
Service Provisioning for ATM 
User Guide

241-6001-603 Preside MDM 
Service Provisioning for Frame 
Relay User Guide

241-6001-616 Preside MDM IP 
VPN Service Configuration User 
Guide
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Help menu
The Help menu provides access to online documentation for Nodal 
Provisioning. The table “Help menu commands” (page 98) describes the 
menu commands.

Tool bar
The tool bar contains the following icons:

• The exit icon closes the Nodal Provisioning main window.

• The shelf view icon lets you switch between component hierarchy and 
shelf view.

• the reload all service templates icon populates the shelf view main 
window with all the templates. If you have created and saved a new 
template, clicking the reload all service template icon adds the new 
template to the service template palette.

• The search icon is disabled in shelf view. 

Shelf panel
The topmost panel is called the shelf panel. It provides the physical 
representation of the shelf and its cards. The card type is shown on each card. 

Sparing panel
The sparing panel is found between the shelf panel and logical shelf panel. It 
shows the card sparing through the logical processors (LPs). When a logical 
processor is configured with a main card and a spare card, and you select a 
logical processor, the shelf view sparing panel shows lines drawn to those 
main and spare cards.

Table 12
Help menu commands

Menu command Description of menu command Related procedure or 
information

Help on Window Opens the on-line documentation for the Nodal 
Provisioning window.

“Displaying help on the 
Nodal Provisioning window” 
(page 145)
241-6001-610   15.1RSUP   



Chapter 4 Shelf view for Passport nodes   99
You can select cards and LPs. When you select an LP, a link is drawn to the 
master card and spare card. You can distinguish between the main card and 
spare card for LPs as follows:

• the main card is identified by a black line

• the spare card is identified by a gray line

Logical shelf panel
The logical shelf panel appears below the sparing panel. It provides a logical 
representation of the device. It displays the logical processors and their ports. 
Ports can be provisioned. For additional information, see the following 
sections:

• “Graphical port display” (page 99)

• “Graphical port provisioning” (page 100)

Graphical port display
When a logical processor has been configured with a main or spare card, all 
of its ports are shown on the logical processor in the shelf view, whether or 
not they are configured.

Note: Ports that cannot be provisioned are not displayed on the logical 
processors.

The following are the key features of the graphical port display:

• tool tips to identify the port type
The port type for each configured and unconfigured port is shown in a 
tool tip. The tool tip appears when you rest the mouse pointer on the port.

• configured and unconfigured ports are visually distinguished
Configured ports are visually distinguished from unconfigured ports by 
a raised border and their port identifier is displayed. Unconfigured ports 
are shown with a sunken border and their port identifier is not displayed.

• scroll bars to enable you to pan up and down the screen
If there are more ports on the logical processor than can be displayed on 
the screen at once, scroll bars are enabled at the bottom of the logical 
processor through which you can pan the ports up and down.
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Graphical port provisioning
You can provision ports from their graphical display in the logical shelf panel.

For provisioned ports, the Selected and component popup menu are the same 
as are available in the component hierarchy view and in the Selected menu.

• Add adds a subcomponent (for example, channel) to the port

• Edit edits the provisioned port data.

• Apply Service Template applies a service template to the port.

• Copy makes a copy of the port and its subcomponents.

• Paste pastes the last copied component as a child of the port, if it is a 
valid type.

• Generate Report generates a report of the provisioned port data.

For unprovisioned ports, the Selected, and component popup menus contain 
the following options, which are used to create the port:

• Add opens the Add Component dialog box if the port supports more than 
a single port type. The Component Names list in the Add Component 
dialog box only displays the port types that are supported by the selected 
port. When you select the new port from the list of available port 
components, a port creation form opens for that supported port type. This 
is the same form shown when the port is added to the LP from the 
component hierarchy view.

• Paste pastes the last copied component as a child of the port, if it is a 
valid type.

Shelf Details panel
The Shelf Details panel contains two sections:

• “Components drill down panel” (page 101)

• “Service drill down panel” (page 102)
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Components drill down panel
The components drill down panel appears below the logical shelf panel and 
to the left half of the Shelf Details panel. When you select a component in the 
shelf view, the selected component is mirrored as a component hierarchy in 
the component drill down panel for the following components

• shelf

• card

• logical processor

• ports

You can also select the root component (EM) by left-clicking to the left of the 
logical shelf panel. The components drill down panel is populated with the 
full component hierarchy, corresponding to the component hierarchy in 
component hierarchy view. For a description of the component hierarchy, see 
“View area” (page 79).

When the mouse pointer rests on a port or channel in the component drill 
down panel, to which a service component is linked, the name and identifier 
of the service component is displayed in a tool tip.

You can detach the component drill down panel from the main window, and 
display it as a separate window. This lets you maximize the shelf view real 
estate. When you collapse the detached portion, it reattaches to the main 
window. For the procedure to detach the drill down panels, see “Detaching 
and reattaching the component and service hierarchies” (page 131).

Component provisioning in the component drill down panel
The following provisioning functionality is available in the component drill 
down panel:

• the Selected and pop-up menus for components are the same as for the 
component hierarchy view

• you can apply service templates to all components shown in the 
component drill down panel
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Service drill down panel
The service drill down panel is found below the logical shelf panel, and to the 
right half of the Shelf Details panel. When you select a component in the 
component drill down panel, the service drill down panel displays any service 
that is configured for the selected component, or any of its subcomponents. 
The service drill down panel displays a component hierarchy, that includes 
subcomponents, for each configured service.

When you rest the mouse pointer on the top-level service component, the 
name and identifier of the port or channel to which it is linked is displayed as 
a tool tip.

The service drill down panel can be detached, along with the component drill 
down panel, from the main window and displayed as a separate window to 
maximize the shelf view real estate. When you collapse the detached window, 
it reattaches to the main window. For the procedure to detach the drill down 
panels, see “Detaching and reattaching the component and service 
hierarchies” (page 131).

Component provisioning in the service drill down panel
The following provisioning functionality is available in the service drill down 
panel:

• the Selected and popup menus for components are the same as for the 
component hierarchy view

• you can apply service templates to all components shown in the service 
drill down panel

Service template palette
The service template palette appears on the right side of the main window. 
The service template palette contains the service creation templates that apply 
to the selected device. The templates let you specify pre-determined 
configurations with default values and custom creation dialog boxes. 

Only the templates that apply to the software version of the connected device 
appear in the service palette.

A service template palette simplifies the creation of a service by requesting 
only a limited amount of critical component data for the service.
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The service palette is organized into tabbed panes. Each pane contains service 
templates for a related group of services. The Nodal Provisioning window 
contains the following tabbed panes: 

• ATM

• FRS

• FrAtm

• MPLS-Infrastructure

• MPLS-Services

• PT-AA1

• UA-IP

• VPN

• WUA-AA1

When you click on a tab, icons representing the service templates for the 
selected service are displayed in the service template palette. If you right-
click on a template, a pop-up menu appears with two command options:

• Launch opens a service template form. This command is enabled only 
when you select a valid dropsite in the component hierarchy.

• Description opens a window with a description of the service template. 
This description corresponds to the description of the template that is 
entered into the Description section found in the Nodal Provisioning 
Template Editor. 

• Edit opens the Nodal Provisioning Template Editor so you can modify 
the template.

You can provision the selected service by applying a service template in one 
of the following ways:

• dragging a template icon and dropping it on a valid dropsite. 

• selecting a valid dropsite in the component hierarchy, right clicking on a 
template icon in the service palette, then selecting Launch from the pop-
up menu. This is the preferred method for remote log in.
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• Using the Apply Service Template command in the Selected menu, or 
component pop-up menu.

Applying a template from the palette onto a valid drop point initiates the 
provisioning of a service using a service template form. The form lets you 
enter the necessary provisioning information. 

The dropsite component is specified as either a link or parent. A link 
component is one in which the component is taken to be the value of the 
specified component attribute in the template. Link drop components may 
also specify components higher in the hierarchy from the main drop 
component as valid dropsites. A template can be dropped on a component that 
contains a valid dropsite. In this case, you are provided a menu of available 
subcomponents beneath the chosen component. A parent component is taken 
to be the parent of a specified component in the template.

When an attempt to create a service fails, a dialog opens with an error 
message and a list of components that were created before the error occurred. 
You need to resolve the error condition and return to the service creation 
procedure. See “Creating a service for Passport devices” (page 178) and 
“Repairing Passport service creation errors overview” (page 194).

 You can delete a component using the service creation error dialog. However, 
you cannot reverse any modifications that you have made to component 
attributes. 

Status bar
The status bar appears at the bottom of the shelf view main window, and 
shows the following information:

• connection status

• shelf type of the node you are connected to. For example, 
“fabricBasedShelf” indicates the Passport 15000 family and 
“busBasedShelf indicates the Passport 7400 family.

• The CDL software version of the device you are connected to

• Edit or ReadOnly appears, depending on the selection that you made 
when opening the view.
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• view name. When you modify the working view, an “*” appears next to 
the View name in the status bar. If you have enabled the propagation 
logging option in the User Preferences dialog, and specified a log file 
name, you can display the log file name by right clicking on the view 
name and selecting Log File Name.

• name of the device to which you are connected.

Shelf view pop-up menus 
Components in the shelf view and the component and service drill down 
panels have a pop-up menu. You open pop-up menus by right-clicking on a 
selected component in the component hierarchy in the component or shelf 
drill down panel, in the Shelf panel, or in the Logical shelf panel. 

The content of the pop-up menu corresponds to the content of the Selected 
menu in the menu bar, with the exception of the Start Tool command. The 
Start Tool command is available only from the pop-up menu. The Start Tool 
command displays a list of other Preside Multiservice Data Manager tools 
that you can start from Nodal Provisioning. The content of the list varies 
depending on component context and access control. For a description of the 
pop-up menu commands, for components other than unconfigured LPs and 
ports, see the section “Selected menu” (page 93).
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Nodal Provisioning forms

For a description of the Nodal Provisioning forms, see the following sections

• “Overview of Nodal Provisioning forms” (page 107)

• “Component forms” (page 109)

• “Service forms for Passport devices” (page 112)

Overview of Nodal Provisioning forms
 Nodal Provisioning provides forms to add and edit components and services. 
The forms that are available to you are dependent on the device you are 
provisioning.

Nodal Provisioning 
form

Applies to Purpose

Passport MPE

“Component creation 
form” (page 109)

x x Creates a single component 
instance, or multiple 
instances of the same 
component.

“Component edit 
form” (page 111)

x x Edits a single component 
instance.

 (Sheet 1 of 2)
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Attribute fields for Nodal Provisioning forms
The fields available on the Nodal Provisioning forms are specific to the 
component that you select and the specific model version. In component 
forms, each field represents an attribute for the selected component. In service 
forms, each tab corresponds to a component. When you select a tab, the form 
displays the attributes for the selected component. 

You may find one or more of the following aids to help you select ranges and 
values:

• drop-down menus identifying valid ranges and default values

• tool tips

• attribute help

For other attributes, you can enter values in a text field.

Navigating Nodal Provisioning forms 
Instead of using the mouse, you can use the tab key to navigate within a table 
and between tables and other fields in the nodal provisioning forms. The Tab 
key functions in the following way:

• Tab
Tab moves the focus to the next cell in the table.

• Shift + Tab 
Shift + Tab moves the focus to the previous cell in the table.

“Service edit form for 
Passport devices” 
(page 115)

x Edits a service.

“Service template 
form for Passport 
devices” (page 112)

x Adds a single service, or 
multiple instances of the 
same service.

Nodal Provisioning 
form

Applies to Purpose

Passport MPE

 (Sheet 2 of 2)
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• Ctrl + Tab
Ctrl + Tab moves the focus to the next widget outside of the table.

• Ctrl + Shift + Tab
Ctrl + Shift + Tab moves the focus to the previous widget outside of the 
table.

Component forms
See the following sections for further information about component forms 
and how to use them:

• “Component creation form” (page 109)

• “Component edit form” (page 111)

• “Adding a single component instance” (page 152)

• “Editing a component instance” (page 159)

• “Creating multiple instances of a Passport component” (page 185)

Component creation form
The component creation form lets you add a single component instance, or 
multiple component instances. The component creation form is dynamically 
generated and displays the provisionable attributes that you can modify for 
the selected component.

A component creation form opens when you select the Add command from 
the Select menu or from the component pop-up menu. 

The component creation form has the following command buttons:

• OK creates one component instance.

• Cancel closes the form without saving the changes. Data that you have 
entered is discarded.

• Help accesses the on-line documentation for the component form.

• Multiple Creations opens the Multiple Creations dialog box. This 
dialog box lets you specify how you want to create multiple instances of 
the component. For information on creating multiple component 
instances, see “Creating multiple instances of a Passport component or 
service” (page 183).
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For sample component creation forms, see the figure “Sample component 
creation forms” (page 110). 

Figure 7
Sample component creation forms

Passport 
component 
creation form

MPE 9500 
component 
creation form
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Component edit form
The component edit form lets you edit the provisionable attributes of a single 
component. This form is dynamically generated, displaying the attributes of 
the selected component.

The edit form opens when you select a component in the component 
hierarchy and then select the Edit command from the component’s Selected 
menu or pop-up menu. 

The component edit form has the following command buttons:

• OK modifies the component, validates the form and saves the current 
data onto the device. For Passport devices, the data is saved in the editing 
view. The component form closes after the component is saved 
successfully.

• Apply validates the form and saves the current service data. The form 
remains open after the component has been successfully saved. If an 
error occurs during validation or saving, a warning dialog opens and the 
form remains open.

• Cancel closes the form without saving the changes. Data that you have 
entered is discarded.

• Help accesses the on-line help for the component form.

For an example of a component edit form, see the figure “Example of a 
component edit form” (page 112). This edit form opens when you edit the 
DS1/1 component that you created with the component creation form 
described in “Component forms” (page 109).
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Figure 8
Example of a component edit form

Service forms for Passport devices
See the following sections for further information about service forms and 
how to use them:

• “Service template form for Passport devices” (page 112)

• “Service edit form for Passport devices” (page 115)

• “Creating a service for Passport devices” (page 178)

• “Editing a service for Passport devices” (page 180)

• “Creating multiple instances of a Passport service” (page 187)

Service template form for Passport devices
You use the service template form to create a service. The service template 
form allows you to enter provisioning information for the components that 
make up the service. 
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A service template form lets you apply a single service instance, or multiple 
instances of the same service from one form.

You can apply a service template by using one of the following methods:

• Drag and drop a service template icon from the service palette to a valid 
drop site on the component hierarchy.

• Select a valid drop site in the component hierarchy, right click on a 
template icon in the service palette, and then select Launch from the 
pop-up menu.

• Select a drop site in the component hierarchy, right-click and from the 
pop-up menu, select Apply Service Template.

A service template form does not open if the service template is dropped on 
an invalid drop site.

The figure “Example of a service template form” (page 114), shows the 
service template form to create a virtual connection (Vcc) under the selected 
ATM Interface. This service template also lets you provision the traffic 
management parameters.
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Figure 9
Example of a service template form

The service template form has the following command buttons:

• OK validates and saves the current data onto the device, creating one 
instance of the service.

• Multiple Creations opens the Multiple Creations form which lets you 
create multiple instances of the service. For the procedure to create 
multiple services, see “Creating multiple instances of a Passport 
component or service” (page 183).

• Cancel closes the service template form without saving the changes. 

• Help accesses the on-line help for the form.

See the following sections for additional information:

• For information on creating services, see “Creating a service for Passport 
devices” (page 178)
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•  For information on the service template forms for specific services, see 
241-6001-611 Preside MDM Nodal and Service Provisioning Reference 
Guide.

Service edit form for Passport devices
The service edit form lets you edit a service that corresponds to a component 
in the component hierarchy. 

A service edit form opens when you select Edit from the Selected or pop-up 
menu for a selected service component.

Note: Selecting Add from the pop-up menu does not invoke the service 
form. It lets you add a subcomponent to the service component (for 
example, DLCI to a FRUNI).

Service edit forms display the attributes of the one or more components that 
make up the service. Each component is represented by a separate tab. When 
you select a tab, the attributes for the selected component are displayed.

The figure “Example of a Service edit form” (page 116) shows the service 
edit form for an AtmIf/10 on EM/Atlanta.
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Figure 10
Example of a Service edit form

The service form has the following command buttons:

• OK validates and saves the current data onto the device. The form closes 
after the service is saved successfully.

• Apply validates and saves the current data. The form remains open after 
the service is saved successfully.

• Cancel closes the service editor form without saving. 

• Help displays the on-line help for the form.

For information on using the service form, see “Editing a service for Passport 
devices” (page 180).
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Navigating component hierarchy and shelf 
view 

This section provides procedures for navigating the Nodal Provisioning 
window and the component hierarchy and shelf view. It contains the 
following sections:

• “Nodal Provisioning window navigation” (page 117)

• “Navigating the component hierarchy” (page 123)

• “Navigating the Passport shelf view” (page 130)

Nodal Provisioning window navigation
See the following sections for general procedures for navigating the main 
window:

• “Closing the current view” (page 118)

• “Switching between Passport component hierarchy and shelf view” 
(page 119)

• “Showing and hiding the toolbar” (page 120)

• “Showing and hiding the status bar” (page 121)

• “Detaching and reattaching the template palette” (page 122)
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Closing the current view
Use this procedure to close the current service data view at any time after you 
have opened a view in Nodal Provisioning.

Procedure
1 In the Nodal Provisioning window menu bar, select File -> Close View.

If you have made changes, you are prompted to save your changes 

2 Save your changes and click OK.

The component hierarchy in the main window is unpopulated. You can 
select a new view.
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Switching between Passport component hierarchy and 
shelf view

When you start Nodal Provisioning for Passport nodes, it opens with the 
component hierarchy view. You can, at any time, change between the 
component hierarch view and the Passport shelf view. 

Procedure
1 To switch to shelf view from component hierarchy view, in the menu bar of 

the Nodal Provisioning window, select View -> Shelf.

To switch to component hierarchy view from shelf view, in the menu bar of 
the Nodal Provisioning window, select View and then deselect Shelf.
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Showing and hiding the toolbar
Use this procedure to display or hide the toolbar in the Nodal Provisioning 
window.

Procedure
1 To switch from displaying the toolbar to hiding the toolbar, in the menu bar 

of the Nodal Provisioning window, deselect View -> Toolbar.

To switch from hiding the toolbar to displaying the toolbar, in the menu bar 
of the Nodal Provisioning window, select View -> Toolbar.
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Showing and hiding the status bar
Use this procedure to display or hide the status bar in the Nodal Provisioning 
window.

Procedure
1 To switch from displaying the status bar to hiding the status bar, in the 

menu bar of the Nodal Provisioning window, deselect View -> 
Statusbar.

To switch from hiding the toolbar to displaying the toolbar, in the menu bar 
of the Nodal Provisioning window, select View -> Statusbar.
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Detaching and reattaching the template palette
Use this procedure to detach the template palette from the Nodal Provisioning 
window in shelf view and component hierarchy view, and reattach it.

Procedure
1 Place your mouse cursor next to the title of the template palette - 

Templates. When the transparent hand appears, left-click. While holding 
down the left mouse button, drag the template palette away from the 
Nodal Provisioning window.

The template palette now appears as a separate window in the shelf view 
window.

2 Close the detached palette window to reattach the template palette.
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Navigating the component hierarchy
The following procedures apply to the component hierarchy in the component 
tree view or the component tree in the components drill down panel in the 
Passport shelf view.

• “Expanding a component” (page 124)

• “Compressing a component” (page 125)

• “Searching for a component in a large instance set” (page 126)

• “Hiding a single Passport component instance” (page 128)

• “Hiding all component instances” (page 129)

• “Detaching and reattaching the component and service hierarchies” 
(page 131)
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Expanding a component
When compressed, a components displays with a plus sign (+) in the 
component hierarchy. A compressed component does not display its 
subcomponents. Use this procedure to expand a component so that its next 
level of subcomponents displays in the component hierarchy. 

Procedure
1 In the component hierarchy, find the component or subcomponent that 

you want to expand.

A plus sign (+) appears to the left of the compressed component icon to 
indicate that the component is compressed.

2 Click the plus sign or double-click on the folder.

The selected component expands to the next level of subcomponent.
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Compressing a component
When expanded, a component displays a minus sign (-) in the component 
hierarchy. An expanded component displays the next level of subcomponents 
in the component hierarchy. Use this procedure to compress, or hide, the 
display of subcomponents in the component hierarchy.

Procedure
1 In the component hierarchy, find the component that you want to 

compress.

A minus sign (-) appears to the left of the component to indicate that the 
component is expanded.

2 Click the minus sign or double-click the folder.

The selected component in the component hierarchy compresses to the 
next level of sub-component.
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Searching for a component in a large instance set
The component hierarchy indicates when the number of component instances 
exceeds a pre-defined threshold size. A value of x of y indicates the 
proportion of instances displayed in the component hierarchy. For example, a 
value of “50 of 75” indicates that only 50 of 75 instances appear in the 
component hierarchy. Card and LP components are exceptions–they always 
display all instances. When you expand the parent folder, Nodal Provisioning 
does not automatically fetch all the instances and add them to the component 
hierarchy. Use this procedure to search for a specific component instance, or 
a subset of instances, for large components. 

You use a search dialog box to search for a component in a large instance set. 
The search dialog box also provides the ability to add or replace one or more 
component instances from the search list in the search dialog box to the 
component hierarchy. 

Related information
To control the number of instances that display in the component hierarchy, 
see “Setting User Preferences” (page 207).

Procedure
1 Select a folder whose component instances exceed the defined threshold 

size, as shown by the visual indicator (x of y) to the right of the folder.

2 Complete one of the following steps:

• Select Search from the Selected menu.

• Right-click and select Search from the pop-up menu.
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The Search dialog box opens.

3 Enter the criteria for the search in the search criteria field.

The search pattern may contain the wild card (*).

4 Click Search to initiate the search for the components that match the 
specified search criteria.

Components that meet the specified criteria appear in the search results 
list. 

5 From the list, select one or more components.

6 To add the selected components to the component hierarchy, click Add to 
Tree.

To replace component(s) in the tree, click Replace in Tree

To remove a component, right-click and select Remove from the pop-up 
menu.

To close the Search dialog box, click Close.

 The results of the search are displayed to the right of the folder. 

Search criteria 
field

Search results list

Command buttons
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Hiding a single Passport component instance 
Use this procedure to hide a component instance in the Passport component 
hierarchy. The Hide command is only available for children of a component 
with too many instances to display. These components are shown with a value 
of x of y in the component hierarchy. The command is not available for other 
items in the component hierarchy. 

Procedure
1 In the component hierarchy in the Nodal Provisioning window, select the 

folder containing the child component that you want to hide, and expand it.

2 Select the component instance that you want to hide.

3  From the Selected menu or the component’s pop-up menu, select Hide.

The selected component is hidden in the parent folder.
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Hiding all component instances 
Use this procedure to hide all component instances in a folder in the 
component hierarchy. The Hide Children command is only available for a 
folder, not for other items in the component hierarchy.

Procedure
1 In the component hierarchy in the Nodal Provisioning window, select the 

folder whose component instances you want to hide.

2  From the Selected menu or the component’s pop-up menu, select Hide 
Children.

All components are hidden in the parent folder.
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Navigating the Passport shelf view
The following procedures apply only to Passport shelf view. For shelf view 
navigation procedures, see the following sections:

• “Detaching and reattaching the component and service hierarchies” 
(page 131)

• “Viewing the root component” (page 132)

• “Viewing shelves” (page 133)

• “Viewing cards” (page 134)

• “Viewing configured logical processors” (page 135)

• “Viewing unconfigured logical processors” (page 136)

• “Viewing configured ports” (page 137)

• “Viewing unconfigured ports” (page 138)

• “Viewing configured channels” (page 139)

• “Viewing provisioned services” (page 140)
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Detaching and reattaching the component and service 
hierarchies

Use this procedure to detach the component and service hierarchies from the 
Passport shelf view.

Prerequisite
This procedure requires that you have selected the shelf view for a Passport 
node.

Procedure
1 Place your mouse cursor next to the Shelf Details title. When the 

transparent hand appears, left-click. While holding down the left mouse 
button, drag the panel away from the Nodal Provisioning window.

The selected panel now appears as a separate window.

2 Close the detached window to reattach the component and service drill 
down panels.
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Viewing the root component
Use this procedure to view the EM component. In Passport shelf view the EM 
root component (the device) is graphically displayed to the left of the logical 
processors. 

Prerequisite
This procedure requires that you have selected the shelf view for a Passport 
node.

Procedure
1 Left click in the area to the left of the graphical representation of the logical 

processor component.

This action populates the component drill down panel showing the 
component hierarchy rooted at the selected EM root.
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Viewing shelves 
Use this procedure to view the Passport shelf component. The shelf 
component is graphically displayed to the left of the cards in shelf view. 

Prerequisite
This procedure requires that you have selected the shelf view for a Passport 
node.

Procedure
1 Left click in the area to the left of the graphical representation of the card 

components.

This action populates the component drill down panel with the component 
hierarchy rooted at the selected shelf.
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Viewing cards
Use this procedure to view the Passport card components. All cards are 
graphically displayed in the shelf panel. 

Prerequisite
This procedure requires that you have selected the shelf view for a Passport 
node.

Procedure
1 Select a graphical representation of the card.

This action populates the component drill down panel with the 
component hierarchy rooted at the selected card.
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Viewing configured logical processors 
Use this procedure to view the Passportlogical processors. Configured logical 
processors (LPs) are shown graphically in the logical shelf view panel. 

Prerequisite
This procedure requires that you have selected the shelf view for a Passport 
node.

Procedure
1 In the logical shelf view panel, select a configured logical processor that 

has been assigned a main card, and/or spare card, or select an LP from 
the component hierarchy. 

This action has the following results:

• The connectivity between the selected logical processor and the 
main and/or spare card is shown graphically.

• The component drill down panel is populated with the component 
hierarchy whose top level elements are the service components that 
are linked to the selected rooted logical processor and any of its 
subcomponents.

• All ports, configured and unconfigured, are visible on the LP.
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Viewing unconfigured logical processors
Use this procedure to view unconfigured logical processors in Passport shelf 
view.

Unconfigured logical processors are visually distinguished from configured 
logical processors. Unconfigured logical processors are dark grey and contain 
no configured or unconfigured ports.

Prerequisite
This procedure requires that you have selected the shelf view for a Passport 
node.

Procedure
1 In the logical shelf view panel, select an unconfigured logical processor.

The contents of the component and service drill down panels are cleared.
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Viewing configured ports 
Use this procedure to view configured ports in Passport shelf view. 

Configured ports are shown graphically on logical processors, whether or not 
the logical processors have been configured with a main or spare card. 
Configured ports are visually distinguished from unconfigured ports by a 
raised border. Unconfigured ports are shown with a lowered border. If there 
are more ports on the logical processor than can be shown on the screen at 
once, scroll bars are enabled at the bottom of the logical processor through 
which you can pan up and down.

Prerequisite
This procedure requires that you have selected the shelf view for a Passport 
node.

Procedure
1 Select a configured port. 

This action has the following results:

• The component drill down panel is populated with a component 
hierarchy rooted in the selected port.

• If the selected port is not channelized, the service drill down panel is 
populated with a component hierarchy rooted at any service that is 
configured on the port.

• If the selected port is channelized, the service drill down panel is 
populated with a component hierarchy for each service that is 
configured on any of its channels.
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Viewing unconfigured ports
Use this procedure to view unconfigured ports in Passport shelf view. 

All ports are shown graphically on logical processors that have been 
configured with a main or spare card. If a logical processor has not been 
configured with a main or spare card, only the configured ports display 
graphically.

Unconfigured ports are visually distinguished from configured ports by a 
lowered border. Configured ports have raised borders and display their port 
identifier.

If there are more ports on the logical processor than can be displayed on the 
screen at once, scroll bars are enabled at the bottom of the logical processor 
through which you can pan up and down.

Prerequisite
This procedure requires that you have selected the shelf view for a Passport 
node.

Procedure
1 Select an unconfigured port.

The contents of the component and service drill down panels are cleared.
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Viewing configured channels
Use this procedure to view configured channels in Passport shelf view.

Prerequisites
This procedure requires the following conditions:

• you have selected the shelf view for a Passport node

• the channel you want to view is on a configured port

Procedure
1 Select a graphical representation of a configured channelized port.

This action has the following results:

• The component drill down panel is populated with a component 
hierarchy rooted at the selected port. 

• The service drill down panel is populated with component hierarchies 
for each service configured on any channel of the selected port.

2 In the component drill down panel, expand the port component.

The channels that have been configured on this port are shown as 
children of the port.

3 In the component drill down panel, select a channel.

If the selected channel has a configured service, the service drill down 
panel is populated with a component hierarchy rooted at the service that 
is configured on that channel.
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Viewing provisioned services
Use this procedure to view provisioned services in Passport shelf view.

Prerequisite
This procedure requires that you have selected the shelf view for a Passport 
node.

Procedure
1 Select a graphical representation of a logical processor or a configured 

port.

If a logical processor is selected, the service drill down panel is populated 
with one or more component hierarchies rooted at the service provisioned 
on ports configured on the selected logical processor.

If the port is channelized, the service drill down panel is populated with 
one or more components hierarchies rooted at the services provisioned 
on that port or on channels of that port. 

2 If the port is channelized, in the component drill down panel, expand the 
port component and select a channel.

The service drill down panel is populated with a component hierarchy 
rooted at the service provisioned on that channel, if it exists.
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Nodal Provisioning procedures

This section provides component and service provisioning procedures using 
Nodal Provisioning, as well as some generic error resolution procedures. This 
section contains the following topics:

• Displaying online help

— “Displaying help on the Nodal Provisioning window” (page 145)

— “Displaying help on attributes” (page 146)

— “Displaying tool tips for attribute ranges” (page 148)

— “Displaying help on dialogs and forms” (page 147)

• Provisioning components

— “Component provisioning procedures overview” (page 149)

— “Viewing and saving a record of changes made during a 
provisioning session” (page 150)

— “Adding a single component instance” (page 152)

— “Finding a component” (page 154)

— “Adding a new LogicalProcessorType component” (page 155)

— “Adding a new LogicalProcessorType component” (page 155)

— “Editing a component instance” (page 159)

— “Editing a ScsSoftware component” (page 160)

— “Migrating Passport software” (page 162)
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— “Editing a LogicalProcessorType component” (page 163)

— “Deleting a component” (page 165)

— “Cutting, copying and pasting components” (page 166)

— “Creating multiple instances of a Passport component” (page 185)

— “Cutting, copying, and pasting Passport components between 
views” (page 172)

• Provisioning in Shelf View

— “Shelf view provisioning procedures” (page 174)

— “Provisioning an unprovisioned Logical Processor” (page 175)

— “Provisioning an unconfigured port” (page 176)

• Provisioning services

— “Service provisioning procedures for Passport devices” (page 177)

— “Creating a service for Passport devices” (page 178)

— “Editing a service for Passport devices” (page 180)

— “Deleting a service for Passport devices” (page 182)

— “Creating multiple instances of a Passport service” (page 187)

— “Repairing Passport service creation errors overview” (page 194)

• Working with multiple instances

— “Creating multiple instances of a Passport component or service” 
(page 183)

— “Canceling the current or remaining instances during a multiple 
creation of Passport components or services” (page 189)

• Checking provisioning changes

— “Checking the Passport view during a provisioning session” 
(page 191)

— “Performing a full semantic check for Passport devices” (page 192)

— “Performing a partial semantic check” (page 193)

• Trouble shooting
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— “Repairing Passport service creation errors overview” (page 194)

— “Repairing Passport service creation errors” (page 199)

— “Resolving a restorePossible error condition” (page 201)

— “Resolving a journalDisabledReason error condition” (page 203)

— “Showing MPE 9500 configuration conflicts” (page 205)

• Committing an MPE 9500 configuration

— “Committing an MPE 9500 configuration” (page 206)

• Customizing Nodal Provisioning

— “Setting User Preferences” (page 207)

— “Customizing the Nodal Provisioning start up” (page 214)
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Displaying online help
See the following sections for displaying online help:

• “Displaying help on the Nodal Provisioning window” (page 145)

• “Displaying help on attributes” (page 146)

• “Displaying tool tips for attribute ranges” (page 148)

• “Displaying help on dialogs and forms” (page 147)
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Displaying help on the Nodal Provisioning window
Use this procedure to access the Help on Window from the Help menu from 
the Nodal Provisioning, Nodal Provisioning Template Editor, Log Viewer and 
Report Generator windows. Help on Window displays the Online 
documentation for the main window, menus and tool bars, and the general 
functions.

Procedure steps
1 On the Help menu, click Help on Window.

A window opens with general descriptive help for the Nodal Provisioning 
tool. 
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Displaying help on attributes 
You can display descriptive information on selected attributes through pop-up 
dialog boxes.

Procedure steps
1 Right-click on an attribute field.

2 On the pop-up menu, click Help.

A dialog box opens displaying information about the attribute.

For an example of attribute descriptive help, see the illustration “Example 
of attribute descriptive help” (page 146).

Figure 11
Example of attribute descriptive help
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Displaying help on dialogs and forms
Use this procedure to access help information for the Nodal Provisioning, 
Nodal Provisioning Template Editor, Log Viewer and Report Generator 
dialogs, and for component, service and service template forms. 

Procedure steps
1 Open a form.

2 Click Help.

A window opens with descriptive help for the form.
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Displaying tool tips for attribute ranges
Use this procedure to access a pop-up dialog box that displays tool tips that 
give the valid ranges for some attributes.

Procedure steps
1  Place the mouse pointer on an attribute field for two seconds. 

A pop-up tool tip dialog box opens displaying the valid ranges for the 
attribute.
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Component provisioning procedures overview
See the following sections for component provisioning procedures:

• “Adding a single component instance” (page 152)

• “Finding a component” (page 154)

• “Adding a new LogicalProcessorType component” (page 155)

• “Editing a component instance” (page 159)

• “Editing a ScsSoftware component” (page 160)

• “Editing a LogicalProcessorType component” (page 163)

• “Deleting a component” (page 165)

• “Cutting, copying and pasting components” (page 166)

• “Cutting, copying, and pasting Passport components between views” 
(page 172)

• “Creating multiple instances of a Passport component” (page 185)
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Viewing and saving a record of changes made during a 
provisioning session

Use this procedure to view and save to a file a record of the actions that you 
have taken and the changes that you have made during the provisioning 
session.

Procedure steps
1 From the View menu in the Nodal Provisioning window, select History.

The History of Changes dialog box opens showing a record of the 
actions and changes that have occurred.

2 Select Save to File.

The History File dialog box opens.
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3 Select a location and specify a file name.

4 Select Save to save a new file to the specified location.

Select Update to update the contents of a directory.

Select Cancel to cancel the save operation.
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Adding a single component instance
Use this procedure to add a single component instance to a selected 
component in the component hierarchy. You use the Add Component dialog 
box to add a single component instance.

You can also add more than one instance of the same component. For the 
procedure to add multiple component instances, see “Creating multiple 
instances of a Passport component or service” (page 183).

Prerequisites
This procedure requires the following condition:

• you are in not in read only mode

Procedure steps
1 Select one of the following actions, depending on the device you want to 

provision. 

2 Select the component that you want to provision.

3 Complete one of the following actions.

• Right-click on the parent component and select Add from the pop-up 
menu.

• On the Selected menu, click Add.

For... Locate the parent component by...

Passport or 
MPE

Expanding the component hierarchy to the parent of the 
component you want to add. 

Passport Selecting a graphical representation of the parent 
component in shelf view.
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The Add Component dialog box opens. The Component Name list 
contains the components that you can add to the selected component.

4 In the Component Name list, click the component that you want to add.

The selected component appears in the Choose a component field. 

5 To add the component, click Ok.

A component creation form opens and displays the provisionable 
attributes for the component.

6 In the component creation form, enter or edit the attribute values.

7 To validate the form and save the current data, click OK 

The component is added to the component hierarchy. If the component 
you add is a network-wide component, then a global icon displays to the 
left of the component name. 

If an error occurs during validation or saving, an error dialog box opens 
and the component form remains open. You can obtain additional details 
about the error condition by clicking Details.

8 Save your view. See “Post-provisioning procedures” (page 219).

selected component for the 
add component operation
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Finding a component
You can find a specific component without having to scroll through a lengthy 
component list. Use the Find a Component dialog box to help locate a specific 
component. Using this dialog box, you can specify a specific component or 
search the list of components based on search criteria.

Prerequisites
This procedure requires the following conditions:

• you are not in read only mode

Procedure steps
1 Complete one of the following actions:

• Right-click a component in the component tree view and from the 
resulting pop-up menu, click Find and select a component.

• Click the Find and select a component icon from the task bar.

The Find a component dialog box opens.

2 In the Find a component dialog box, type the component name and then 
go to step 5. Otherwise go to step 3 to search for a component.

3 Specify the appropriate search criteria and click Search.

The Component Search Results list displays the results of the search. 

4 Click the appropriate component name in the Component Search 
Results list.

5 Click OK. 

The Find a component dialog box closes and the selected component is 
highlighted in the component tree view.
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Adding a new LogicalProcessorType component
Use this procedure to add a new ScsLogical Processor Type (Lpt) component 
and provision the featurelist attribute.

When you add a new Lpt, Nodal Provisioning displays candidate values, 
derived from the device, for the attribute “featureList”. You can select the 
values that you want to use from the list. 

Prerequisites
This procedure requires the following condition:

• you are not in read only mode

Procedure steps
1 In the component hierarchy in the Nodal Provisioning window, select the 

Sw component.

2 Complete one of the following steps:

• Right-click and select Add from the pop-up menu.

• In the menu bar, select the Selected menu option and then select 
Add.

•

The Add Component dialog box opens.
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3 Select the Lpt component, and click Ok.

The Sw (Create Lpt) component form opens.

The component form displays two lists for the “featureList” attribute:

• Available Features lists all the features (services) supported by the 
software loaded into the current view on the device.

• Selected Features is empty when the create Lpt form opens.

The Component Name field displays the 
components that you can add to the component 
that is selected in the component hierarchy.

The Choose a component field displays the 
selected component
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4 To add a new feature to the Selected Features list, from the Available 
Features list, select a required feature value and click Add or 
alternatively, double click on the feature value in the Available Features 
list.

The item selected in the Available Features list moves to the Selected 
Features list. 

5 Repeat step 4 to add additional feature values until you have build the 
value set for featureList.

If you want to remove a feature, from the Selected Features list, select 
the feature that you want to remove and click Remove. The feature moves 
to the Available Features list.

6 In the Lpt field, enter a key value for the new Lpt component.

7 Click OK.

The values from the Selected Features list are used to set the value for 
the “featureList” attribute. The new Lpt appears under the Sw component 
in the Nodal Provisioning window.

If any of the selected features are not supported by the software loaded 
into the current view, a warning dialog box opens. The warning dialog box 
lists the features that are not supported. You are given the option to keep 
them in the feature list or to remove them from the feature list. If you 
remove them, they are lost permanently since they are not put back into 
Preside MDM Nodal Provisioning User Guide   15.1RSUP



158   Chapter 7 Nodal Provisioning procedures
the Available Features list once they are removed from the Selected 
Features list. 
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Editing a component instance
Use this general procedure to change attributes for a component. For 
components that have a graphical representation in shelf view, you can select 
the component to be provisioned by its graphical representation in the shelf 
view or by its hierarchical representation in the drill down panels.

Prerequisites
This procedure requires the following condition:

• you are not in read only mode

Procedure steps
1 Select one of the following actions, depending on the device you want to 

provision. 

2 Select the component that you want to provision.

3 Complete one of the following actions.

• Right-click on the component and select Edit from the pop-up menu.

• On the Selected menu, click Edit.

A component edit form opens, containing the component attributes that 
you can provision.

4 Make the required changes to the attribute values in the form.

5 To validate the changes and close the form, click OK.

To keep the form open, click Apply. The current service data is validated 
and saved.

6 Save the view. See “Saving the view for Passport devices” (page 220).

For... Locate the component by...

Passport or 
MPE

Expanding the component hierarchy to display the 
component you want to edit. 

Passport Selecting the graphical representation of the component 
in shelf view.
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Editing a ScsSoftware component
Use this procedure to set new values for an existing avList attribute for the 
ScsSoftware (Sw) component.

When you edit the Sw component, Nodal Provisioning component edit form 
displays the available and selected candidate values, derived from the device, 
for the avList attribute. You can modify an existing avList attribute by adding 
or removing candidate values. 

Prerequisites
This procedure requires the following condition:

• you are not in read only mode

Procedure steps
1 In the Nodal Provisioning window, select the Sw component.

2 Complete one of the following steps:

• Right-click and select Edit from the pop-up menu.

• On the Selected menu, click Edit.

The Edit Sw form opens and displays two lists for the avList attribute: the 
Available Versions list which shows the available avList values and the 
Selected Versions list which shows the currently selected avList values. 

3 To add a value, select a value from the Available Versions list and click 
the Add button, or double-click on a value. This step adds this value to the 
Selected Versions list.
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To remove a value, select a value in the Selected Versions list and click 
the Remove button, or double-click on a value. This step moves the value 
from the Selected Versions list to the Available Versions list.

4 Repeat step 3 for each value that you wish to add or remove from the 
avList attribute.

5 If you want to modify the ScsSoftware component and close the form after 
the data is successfully saved, click OK.

If you want the form to remain open, click Apply. The current service data 
is validated and saved.
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Migrating Passport software
Use this procedure when a Passport software migration occurs during a Nodal 
Provisioning session. If you are connected to a Passport device in your Nodal 
Provisioning session and a software migration is subsequently activated 
during that session, use this procedure to ensure you access the latest 
software.

Procedure steps
1 To migrate Passport software, modify the avList of the Sw component as 

required. See “Editing a ScsSoftware component” (page 160).

2 Save the view. See “Saving the view for Passport devices” (page 220).

3 Active the view. See “Activating and Committing the View for Passport 
devices” (page 223). 

4 On the Nodal Provisioning File menu, click New Device.

The Nodal Provisioning-Device Selection dialog box opens.

5 In the Nodal Provisioning-Device Selection dialog box, select the same 
Passport to provision and then click OK.

The Nodal Provisioning-Device Selection dialog box closes.

6 Open the current view. See “Opening a view for Passport devices” 
(page 53). 

A new connection to the Passport is established, Nodal Provisioning 
retrieves the new model, generates the model files if required, and 
refreshes the template panel.
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Editing a LogicalProcessorType component
Use this procedure to set new values for an existing featureList attribute for a 
provisioned Logical Processor Type (Lpt) component.

 When you edit the Lpt component, the Nodal Provisioning tool component 
edit form displays the selected and available candidate values, derived from 
the device, for the featureList attribute. You can modify an existing 
featureList attribute by adding or removing candidate values. 

Prerequisites
This procedure requires the following condition:

• you are not in read only mode

Procedure steps
1 In the Nodal Provisioning window, expand the Sw component so that 

you can view its subcomponents.

2 From the component hierarchy, select the Lpt component.

3 Complete one of the following steps.

• Right-click and select Edit from the pop-up menu.

• In the menu bar, select the Selected menu option and then select 
Edit.

The edit Lpt form opens and displays two lists for the featureList attribute: 
the Selected Features list which shows the currently selected featureList 
Preside MDM Nodal Provisioning User Guide   15.1RSUP



164   Chapter 7 Nodal Provisioning procedures
values, and the Available Features list which shows the available 
featureList values. 

4 To add a value, double-click on a value from the Available Features list 
or select a value and click the Add button. This step adds this value to the 
Selected Features list.

To remove a value, double-click on a value or select a value in the 
Selected Features list and click the Remove button. This step moves the 
value from the Selected Features list to the Available Features list.

5 Repeat step 4 for each value that you wish to add or remove from the 
featureList attribute.

6 I f you want to modify the The LogicalProcessorType component and 
close the form after the data is successfully saved, click OK.

 If you want the form to remain open, click Apply. The current data is 
validated and saved. 
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Deleting a component
Use this procedure to delete a component and all its subcomponents. 

Prerequisites
This procedure requires the following condition:

• you are not in read only mode

Procedure steps
1 Select one of the following actions, depending on the device you want to 

provision. 

2 Select the component that you want to provision.

3 Complete one of the following actions.

• Right-click on the component and select Delete from the pop-up 
menu.

• On the Selected menu, click Delete.

A confirmation dialog box opens asking you to confirm the delete.

4 Click Yes to confirm the delete.

The component and its subcomponents are removed from the component 
hierarchy.

If there are errors, an error dialog box opens and describes the error. 
Correct the errors.

5 Save the view. See “Saving the view for Passport devices” (page 220).

For... Locate the component by...

Passport or 
MPE

Expanding the component hierarchy to display the 
component you want to delete. 

Passport Selecting the graphical representation of the component 
in shelf view.
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Cutting, copying and pasting components 
You can cut, copy, and paste a component and its subcomponents, within and 
between supported devices. To perform these operations between devices, 
you need to open two Nodal Provisioning sessions. Then you can cut or copy 
a component from one Passport device and paste it to another, or cut or copy 
a component from one Nortel Networks Multiservice Provider Edge device 
and paste it to another. The paste operation always checks the paste target to 
make sure that it is a valid action for the copied component. When cutting, 
copying, and pasting between devices, the client for the cut and copy 
operations and the client for the paste operation must be connected to the 
same Configuration Manager.

When you cut or copy and paste a component, the component and all of its 
selected subcomponents are cut or copied from the source component and 
pasted into the target component. Therefore, if you cut or copy a component 
with a large number of subcomponents, it may take several minutes.

When copying and pasting within a Passport device, Nodal Provisioning uses 
the on-switch copy function. When the actions occur between Passport 
devices, Nodal Provisioning uses the off-switch copy function. In some cases, 
minor differences in output can occur. For example, when you copy 
components within a node that have attributes based on instance values, the 
on-switch copy function regenerates any attributes based on new instance 
values. If you copy these components between nodes, the off-switch copy 
function does not regenerate the attributes. Since such differences in output 
can occur, it is recommended that you verify the output of copy actions.

For Passport devices, you can also cut, copy, and paste between the shelf and 
component tree views.

For procedure, see 

• “Cutting and copying components” (page 167)

• “Pasting Components” (page 170)

• “Cutting, copying, and pasting Passport components between views” 
(page 172)
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Cutting and copying components
Use this procedure to cut or copy a component and its subcomponents for use 
within or between devices.

You use the cut or copy dialog boxes to copy components and their 
subcomponents. The cut and copy dialog boxes open only when the 
component that you select for the cut or copy operation has subcomponents.

Prerequisites
This procedure requires the following condition:

• you are not in read only mode

Procedure steps
Note: The cut and copy commands are enabled in the Selected and pop-
up menus only if the cut or copy is a valid action.

1 Select the component that you want to cut or copy.

2 Complete one of the following steps:

• Right-click and select Cut or Copy from the pop-up menu or

• In the menu bar, select the Selected menu option and then select 
Cut or Copy.

A cut or copy components dialog box opens. The dialog box displays the 
selected component and its children.

3 In the dialog box, select the component or the subcomponents that you 
wish to cut or copy. 
Preside MDM Nodal Provisioning User Guide   15.1RSUP



168   Chapter 7 Nodal Provisioning procedures
Example of a copy component dialog box 

Selected components are shown by a check mark to the left of the 
component. 

Selecting or deselecting the parent component automatically selects or 
deselects all its children. You can also select the individual 
subcomponents that you want to copy.

You are provided a visual indicator when not all the children are included 
in the cut or copy operation. The background color of the parent 
components up the component hierarchy change color to a light grey. This 
color change occurs in the following situations:

• when you deselect one of the children in the cut or copy components 
dialog boxes.

• when the number of children for a component exceeds a predefined 
threshold, as indicated visually to the right of the folder in the nodal 
provisioning main window, as (x of y) where x is maximum number of 
children shown and y is the total number of instances. You have to 
search for component instances and add them to the component 
hierarchy if you want them to be part of the cut or copy operation. See 
“Searching for a component in a large instance set” (page 126).

4 To proceed with the cut or copy operation, click OK.

Components selected for 
the copy operation are 

shown with a check next 
to them
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The device information for the selected components is retrieved and, if the 
paste is done between devices, the information is stored so that it can be 
retrieved for later use when you execute the paste command. 

The status bar updates to indicate that the component was copied 
successfully. If you have selected a component with a large number of 
subcomponents, the cut or copy action may take several minutes.

To cancel the operation, click Cancel.

5 Paste the cut or copied component into the target. See “Pasting 
Components” (page 170).
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Pasting Components
The paste dialog box opens when you select the target component in which to 
paste a copied component, and then select Paste from the Selected menu, or 
click the mouse menu button and select paste from the available options. The 
target can be within the same device hierarchy or on a different device 
hierarchy. However, the source and target must be connected to the same 
Configuration Manager.

Prerequisites
This procedure requires the following conditions:

• you are not in read only mode

• you have previously copied a component. See “Cutting and copying 
components” (page 167).

Procedure steps
Note: The paste command is enabled in the Selected and pop-up menus 
only if the paste is a valid action and the cut or copy action is complete.

1 Select the target component for the paste action.

The target component can be within and between supported devices and 
between shelf and component hierarchy view. 

2 Complete one of the following steps:

• Right-click and select Paste from the pop-up menu, or

• In the menu bar, select the Selected menu option and then select 
Paste.

A dialog box opens that lets you enter an identifier for the new component. 
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3 Enter an identifier, and click OK to initiate the paste operation.

The status bar in the Nodal Provisioning window updates to indicate 
that the component was pasted successfully. If you are pasting a 
component with a large number of subcomponents, the paste action may 
take several minutes.

The component and all of its subcomponents are created under the target 
component. The status bar updates, stating that the component was 
pasted successfully. This may take several minutes.

Note:  If an error occurs during the cut/copy and paste action, such as 
when you cut/copy a component instance from one device to another with 
incompatible model files, an error dialog box opens. The dialog box 
identifies the error, and the components that were created. For additional 
information, see “Repairing Passport service creation errors overview” 
(page 194).

4 Modify the attributes for the pasted components as desired. To modify the 
attributes for the pasted component, you need to use the procedure 
described in “Editing a component instance” (page 159). 

5 Save the view. See “Post-provisioning procedures” (page 219).
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Cutting, copying, and pasting Passport components 
between views

Use this procedure for Passport devices to cut or copy components and their 
subcomponents in shelf view and paste them in component hierarchy view. 

When you cut or copy and paste a component, the component and all of its 
selected subcomponents are cut or copied and pasted into the target 
component. Therefore, if you cut or copy a component with a large number 
of subcomponents, it may take several minutes.

Prerequisites
This procedure requires the following conditions:

• you are not in read only mode

• the source and target are connected to the same Configuration Manager

Procedure steps
1 In the shelf view, select the component that you want to cut or copy.

2 Complete one of the following actions:

• right-click and select Cut or Copy from the pop-up menu

• on the Selected menu, click Cut or Copy

If the selected component does not have subcomponents, then the cut or 
copy operation is completed. Otherwise, if the selected component has 
subcomponents a dialog box opens and displays the selected component 
and its children. 

3 In the dialog box

• select the component and subcomponents that you want to cut or 
copy

• click OK

The status bar indicates that the component was successfully copied or 
deleted. If you have selected a component with a large number of 
subcomponents, the cut or copy action may take several minutes.

4 Switch to the component tree view using one of the following actions:

• in the tool bar, click the shelf icon 

• on the View menu, clear the Shelf check box
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5 In the component tree view, select the target component for the paste 
action.

6 Complete one of the following actions:

• right-click and select Paste from the pop-up menu

• On the Selected menu, click Paste.

Note:  The Paste command is enabled only if the paste is a valid action 
and the cut or copy action is complete.

A paste dialog box opens that lets you enter an identifier for the new 
component.

7 Enter an identifier, and click OK to initiate the paste operation.

The status bar updates to indicate that the component was pasted 
successfully. If you are pasting a component with a large number of 
subcomponents, the paste action may take several minutes. The status of 
the paste operation is shown in the status bar.

Note:  If an error occurs during the cut or copy and paste action, such as 
when you cut or copy a component instance from one device to another 
with incompatible model files, an error dialog box opens. The dialog box 
identifies the error, and the components that were created. For additional 
information, see “Repairing Passport service creation errors overview” 
(page 194).

8 Modify the attributes for the pasted components, as desired. See “Editing 
a component instance” (page 159). 

9 Save the view. See “Post-provisioning procedures” (page 219). 
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Shelf view provisioning procedures 
The following component level provisioning procedures can only be 
performed in shelf view:

• “Provisioning an unprovisioned Logical Processor” (page 175)

• “Provisioning an unconfigured port” (page 176)
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Provisioning an unprovisioned Logical Processor
Use this procedure to provision an unprovisioned Logical Processor (LP) in 
shelf view. The following options are available from the Selected menu or 
pop-up menu to provision an unprovisioned logical processor:

• Add a new LP

• Paste a copied LP to provision this LP

Prerequisites
This procedure requires the following condition:

• you are not in read only mode

Procedure steps
1 In the Logical Shelf panel, select the graphical representation of an 

unconfigured logical processor.

2 Complete one of the following steps:

• Right-click and select the desired command (Add or Paste) from the 
pop-up menu, or

• In the menu bar, select the Selected menu option and then select the 
desired command (Add or Paste).

If you select Add, a component edit dialog box opens on the new logical 
processor component. Selecting OK creates the new logical processor.

If you select Paste, a copied logical processor is pasted to this logical 
processor.

3 Save the view. See “Post-provisioning procedures” (page 219).
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Provisioning an unconfigured port
Use this procedure to provision an unconfigured port in shelf view. The 
following options are available from the Selected menu or pop-up menu to 
configure an unconfigured port:

• Add a port

• Paste a copied port to this port

Prerequisites
This procedure requires the following condition:

• you are not in read only mode

Procedure steps
1 In the Logical Shelf panel, select an unconfigured port.

2 Complete one of the following steps:

• Right-click and select the desired command (Add or Paste) from the 
pop-up menu, or

• In the menu bar, select the Selected menu option and then select the 
desired command (Add or Paste).

Depending on which action you selected, the following happens:

• If you select Add, the Add Component dialog box opens with a list 
of port types that are supported by the port that is being created. 
Proceed to step 3. If only one port type is supported, the Add 
Component dialog box does not open, and the port is automatically 
selected. The component editor form opens.

• If you select Paste, the last copied component is pasted as a child of 
the port, if it is a valid type.

3 Select a port type.

A component edit dialog box opens on the new port component.

4 Edit the attributes in the dialog box, as desired.

5 Click OK.

The new port is created.

6 Save the view. See “Post-provisioning procedures” (page 219).
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Service provisioning procedures for Passport devices
For the provisioning tasks that you can perform at the service level, see the 
following sections:

• “Creating a service for Passport devices” (page 178)

• “Editing a service for Passport devices” (page 180)

• “Deleting a service for Passport devices” (page 182)
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Creating a service for Passport devices 
Use this procedure to create a single instance of a service. 

If you wish to create multiple instances of a service, see the section “Creating 
multiple instances of a Passport component or service” (page 183).

Prerequisites
This procedure requires the following condition:

• you are not in read only mode

Procedure steps
1 If selecting a component from the component hierarchy in component 

hierarchy view, or its hierarchical representation in shelf view, expand the 
component hierarchy to display the target component for the new service. 
For the procedure to expand a component, see “Expanding a component” 
(page 124).

Note:  This is either the parent component for the root component of the 
service or a component to which the root component or one of its 
subcomponents is to be linked.

2 Select the component.

3 Apply the template using one of the following methods:

• Click the tabbed pane in the service template palette to go to the 
service group. Select an template icon for the required service and 
drag and drop the template onto a valid target component, or

• Select Apply Service Template from the pop-up menu or Selected 
menu. Select the service and then select the template from the list of 
available templates, or

• Select the appropriate drop site, click on the template icon and select 
Launch from the pop-up menu.

A service template for the service opens containing the attributes that you 
must enter to create a service. For some attributes, you can access the 
range and default information by resting the mouse pointer on the 
attribute.

4 Enter the data to provision the service.

5 In the service template, click OK.
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If there are no errors, the updated component and service information is 
added to the tree and displayed when their parents are expanded. 
Proceed to Step 6.

If there is an error in the data entered into the attribute fields, an error 
dialog box opens and the service template dialog box remains open. 
Correct the error. Proceed to step 6.

If an error occurs while the service is being created, but before 
components are created, an error dialog box opens. Correct the error and 
return to step 1.

If an error occurs after some of the components in the service are created, 
a service creation error dialog box opens. Correct the error. See 
“Repairing Passport service creation errors overview” (page 194).

6 Save the view. See “Post-provisioning procedures” (page 219).
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Editing a service for Passport devices
Use this procedure to edit a service if the service corresponds to a single 
component and its subcomponents in the component hierarchy. For 
components that have a graphical representation in shelf view, you can select 
the component to be provisioned by its graphical representation in the shelf 
view or its hierarchical representation in the drill down panels.

Prerequisites
This procedure requires the following condition:

• you are not in read only mode

Procedure steps
1 If selecting a component from the component hierarchy in component 

hierarchy view, or its graphical or hierarchical representation in shelf view, 
expand the component hierarchy to display the root component of the 
service. For the procedure to expand a component, see “Expanding a 
component” (page 124).

If selecting a component from the its graphical representation in shelf 
view, proceed directly to step 2.

2 Select the service component that you want to edit.

3 Complete one of the following steps:

• Right-click and select Edit Service from the pop-up menu, or

• In the menu bar, select the Selected menu option and then select 
Edit Service.

A service form opens, containing a tabbed form for each of the 
components for the service. Each form lists the attributes of one of the 
components that was created when the service was added.

4 Select the tab for the component that you want to modify.

5 Modify the component attributes.

Note:  Do not click OK until you have completed editing all the attribute 
values that you want to change.

6 If you want to edit the attribute values on the service and close the form, 
click OK.

If an error occurs, an error dialog box opens with an error message. The 
form remains open. Correct the error and click OK.
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If you want the form to remain open, click Apply. The data is validated and 
saved.

7 Save the view. “Post-provisioning procedures” (page 219).
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Deleting a service for Passport devices
Use this procedure to delete a service if it has a single root component and 
there is a corresponding service model. 

Prerequisites
This procedure requires the following condition:

• you are not in read only mode

Procedure steps
1 In the Nodal Provisioning window, expand the component hierarchy to 

display the root component of the service.

2 Select the component that you want to delete

3 Complete one of the following steps:

• Right-click and select Delete from the pop-up menu, or

• In the menu bar, select the Selected menu option and then select 
Delete.

The component and its subcomponents are removed from the component 
hierarchy. 
241-6001-610   15.1RSUP   



Chapter 7 Nodal Provisioning procedures   183
Creating multiple instances of a Passport component or 
service 

Nodal provisioning provides the ability to create multiple instances of a 
Passport component or service. This functionality is accessed by clicking the 
Multiple Creations button on the component or service creation form to open 
the Multiple Creations dialog box. This dialog box allows you to specify how 
you want the multiple instances of the service, or component, to be created.

The Multiple Creations form provides a text field for each root level 
component so that you can enter a key value pattern for the component or 
service. The table “Valid key value patterns” (page 183) describes valid key 
value patterns. 

Alternately, you can enter the key value directly in the key field in the service 
creation or component creation form. The value that you enter in the key field 
of the service or component creation form is copied to the Multiple Creation 
form as a default pattern.

The Multiple Creations dialog box also gives you the option to display the 
dialog box for each instance. If, however, there are any attributes in the 
service or component whose value can not be pre-defined, the Display form 

Table 13
Valid key value patterns

Description  Key Value Pattern Key Values

All key values separated by a 
comma

1, 2, 3, 7, 9, a, b 1, 2, 3, 7, 9, a, b

A range value 1-3, 7-9, a, b 1, 2, 3, 7, 8, 9, a b

A range value a-c, g-i, a, b, c, g, h, i

A prefix and a suffix separated by a 
colon

any:1-3, 7-9 any1, any2, any3, any7, 
any8, any9

More than one pattern separated 
by a semicolon

0.:1-3; 1.:7-9 0.1, 0.2, 0.3, 1.7, 1.8, 1.9
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for each instance check box is automatically selected and disabled. 
Consequently, for these cases, each individual component or service creation 
form is displayed, and you need to enter values for such attributes. 

If there are no attributes whose value can not be predefined, you have the 
option of selecting or deselecting the Display form for each instance check 
box. If the check box remains unselected, the Nodal Provisioning tool creates 
all services or components automatically when you click OK. If you select the 
check box, a component or service creation form opens for each instance.

You can also cancel service or component creations from the component or 
service creation form. The form provides a Cancel button which opens the 
Cancel Creation dialog box. This dialog box gives you two options:

• Cancel the current instance only which cancels the creation of the 
current service or component instance and then displays the next service 
or component

• Cancel the current and the remaining instances which cancels the 
creation of the current service or component instance, and all remaining 
instances. You return to the Nodal Provisioning window.

For relevant procedures, see the following sections:

• “Creating multiple instances of a Passport component” (page 185)

• “Creating multiple instances of a Passport service” (page 187)

• “Canceling the current or remaining instances during a multiple creation 
of Passport components or services” (page 189)
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Creating multiple instances of a Passport component
Use this procedure to create multiple instances of the same component.

Prerequisites
This procedure requires following condition:

• you are not in read only mode

Procedure steps
1 In the Nodal Provisioning window, select a component.

2 Complete one of the following steps.

• Right-click and select Add from the pop-up menu, or

• In the menu bar, select the Selected menu option and then select 
Add.

The Add Component dialog box opens.

3 In the Add Component dialog box, select the component that you want 
to add and click OK.

A component creation form opens.

4 Enter the required values for each attribute.

5 Click Multiple Creations.

The Multiple Creations dialog box opens.

6 In the Component Key Assignment field in the Multiple Creations 
dialog box, enter a key pattern. See “Valid key value patterns” (page 183).

7 If you want to see the Multiple Creations dialog box for each component 
instance, select the Display form for each instance check box.

If you want to create multiple components without showing each form, 
leave the Display form for each instance check box unchecked.

8 Click OK.

Nodal Provisioning analyzes the key value patterns that you have 
entered. One of the following happens:

• If you have made a key assignment error, a key assignment error 
dialog box opens. Click OK in the error dialog box, correct the key 
range in the Multiple Creations dialog box, and click OK.
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•  if there are no errors in the key pattern, and you have selected the 
Display form for each instance check box, the Multiple Creations 
dialog box closes and the first component instance creation form 
opens. The component creation form displays the first key value in 
the key field. The Multiple Creations button is disabled. Proceed to 
step 9. 

• If there are no errors in the key pattern, and you have not checked the 
Display form for each instance check box, all service instances are 
automatically created and display in the Nodal Provisioning 
window. 

• If you click Cancel in the Multiple Creations dialog box, the dialog 
box closes and you return to the dynamic component creation form.

9 Make any necessary modifications to the attribute values in the 
component creation form, if desired, and click OK.

If there are no errors in the values that you have entered, the first instance 
is created. This instance displays in the Nodal Provisioning window. The 
next component creation form opens with the next available key value 
displayed in the key field. Otherwise, if errors occur, correct the attribute 
values.

10 Repeat step 9 to create all remaining component instances. 

The component instances appear in the Nodal Provisioning window and 
are automatically assigned key values according to the key pattern that 
you have specified in the Multiple Creations dialog box.
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Creating multiple instances of a Passport service
Use this procedure to create multiple instances of the same service.

Prerequisites
This procedure requires the following condition:

• you are not in read only mode

Procedure steps
1 In the Nodal Provisioning window, select a component to which you wish 

to apply the service.

2 Complete one of the following steps:

• Right-click and select Apply Service Template from the pop-up 
menu and from the list of valid templates, select the service template 
that you want to apply

• In the menu bar, select the Selected menu option, select Apply 
Service Template. From the list of valid templates, select the service 
template that you want to apply.

A service creation form opens.

3 In the service creation form, enter the required values for each attribute.

4 Click Multiple Creations.

The Multiple Creations dialog box opens. The Multiple Creations dialog 
box contains text fields for each first level component defined in the 
service template.

5 In the Component Key Assignment fields, enter a key pattern to each 
key pattern field. See “Valid key value patterns” (page 183).

6 If you want to see the Multiple Creations dialog box for each service 
instance, select the Display form for each instance check box.

If you want to create multiple service instances without showing each 
form, leave the Display form for each instance check box unchecked.

7 Click OK.

Nodal Provisioning analyzes the key value patterns that you have 
entered. One of the following happens:

• If you have made a key assignment error, a key assignment error 
dialog box opens. Click OK in the error dialog box, correct the key 
range in the Multiple Creations dialog box and click OK.
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•  if there are no errors in the key pattern, and you have selected the 
Display form for each instance check box, the Multiple Creations 
dialog box closes and the first service creation form opens. The 
service creation form displays the first key value to each first level 
component in the service. The Multiple Creations button is disabled. 
Proceed to step 8. 

• If there are no errors in the key pattern, and you have not checked the 
Display form for each instance check box, the Multiple Creations 
dialog box, and the service creation dialog box close. All service 
instances are automatically created and display in the Nodal 
Provisioning window. 

• If you click Cancel in the Multiple Creations dialog box, the dialog 
box closes and you return to the dynamic service creation form.

8 Make any necessary modifications to the attribute values in the service 
creation form and then click OK.

If there are no errors, the first instance is created and the next service 
creation form opens with the next available key value for each first level 
component.

If an error occurs, a service creation error dialog box opens. Correct the 
error. See “Repairing Passport service creation errors overview” 
(page 194).

9 Repeat step 8 for all remaining service instances.

Key values for all remaining instances are automatically assigned 
according to the key values that you have specified.
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Canceling the current or remaining instances during a 
multiple creation of Passport components or services

Use this procedure to cancel the creation of a single instance or all remaining 
component instances during the process of creating multiple instances of a 
Passport component or service.

 You use the Cancel Creation dialog box to cancel the current or remaining 
instances. 

Prerequisites
This procedure requires the following conditions:

• you are not in read only mode

• you are creating multiple instances of a component or service as 
described in “Creating multiple instances of a Passport component or 
service” (page 183) and have completed the following steps:

—  entered a key pattern in the Component Key Assignment field

— selected Display form for each instance

— clicked OK in the Multiple Creations dialog box 

Procedure steps
1 In the component or service creation form, click Cancel.

The Cancel Creation dialog box opens.
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2 In the Cancel Creation dialog box, select one of the following options:

• If you wish to only cancel the current component or service creation 
instance, select Cancel the current instance only.

• If you wish to cancel the current and all remaining instances, select 
Cancel the current and the remaining instances.

3 Click OK.

If you have selected Cancel the current instance only option, the 
current component or service is not created and the next creation form 
opens.

If you have selected Cancel the current and all remaining instances 
option, no further instances of the component or service are created and 
the creation form closes.

If you click Cancel, the Cancel Creation dialog closes and you return to 
the current creation form.
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Checking the Passport view during a provisioning session
Use this procedure at any time during a provisioning session to perform a 
check for errors on the currently open view. Any errors or warnings 
encountered during the check view operation display in the Check View 
dialog box.

Prerequisites
This procedure requires the following conditions:

• you have started Nodal Provisioning

• you are connected to a Passport device

• you are in read-write mode

Procedure steps
1 On the File menu, click Check View.

A Check View dialog box opens indicating that the checking process may 
take a few minutes. You are prompted as to whether or not to proceed with 
checking the view.

2 Click Yes to proceed with checking the view. 
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Performing a full semantic check for Passport devices
Perform a full semantic check anytime during a provisioning session to verify 
that the provisioning details are valid for the current view or configuration. 
Any semantic errors or warnings encountered during the check operation 
display in a dialog box.

Prerequisites
This procedure requires the following condition:

• you are not in read only mode

Procedure steps
1 Select one of the following actions, depending on the device you want to 

provision. 

A confirmation box opens. 

2 On the confirmation box, click Yes.

A dialog box opens and displays any errors encountered during the check 
operation.

For... On the File menu...

Passport Click Check View.

MPE Click Check Configuration.
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Performing a partial semantic check
Perform a partial semantic check when you want to check for errors under a 
selected component. Any semantic errors or warnings encountered during the 
partial semantic check operation are displayed in a dialog box.

Prerequisites
This procedure requires the following condition:

• you are not in read only mode

Procedure steps
1 Select the component that you want to check for errors.

2 From the Selected menu of the Nodal Provisioning window, select 
Partial Semantic Check, or select Partial Semantic Check from the 
selected component’s popup menu.

A Check View message dialog box opens and displays any errors 
encountered while checking the selected component, or informs you that 
no errors were found.
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Repairing Passport service creation errors overview
 A Service Creation Errors dialog box opens if an attempt to create a service, 
using Nodal Provisioning or Embedded Nodal Provisioning, is only partially 
successful. Attribute errors may have occurred so that some, but not all, of the 
components in the service are created. 

If the error occurs during the service creation but before any components are 
created, or attributes modified, an error message opens, and clicking OK in 
the error dialog causes one of the following scenarios to occur. 

• If you are creating multiple instances of the service and you have opted 
to show the creation form for each instance, when you click OK the next 
creation form opens.

• If you are creating multiple instances of the service and you have opted 
to not show the creation form for each instance, when you click OK the 
creation form opens with a Continue button, and all remaining key values 
appear in a corresponding key field for each first level component.

You are given the following options in the Service Creation Errors dialog box 
after an error has occurred in the service creation:

• Accept allows the service to be created regardless of the error. Default 
values are used for those attributes. 

In the case of Embedded Nodal Provisioning, the task activation 
proceeds and the next provisioning action in the task is applied to the 
device.

If you are creating multiple instances of the service, and have opted to 
display the service creation form for each instance, the next remaining 
instance creation forms opens.

If you are creating multiple instances of the service, and have opted not 
to display the service creation form for each instance, the Nodal 
Provisioning tool creates the current instance as is, and creates all 
remaining instances automatically without showing each creation form. 
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• Repair brings up another dialog box which allows you to modify the 
input values to repair the error. When you click OK, the service is created 
using the modified values. 

If you are creating multiple instances of the service, and have opted to 
display the service creation form for each instance, the next remaining 
instance creation forms opens and the tool continues to process the next 
instance creation.

If you are creating multiple instances of the service, and have opted to not 
display the service creation form for each instance, the tool creates all 
remaining instances automatically after you finish repairing the instance 
that generated the error. 

• Delete All deletes the current instance and all the components created by 
the service. 

If you are creating multiple instances of the service, and have opted to 
display the service creation form for each instance, the current instance 
is not created and the next remaining instance creation form opens.

If you are creating multiple instances of the service, and have opted to not 
display the service creation form for each instance, the tool creates all 
remaining instances automatically.

• In Nodal Provisioning, Cancel cancels the current instance and brings up 
the service creation form with all remaining key values appearing on 
each first level component’s key field. You can modify the attribute or 
key values before you continue to create the remaining instances. The 
OK button in the service creation form is replaced with a Continue 
button. 

In Embedded Nodal Provisioning Cancel cancels the entire task 
activation. You are given the chance to cancel one or more of the pending 
activations using the Cancel Activations dialog and the procedure 
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“Canceling the application of multiple provisioning tasks” (page 466). 
You can edit the task as required and activate it once the problems are 
fixed.

If you are creating multiple instances of the service and have opted to 
display the service creation form for each instance, when you click 
Continue the next creation form with new values is displayed.

If you are creating multiple instances of the service and have opted to not 
display the service creation form for each instance, when you click 
Continue the remaining instances are automatically created with new 
values.

For an illustration of the service creation error dialog box, see “Service 
Creation Errors dialog box” (page 197).
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Figure 12
Service Creation Errors dialog box

The Components and errors encountered during the service creation 
panel displays the errors in component hierarchy format. It shows visually the 
following:

• where in the component hierarchy tree the error occurred

• the components that have been successfully created

• the components that have been impacted by the error. 

The icons that appear in the dialog box, and what they represent are described 
in the table “Icons and what they mean” (page 198).
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The Error Messages panel shows in text format the error messages that caused 
the service creation to fail. The error messages in this panel correspond to the 
error messages shown next to the affected component or attribute in the 
components and errors encountered during service creation panel.

You can tear the error messages panel or component panel away from the 
service creation error dialog box by right-clicking on the panel and pulling the 
panel away. Closing the Error Messages panel reattaches it.

Tool tip messages are available that describe component states, and provide 
additional information on components and attribute errors. For example, in 
the case of greyed out components, the tool tip indicates that the component 
is not part of the service. For attribute errors, the tool tip tells you the attribute 
value that the service creation tried to set.

For the procedure to resolve service creation error conditions, see 

• “Repairing Passport service creation errors” (page 199)

Table 14
Icons and what they mean

Icon What it represents

A greyed out component A greyed out component represents a 
component that is not part of the service creation 
operation.

Yellow triangle A yellow triangle represents a component that 
encountered an error while setting its attributes.

Red x next to an attribute 
or component

A red x next to an attribute represents an error in 
setting the attributes. The adjacent red text 
provides additional details about the attribute 
value that it tried to set.

A red x next to a component icon represents an 
error creating the component.
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Repairing Passport service creation errors
Use this procedure to correct Passport service creation errors in either Nodal 
Provisioning or Embedded Nodal Provisioning.

Prerequisites
This procedure requires the following conditions:

• An error condition exits in the service creation operation.

• A Service Creation Errors dialog box has opened to display the error 
condition(s).

Procedure steps
1 In the Service Creation Errors dialog box, select one of the following 

options;

• If you wish to delete all the components that were created, select 
Delete All. 

— If you are creating multiple instances of the service, and have opted 
to display the service creation form for each instance, the current 
instance is deleted and the next remaining instance creation form 
opens. 

— If you are creating multiple instances of the service, and have opted 
to not display the service creation form for each instance, the tool 
deletes all remaining instances automatically.

• If you wish to accept the components that were created, select 
Accept.

— If you are creating multiple instances of the service, and have opted 
to display the service creation form for each instance, the next 
remaining instance creation forms opens. If another error is 
encountered, another error message opens. Return to step 1

— If you are creating multiple instances of the service, and have opted 
not to display the service creation form for each instance, the tool 
creates all remaining instances automatically. If another error is 
encountered, another error message opens. Return to step 1.

• If you wish to modify the attributes of the components that were 
created, click Repair. A dynamic dialog box opens containing the 
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components and attributes that it could not create or modify. Only 
those that can be repaired are shown. Proceed to step 2.

• If you wish to cancel the operation, click Cancel.

— If you are creating multiple instances of the service and have opted 
to display the service creation form for each instance, Cancel 
cancels the current instance and brings up the service creation form 
with all remaining key values appearing on each first level 
component’s key field. The OK button in the service creation form 
is replaced with a Continue button. when you click Continue the 
next creation form with new values is displayed.

— If you are creating multiple instances of the service and have opted 
to not display the service creation form for each instance, when you 
click Continue the remaining instances are automatically created 
with new values.

2 In the repair dialog box, repair the component attributes.

3 Click OK to complete the creation using the modified values.

If errors remain, another Service Creation Error dialog box opens 
showing only those components or attributes that have not been repaired. 
Return to step 2 to resolve the remaining errors.

If there are no further errors, you are creating multiple instances of the 
service, and you have opted to display the service creation form for each 
instance, the next remaining instance creation forms opens and the tool 
continues to process the next instance creation.

If you are creating multiple instances of the service, and have opted to not 
display the service creation form for each instance, the tool creates all 
remaining instances automatically.
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Resolving a restorePossible error condition
Use this procedure when an warning message dialog box opens that indicates 
that a previous current view needs to be restored. This error condition can 
occur in Nodal Provisioning or Embedded Nodal Provisioning.

This warning dialog box is generated when the current view has been 
journalized by the provisioning system and is different from the committed 
view. The restore prov command can be issued if display prov restorePossible 
attribute of the is set to yes on the node. This attribute indicates if a restore 
provisioningSystem command is possible.

When opening the view, you are warned that the restorePossible attribute is 
set. However, you can still continue to open the view.

Upon activating, at check prov, a warning is generated that subsequent 
activation will remove the previous journal log files, and you need to use the 
-force option.

Procedure steps
1 In the warning dialog box, click Close View to close the current view. 

Proceed to step 2.
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Click Continue to proceed with this view. However, any subsequent 
activation will destroy the previous “current view”.

2 Confirm that the display prov restorePossible command is set to yes.

3 If set to yes, do 

• start prov

• PROV>restore prov

This command loads and reactivates the journal files.
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Resolving a journalDisabledReason error condition
Use this procedure to resolve a journal disabled condition. This error 
condition can occur in Nodal Provisioning or Embedded Nodal Provisioning.

When this condition exists, an alarm is generated (7000037) and a warning 
dialog box opens. The warning dialog box provides you one of the following 
reasons for the error condition:

• not configured

• initial commit required. Journaling has been enabled via provisioning 
and an initial commit is required.

• file system error. The journal log save failed due to File System error or 
because the File System is locked.

• threshold exceeded. A number of journal logs has exceeded the 
maximum.

• reload activation. A reload activation has occurred and a commit has not 
yet been done

When opening the view, or after activating, you are warned that the 
journalDisabledReason attribute is set. However, you can still continue to 
open the view.

Procedure steps
1 To close the current view, in the Open View Warning dialog box, click 

Close View. Go to step 2.
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Click Continue to proceed with this view. However, any subsequent 
activation will destroy the previous “current view”.

2 Query the attribute journalDisabledReason.

To determine if the File System is locked, do display fs adminState. If the 
value is locked, then the Filesystem is locked.

3 Take the following on-switch remedial action:

If the reason is for the journalDisabledReason error is “file system error” 
then ensure that the file system is not locked. If it is locked, unlock the file 
system. Otherwise, look for the file system or disk alarms to determine the 
root cause of the failure. Once the root cause is determined and fixed, re-
commit to clear this alarm.

For any other value of journalDisabledReason, re-commit the current 
provisioning view to clear the alarm.

If neither the disaster recovery nor CP equipment protection feature are 
wanted, then the operator can also clear this alarm by disabling journal 
log saving by setting the attribute Prov journaling to disabled.
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Showing MPE 9500 configuration conflicts
In shared configuration mode, multiple users can simultaneously modify an 
MPE 9500 configuration. Sometimes configuration conflicts can occur 
between the candidate configuration and the running configuration. For 
example, conflicts arise when more than one user changes the same 
component attributes or when more than one user adds the same component 
instance. Conflicts between the candidate and running configurations are 
automatically detected when you commit a configuration. This procedure lets 
you manually detect and resolve conflicts before you commit.

Procedure steps
1 On the File menu, click Show Conflicts.

The Configuration Conflict  dialog box opens and displays conflicts 
between the candidate and running configurations.

2 In the dialog box, complete one of the following actions:

• Click Resolve From Running to resolve conflicts by using values 
from the running configuration.

• Click Resolve From Candidate to resolve conflicts by using values 
from the candidate configuration.

• Click Resolve Later to close the dialog box and manually correct the 
conflicts.
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Committing an MPE 9500 configuration
Commit the MPE 9500 configuration when you have completed all the 
modifications and are ready to make the configuration the running 
configuration. The commit process performs a semantic check as well as a 
check for conflicts. If the configuration is free of errors, it is committed, 

The commit operation may temporarily change the state of the node to out-
of-service due to software migrations or firmware updates. In these 
circumstances, a confirmation dialog prompts for confirmation to continue. 
The commit operation may fail for the following reasons:

• there are semantic errors in the configuration

• in shared mode there is a conflict between the candidate and running 
configuration

• another user is currently in sole-commit mode

Procedure steps
1 On the File menu, click Commit Configuration.

The dialog box opens.

2 In the dialog box, specify the appropriate commit options.

3 Commit the configuration.

The configuration is committed unless you have set your user preferences 
to prompt for confirmation before committing. In this case, the Commit 
Confirmation dialog box opens and you need to continue with step 4.

4 In the Commit Confirmation dialog box, complete one of the following 
actions:

• Click OK within the specified time frame.

• Click Cancel to cancel the commit operation. A dialog box opens and 
lets you save the configuration before exiting.

If you don’t commit or cancel and the wait period for confirmation expires, 
the previous running configuration is restored.
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Setting User Preferences 
You can set user preferences to customize a selection of Nodal Provisioning 
settings as well as the look and feel of the Nodal Provisioning window. For 
example, you can override the default MDM default setting and specify a 
particular type of view mode to use whenever Nodal Provisioning starts. The 
preferences that you set are specific to your user ID only. User preferences 
take effect immediately after saving them and remain in effect until you reset 
them.

Each Nodal Provisioning instance maintains its own preferences. For 
example, if you open multiple instances of Nodal Provisioning within a 
session and make changes to the user-preferences in only one of these 
instances, then the user preferences in the remaining instances are not 
affected.

User preferences are stored in your home directory. To modify any existing 
preferences that you have set, you must do so by using the Nodal Provisioning 
tool, not by using a text editor.

Procedure steps
1 On the Options menu, click User Preferences, and then the appropriate 

tab.

2 Modify the user preference settings as required.

•  For details about Passport user preferences, see the table “Passport 
user preferences for Nodal Provisioning” (page 208).

• For details about MPE, see the table “MPE user preferences for 
Nodal Provisioning” (page 211).

3 Click OK.
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Table 15
Passport user preferences for Nodal Provisioning

Preference type Preference Use when you want to...

Open View:

Access Mode Read Only Start Nodal Provisioning with read access 
only.

Read and Write Start Nodal Provisioning with read and 
write access to the service data. This 
setting is the default access mode.

View Mode Committed Start Nodal Provisioning with the 
committed service data view. The 
committed view is used when the node 
restarts.

Current Start Nodal Provisioning with the current 
service data view. The current view is the 
configuration that is currently running on 
your node. This setting is the default view 
mode.

Edit Start Nodal Provisioning with the edit 
service data view. The edit view is the 
view that you are currently modifying. It 
can potentially become the next current 
view.

Other Start Nodal Provisioning with a specific 
view. You can select the Keyed, Dated, or 
User Specified options. The default is 
Keyed.

Other Options Preload View Automatically load the service data view 
when Nodal Provisioning starts. This 
option is useful when you need to access 
a large number of components. To lessen 
network traffic and the impact on the 
device, preload the view from the backup 
directory rather than the node. The 
Preload View option is the default setting.

 (Sheet 1 of 4)
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Propagation Logging To Create a log file of the changes made 
during a provisioning session. The log file 
starts recording when you successfully 
open a view and continues until the view 
is closed. The name of the propagation 
log file is the user name concatenated 
with the string “_ApiLog”, for example, 
smith_ApiLog. The log file is saved in the 
/opt/MagellanNMS/data/ANP directory. 
Each time a log file is created, a time 
stamp is appended to the file name so 
that each file has a unique name. You 
can view the log file name from the Nodal 
Provisioning window by right clicking the 
view name in the status bar and selecting 
the Log File Name command.

Always Prompt to Open View Open a dialog box containing user 
preference values whenever you select a 
new device. This setting is the default 
option.

Save/Activate 
View:

Check View Check View Check the provisioning view. You can 
check only the changes made to the view 
or the complete view, depending on the 
option you select in the Type list. 
Checking the complete view is the default 
setting.

Table 15 (Continued)
Passport user preferences for Nodal Provisioning

Preference type Preference Use when you want to...
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Save View Save Save the view. You can save the view in 
ascii, delta, portable, or both portable and 
ascii formats. Name the new service by 
selecting the Keyed, Dated, or User 
specified options. Saving the view in 
portable format with a keyed name is the 
default setting.

• Keyed - A key must start with a 
number or letter but can contain 
numbers, letters, or underscores for 
subsequent characters. The key 
cannot exceed 6 characters. If the 
keys contains only numbers, then its 
length must be at least three 
characters. The service data view that 
matches the pattern and has the 
highest index is used, and the next 
view in the sequence is created

• Dated - Type “today” or a date in the 
format yymmdd (where yy is the year, 
mm is the month, and dd is the day). 
When a provisioning view is saved 
with a dated key, Nodal Provisioning 
adds a two-digit index to the date to 
keep track of the number of saved 
views on the same date, for example 
<yymmdd><nn>. When you enter a 
date, the service data view with the 
highest index is used and the next 
view in the sequence is created. 
Invalid date keys will cause a warning 
dialog box to open

• User specified - Type a view name.

Activate View Activate Apply the provisioning tasks to the view 
being modified.

Table 15 (Continued)
Passport user preferences for Nodal Provisioning

Preference type Preference Use when you want to...
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Commit View Commit Make the view the one that opens after 
the node restarts.

Other Option Always Prompt to Save View Open a confirmation box before a view is 
saved. 

General:

Max Instances Modify the maximum number of 
component instances to display in the 
component tree. The default value is 50. 
This preference does not apply to Card 
and LP components which display all 
instances. 

View Presentation Tree Start Nodal Provisioning with the node’s 
components in a hierarchical list. The 
component tree is the default view 
presentation.

Shelf Start Nodal Provisioning with the node’s 
logical shelf view displayed. 

Communications 
Timeout

Modify the maximum time to wait for a 
response. The default response time is 
45 seconds.

Table 16
MPE user preferences for Nodal Provisioning

Preference type Preference Use when you want to...

Open:

Access Mode Shared Start a multiple user Nodal Provisioning 
session.

Sole-commit Start Nodal Provisioning and lock the 
configuration until you commit or exit the 
provisioning session.
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Table 15 (Continued)
Passport user preferences for Nodal Provisioning

Preference type Preference Use when you want to...
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Read only Start Nodal Provisioning with read access 
only. 

Configuration Running Start Nodal Provisioning with the running 
configuration. The running configuration 
reflects the system view of configuration 
data currently in effect on the MPE.

Previous Running Start Nodal Provisioning with the rollback 
configuration. 

Other Start Nodal Provisioning with a specific 
configuration file. You can select the 
Keyed, Dated, or User Specified options. 
The default is Keyed.

Always Prompt Before Open 
Configuration

Specify whether or not to open a dialog 
box that lets you select the candidate 
configuration and access mode 
whenever you select a new device. This 
setting is the default option.

Save:

Save 
Configuration

User Specified Save the configuration to a specific file. 
You can specify the filename using the 
Keyed, Dated, or User Specified options. 

Always Prompt Before Save 
Configuration

Specify whether or not to open a 
confirmation box whenever you save a 
configuration.

Commit:

Commit 
Configuration

Commit confirmation required Specify whether or not you want to 
display a dialog box that prompts before 
making the configuration permanent by 
committing it. The dialog box also lets you 
specify the maximum time to wait for 
confirmation before rolling back to the 
previous configuration.

Table 16 (Continued)
MPE user preferences for Nodal Provisioning

Preference type Preference Use when you want to...
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Wait period for confirmation 
(min.)

Modify the time to wait for a confirmation. 
The default time is five minutes.

Always Prompt before Commit 
Configuration

Specify whether or not to open the 
Commit Confirmation dialog box 
whenever you commit a configuration.

General:

Notify me of 
commits by other 
users

Receive notification of commits made by 
other users.

Maximum number
of 
subcomponents

Modify the number of subcomponents 
that display in the Nodal Provisioning 
window. 

Communications 
Timeout

Modify the maximum time to wait for a 
reply from the server before notification of 
no response. The default response time 
is 45 seconds.

Table 16 (Continued)
MPE user preferences for Nodal Provisioning

Preference type Preference Use when you want to...
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Customizing the Nodal Provisioning start up
Preside Multiservice Data Manager (MDM) provides a set of default files that 
determine how its tools start. If required, you can customize the way Nodal 
Provisioning starts, for example, you may want to start Nodal Provisioning 
with a specific network element or a specific access mode. To customize the 
start up, you need to copy the original configuration file provided by MDM 
and then make any required changes to the copy. 

Navigation
• “Procedure steps” (page 214)

• “Variable definitions” (page 216)

Procedure steps
1 Copy the default application launch configuration files to the appropriate 

directory.

2 Using a UNIX editor, open the copy of the MDMALaunch.cfg file.

If running... Copy the file from... Save the file to...

Toolset /opt/MagellanNMS/lib/cfg/mft/
MTlaunchscripts/
C10NodalProvisioningLM.cfg

/opt/nortel/config/applications/
desktop/MDM/launchscripts/cfg/
MTlaunchscripts/
C10NodalProvisioningLM.cfg

Operator Client /opt/MagellanNMS/lib/cfg/mft/
OClaunchscripts/
C10NodalProvisioningLM.cfg

/opt/nortel/config/applications/
desktop/MDM/launchscripts/cfg/
OClaunchscripts/
C10NodalProvisioningLM.cfg
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3 Within the file, locate the Nodal Provisioning command block. See the 
following sample Nodal Provisioning command block.

4 Modify the file by adding an “Args=” statement to the line that begins with 
“Command =”. See the following sample of a customized Nodal 

{

Menutype = MenuBar

Menu/Submenu = Configuration

CommandLabel = Nodal Provisioning

CommandType = Plugin

Command = Class=“com.nortel.cpt.gui.CoreProvisioningTool”, 
Client=“yes”, Single=“no”

SandboxName = NodalProvisioningSandbox_<sandbox_id>

SandboxJars = MDM/pluginJars/ANPClient.jar
MDM/pluginJars/ANPMpeClient.jar 
MDM/pluginJars/ANPShared.jar
MDM/pluginJars/ANPTemplateIcons.jar 
MDM/pluginJars/MdmLib-MftApp.jar 
MDM/pluginJars/parser.jar
MDM/pluginJars/jaxp.jar 
MDM/pluginJars/sharedJVMApp.jar

}

Nodal 
Provisioning 
command 
block
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Provisioning command block. The modifications are shown in bold font. 
For a list of arguments, see the variable definitions table. 

5 Save the file.

Variable definitions

Variable Value

-emcomp<node name> | 
<component name>

specifies the node name or the full component identifier of the 
device to which you want to connect.

-loadview <view mode> 
<view name>

specifies the service data view mode. Possible values for the view 
mode are commit, edit, current, key, date, or user. If you specify 
key, date, or user, then you also need to specify the view name. 

 (Sheet 1 of 2)

{

Menutype = MenuBar

Menu/Submenu = Configuration

CommandLabel = Nodal Provisioning

CommandType = Plugin

Command = Class=“com.nortel.cpt.gui.CoreProvisioningTool”, 
Client=“yes”, Single=“no”, Args=“-loadview edit -access rw”

SandboxName = NodalProvisioningSandbox_<sandbox_id>

SandboxJars = MDM/pluginJars/ANPClient.jar
MDM/pluginJars/ANPMpeClient.jar 
MDM/pluginJars/ANPShared.jar
MDM/pluginJars/ANPTemplateIcons.jar 
MDM/pluginJars/MdmLib-MftApp.jar 
MDM/pluginJars/parser.jar
MDM/pluginJars/jaxp.jar 
MDM/pluginJars/sharedJVMApp.jar

}

Add the required 
arguments to the 
“Command=” 
line
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-access <ro|rw> specifies the access mode for the service data view. Select an 
access mode of read-only (ro) or read-write (rw). 

-action <edit | select> specifies how Nodal Provisioning opens. The edit option opens 
Nodal Provisioning with a component form displayed. The select 
option opens Nodal Provisioning with the specified component 
selected in a tree view.

Variable Value

 (Sheet 2 of 2)
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Chapter 8
Post-provisioning procedures

This section describes post-provisioning procedures. It contains the following 
sections:

• “Saving the view for Passport devices” (page 220)

• “Activating and Committing the View for Passport devices” (page 223)

• “Saving an MPE configuration” (page 226)
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Saving the view for Passport devices
Use this procedure to save the service data view after completing a 
provisioning session on a Passport device. The Save/Activate View dialog 
box lets you specify how you want to save the service data view after you 
complete the provisioning session, and to activate and commit the view. For 
the procedure to activate and commit the view, see “Activating and 
Committing the View for Passport devices” (page 223).

You can set default user preferences for the Save/Activate View. For details, 
see “Setting User Preferences” (page 207).

Procedure steps
1 On the Nodal Provisioning File menu, click Save/Activate View.

The Save/Activate View dialog box opens with the default settings, 
unless you have changed them by setting the user preferences for the 
Save/Activate View dialog box. 

2 To check the view, select the Check View check box.

The adjacent Type box becomes available.
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Note:  When journaling is enabled, you can activate the device without 
saving the view. However, a complete check is required for activating the 
provisioning view.

To bypass the check operation, clear the Check View check box. The 
adjacent Type box becomes unavailable.

3 Select one of the following options from the Type drop down list:

• changed performs a check of only the added or changed 
components before saving. When you select changed, the following 
command is sent to the device:
String = check -changed -stoponerror prov

• complete checks the provisioning data in the edit view to ensure it is 
semantically correct. The complete check is the default setting. The 
following command is sent to the device:
String = check -stoponerror prov

Since the stopOnError is specified implicitly, the device will abort the 
check immediately upon finding the first error.

4 In the Save View panel, select Save and then select one of the following 
format options for saving the view from the Type drop down list:

• ascii saves the view in ASCII format.

• delta saves the view in delta format

• portable saves the view in portable format.

• portable and ascii saves the view in both portable and ASCII 
formats

5 From the view mode drop down list, select one of the following view mode 
options to name the new provisioning view:

• If you select Keyed, type a valid key in the Key field. The key is used 
to search for service data views. The service data view that matches 
the pattern and that has the highest index is found, and the next view 
in the sequence is created. You can name a file by using one to six 
alphanumeric characters or by using a 1 digit fully numeric download 
key. A fully numeric download key cannot be less than three digits.

• If you select Dated, type “today” or a date in the format yymmdd 
where yy is the year, mm is the month and dd is the day. When a 
provisioning view is saved with a dated key, Nodal Provisioning adds 
a two-digit index to the date to keep track of the number of saved 
views on the same date, for example <yymmdd><nn>. When you 
enter a date, the service data view with the highest index is found and 
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the next view in the sequence is created. Invalid date keys will cause 
a warning dialog box to open.

• If you select User Specified view mode, in the File field, enter a file 
name or click Browse to open a Select View file browser dialog box 
containing a list of user specified views. Select a view name and click 
OK.

• If you select Same as Opened View Name, the view is saved with 
the same name as the opened view but with the numeric extension 
increased by one. For example, you use the key NMS when opening 
a nodal provisioning session and the view NMS01.full.001 displays in 
the Nodal Provisioning window. When you save and activate this view 
using the Same as Opened View Name option, the view is saved as 
NMS01.full.002.

Note:  Commit, Current, and Edit not available in the Save/Activate 
View dialog box.

6 Click OK to save the modified view, or if you wish to activate a view and 
commit a view, proceed to “Activating and Committing the View for 
Passport devices” (page 223).
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Activating and Committing the View for Passport devices
Use the Activate View and Commit View panels of the Save/Activate View 
dialog box to activate and commit the view. 

Note: In a hitless software upgrade, the noPause option is automatically 
added during the activation process. The message that is sent to the 
Passport prevents the automatic pause that typically occurs before a 
migration switchover during a software migration.

Nodal Provisioning lets you to activate the device without saving the view 
when journaling is enabled on the device. However, a complete check is 
required to activate the provisioning view. 
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Procedure steps
1 In the Save/Activate View dialog box, select Activate to activate the 

view.

2 If you want to commit the view, select Commit. The default is unchecked.

To prevent accidental selection, a confirmation dialog box opens asking 
you to confirm the commit selection.

3 Click OK. 

The confirmation dialog closes and you return to the Save/Activate View 
dialog box.

4 To save the modified view, click OK. The Save/Activate View dialog box 
closes.

Select Commit to 
commit the 
configuration.

Select Activate to 
activate the 
configuration.
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The OK button remains disabled if your selections in this dialog box are 
invalid or incomplete.

To cancel the operation, click Cancel. The Save/Activate View dialog box 
closes without applying your provisioning changes.

If you have selected commit, a dialog box opens, asking you to confirm 
the commit. Click Yes.

You may encounter the following error conditions, and corresponding 
error dialogs, upon activation:

• A journalDisabledReason error. For the procedure to resolve a 
journal error conditions, see “Resolving a journalDisabledReason 
error condition” (page 203).

• restorePossible. For the procedure to resolve a restorePossible 
condition, see “Resolving a restorePossible error condition” 
(page 201).
Preside MDM Nodal Provisioning User Guide   15.1RSUP



226   Chapter 8 Post-provisioning procedures
Saving an MPE configuration
Save a modified MPE configuration when you want to store the configuration 
in a file. MPE saves all changes that are visible in the candidate configuration 
including changes committed by others.

Procedure steps
1 On the File menu, click Save Configuration. 

The dialog box opens.

2 In the dialog box, specify the appropriate options. 

3 Specify a file name using one of the following actions:

• select Keyed and specify a value 

• select Dated and specify a value 

• select User Specified and type the full file name or click Browse to 
navigate to a specific file.

4 Click OK. 

The configuration is saved unless you have set your user preferences to 
prompt before saving. In this case, the Save dialog box opens and you 
need to continue with step 5.

5 the Save dialog box 
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Chapter 9
Nodal Provisioning Template Editor

You use the Nodal Provisioning Template Editor to create and modify Nodal 
Provisioning service templates.

Nodal Provisioning Template Editor supports Passport and Nortel Networks 
Multiservice Provider Edge (MPE) network elements. Nodal Provisioning 
Template Editor is available through both the MDM Toolset and Operator 
Client environments. For details about these MDM environments, see 
241-6001-801 Preside MDM Overview.

Navigation
• “Tool fundamentals” (page 227)

• “Nodal Provisioning Template Editor window” (page 229)

• “Procedures” (page 247)

Tool fundamentals
The template editor lets you do the following tasks:

• create service templates that have multiple top level or root components, 
such as two AtmIfs under the EM device type

• create multiple same type components, such as multiple Channels on a 
single port

• specify a valid node software version range or ranges in the template so 
that only the templates applicable to the software version of the 
connected device display in the Nodal Provisioning window. 
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• display a dynamically created view-only service creation form that can 
always be visible while creating the template, and which shows how the 
template will appear in the Nodal Provisioning. When the preview is 
displayed, any changes that you make to the template are immediately 
shown in the preview form.

• ensure template security by setting file permissions through the UNIX 
file system. If a file is set as read-only, the Template Editor will not 
overwrite it.

• provide support for data sharing, allowing the value of one field to be 
used as the value for a dependent field.

• update the template listing directly from Nodal Provisioning 

When you save a service template, the files are stored in the following 
location:

/opt/MagellanNMS/cfg/ANP/<deviceType>/Service/
<category folder>/<templatefile name>.st

Nodal Provisioning Template Editor supports the following device types:

• EM - Passport

• SRS - MPE

Where information is specific to a device type in this document, the device 
type is specified. The Nodal Provisioning Template Editor operates the same 
for the device types. The differences are the model and the directory where 
the device type is stored.

Nortel Networks provides service templates with Preside Multiservice Data 
Manager. These templates are read-only so they cannot be modified. The 
directory has read/write privileges so users can save these templates with a 
new name.

Nodal Provisioning also provides a version checking tool. This is an off-line 
tool that identifies inconsistencies between the following items, when the 
node software version is upgraded:

• service templates and component models

• service models and the hierarchy model
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For information on using the version checking tool, see the following 
sections:

• “Starting the version checking tool” (page 316)

• “Sample outputs” (page 316)

Service selection
The Nodal Provisioning Template Editor tool uses service selection to 
determine which configuration management (CONFIGMAN) server it 
communicates with. For details, see “Service selection” (page 28).

Nodal Provisioning Template Editor window
You can create new service templates, or modify existing service templates, 
using the Nodal Provisioning Template Editor window. When you start the 
template editor for the first time, the fields in the window are empty, and by 
default the status bar shows the latest model version and the Valid Model 
versions as All. 

When you load a service template file, the template editor populates the fields 
in the Nodal Provisioning Template Editor window with the information 
contained in the selected service template (.st) file.

The status bar shows the selected model version and the valid model version 
range or ranges.

For an illustration of the template editor window after you have loaded a 
service template file, see “Nodal Provisioning Template Editor after loading 
a service template file” (page 230).
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Figure 13
Nodal Provisioning Template Editor after loading a service template file
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The Nodal Provisioning Template Editor window contains the following 
items:

• “Nodal Provisioning Template Editor menu bar” (page 231)

• “Template Identification panel” (page 236)

• “Template Details panel” (page 237)

• “Status bar” (page 246)

Nodal Provisioning Template Editor menu bar
The template editor menu bar gives you access to the high-level functions for 
the template editor. The following menus are found in the menu bar:

• “File menu” (page 231)

• “Selected menu” (page 233)

• “View menu” (page 235)

• “Help Menu” (page 236)

File menu
See the table “File menu commands” (page 232) for a description of the menu 
commands.
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Table 17
File menu commands

Command Description Additional Information

New Clears the template editor window so 
you can create a new service template. 

“Selecting a model version 
overview” (page 258)

Open Opens a Open file browser to select a 
service template (.st) file. By default, the 
dialog box opens to the Service 
directory.When you select a file, the 
template editor window is populated 
with the information contained in the 
selected service template file. If this is 
the first template that you have opened 
after launching the template editor, and 
it does not have a model version 
specified within it, you must select a 
model version before the main window 
populates.

“Opening a saved service template 
file” (page 256)

“Selecting a model version 
overview” (page 258)

Save Generates the eXtensible Markup 
Language (XML) file for a service 
template file. If you have not previously 
saved the file, a Save dialog box opens 
so you can select a location and specify 
a file name to save to.

“Saving a service template file after 
you have modified it” (page 312)

Save As Opens a Save dialog box so you can 
select a location and specify a file name 
to save to, and then generates the XML 
file for the service template file. 

“Saving a service template file for 
the first time” (page 309)

Change Model 
Version

Opens the Choose Model Version 
dialog box so you can select a model 
version on which to base the service 
template.

“Selecting a model version 
overview” (page 258)
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Selected menu
The content of the Selected menu depends on whether you have selected the 
Component layout tab or the Form Layout tab. In addition, the menu enables 
options that are valid for the current selected node. The Selected menu 
options are also available from the pop-up menu for the selected item.

See the following tables:

• “Selected menu commands for the Component Layout tab” (page 233). 
These commands let you build the structure of the service template.

• “Selected menu commands for the Form Layout tab” (page 235). These 
commands determine the layout of the service template.

Set Valid Model 
Versions

Opens the Set Valid Model Versions 
dialog box so you can specify the model 
versions applicable to the connected 
device.

“Specifying a model software 
version range” (page 262)

Exit Closes the template editor. If you have 
not yet saved your file, you are 
prompted to save.

“Exiting Nodal Provisioning 
Template Editor” (page 313)

Table 18
Selected menu commands for the Component Layout tab

Command Description Additional Information

Add Component Opens a dialog box containing a list of 
components that you can add to the 
device.

“Adding a component” (page 274)

Add Dropsite Opens a dialog box that allows you to 
add a parent or link dropsite for a 
component.

“Adding or removing a dropsite” 
(page 282)
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File menu commands
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Add Sub-
component

Opens a list that displays the possible 
components that you can add to a 
selected subcomponent that can have 
sub-components. This command is 
disabled if you have not yet created 
components.

“Adding sub-components to a 
dropsite or component node” 
(page 277)

Add Link Opens the Add Linked Component 
dialog box which lets you add a linked 
component. This command is enabled 
only if the currently selected component 
can have links.

“Adding a link” (page 278)

Remove Removes a selected component, and its 
links and subcomponents. In the form 
layout, if the group and tab have been 
generated automatically, and they are 
empty, they are removed. If there are 
multiple groups, only the empty groups 
are removed.

“Removing components from the 
Component Layout” (page 281)

Remove Link Removes a link from the currently 
selected component. This command 
does not remove the component that it is 
linked to.

“Removing links” (page 294)

Change 
Component 
Designation

Opens a dialog box that allows you to 
change the way the parent of the 
component is created or located.

“Changing the component 
designation” (page 292)

Move 
Component

Opens a dialog box that allows you to 
select a new parent for a component 
from a list of compatible parents.

“Moving a sub-component to 
another parent” (page 280)

Table 18  (Continued)
Selected menu commands for the Component Layout tab

Command Description Additional Information
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View menu
See the table “View menu command” (page 236) for a description of the 
Preview command. 

Table 19
Selected menu commands for the Form Layout tab

Command Description Additional information

Add Tab Adds a tab to the layout tree in the 
Template Details panel. 

“Renaming tabs or groups” 
(page 298)

“Adding tabs to the form layout tree” 
(page 299)

Add Group Adds a group to a selected tab on the 
display layout tree in the template 
details panel. The Add Group command 
is enabled only when a tab is selected.

“Adding Groups to the form layout 
tree” (page 301)

Add to Template Adds a selected component attribute to 
the template. 

“Adding a component attribute” 
(page 275)

Remove Deletes the selected item from the 
display layout tree. 

“Deleting tabs from the form layout 
tree” (page 300)

“Deleting Groups from the form 
layout tree” (page 302)

Show Turns on the display of a selected 
hidden item in the form preview. The 
item also displays when the template is 
used in Nodal Provisioning. 

“Showing components in the form 
layout tree” (page 304)

Hide Turns off the display of a selected item 
in the form preview. The item remains 
hidden when the template is used in 
Nodal Provisioning. The hidden 
component is greyed out in the Form 
Layout tree.

The Hide command is enabled only for 
components whose key does not need 
to be filled in at run-time.

“Hiding a component in the form 
layout tree” (page 303)
Preside MDM Nodal Provisioning User Guide   15.1RSUP



236   Chapter 9 Nodal Provisioning Template Editor
Help Menu
The table “Help menu commands” (page 236) describes the Help menu 
commands.

Template Identification panel
The Template Identification panel provides text fields to enter general 
identifying information for the service template. 

The Template Identification panel contains the following fields:

• The Title field identifies the service template. The name that you type in 
this field appears in the service template palette in the Nodal 
Provisioning window.You can select the content of this field and edit it. 
You cannot save a template with no title.

Table 20
View menu command

Command Description Additional Information

Link Display A check box that allows you to turn on 
and off the display of the links between 
components in the Component Layout.

Preview Opens a preview of the service template 
form so that you can see how the 
service template looks in real time, that 
is, as you are creating it in the Nodal 
Provisioning Template Editor window. 
The preview form cannot be edited. 

Table 21
Help menu commands

Command Description Additional Information

Help on Window Opens the online documentation 
describing the Nodal Provisioning 
Template Editor window.

“Help options” (page 35)
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Note: It is recommended that you create a unique title for each template 
within the same category. The title and the template icon are the only 
items that distinguishes between templates in the Nodal Provisioning 
tool.

• The Author field lets you enter the author of the template.You can select 
the content of this field and edit it. 

You cannot save a template with “Nortel Networks” as the author, nor 
can you save a template with no author. If the template is created by 
Nortel Networks, the Author field displays “Nortel Networks”. If you 
edit the template, you need to save it under a new name since you cannot 
overwrite a Nortel Networks template. 

• You can enter a textual explanation or details about the service template 
in the Description field. Completing this field is optional. You can edit 
the contents of this field. 

• The Icon field lets you choose an icon image that represents the service 
template. This icon appears in the service template palette in the Nodal 
Provisioning window. You can also click Browse... to select an icon from 
the icon browser dialog box. 

For related procedures, see the following sections:

• “Specifying template identification attributes for a new template” 
(page 271)

• “Modifying template identification attributes of an existing service 
template (.st) file” (page 272)

Template Details panel
The Template Details panel contains the following tabs with their 
corresponding details:

• “Component Layout tab” (page 238)

• “Form Layout tab” (page 240)
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Component Layout tab
The Component Layout tab displays the component layout tree and the 
Component Details panel.

• Component layout tree shows the following

— the components that are created on the device by the template when 
it is applied

— the dropsite where this template can be dropped

— the relationship between the components in the component layout 
tree.

• Component Details panel contains the details about the component that 
you have selected in the component layout tree. You use this panel to 
change the instance value for each component and select the component 
attributes that you want to include in the service template

When you open the Nodal Provisioning Template Editor window, the 
Component Details panel is blank. 

The content of the Details panel varies with the type of dropsite that you 
select in the component layout tree:

• parent 

• link

• component

The Parent Dropsite, Link Dropsite, and Component Dropsite Details panel 
have the following command buttons:

• Add moves a selected component from the Available list to the Included 
in Template or Chosen list.

• Add All moves all the selected components from the Available list to the 
Included in Template or Chosen list.

• Remove moves the selected component or components from the 
Included in Template or Chosen list to the Available list.

• Remove All moves all the components from the Included in Template or 
Chosen list to the Available list
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See the following tables for additional information the details panel for each 
of the dropsite types:

• for a parent dropsite, see “Details panel for a parent dropsite” (page 239)

• for a link dropsite, see “Details panel for a link dropsite” (page 239)

• for a component dropsite, see “Details panel for a component dropsite” 
(page 240)

Table 22
Details panel for a parent dropsite

Title of Details 
panel

Details panel content Description

Dropsite Details Child component(s) field The name of the component created under the 
dropsite component

Available Dropsites list A list of available components that can be parents

Chosen Dropsites list A list of components that have been added from the 
Available Dropsites combo box. These are the 
components that the template can be dropped on 
when using the Nodal Provisioning tool.

Table 23
Details panel for a link dropsite

Title of Details 
panel

Details panel content Description

Dropsite Details Linked Component(s) 
field

The name of the component(s) that are linked to the 
dropsite component

Available Dropsites list A list of available components that can be linked to 
the selected link component.

Chosen Dropsites list A list of components that have been added from the 
Available Dropsites combo box. These are the 
components that the template can be dropped on 
when using the Nodal Provisioning tool.
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Form Layout tab
The Form Layout tab lets you select the layout of the service creation form. 
The contents of the Form Layout tab correspond directly to the appearance of 
the service creation form.

The Form Layout tab displays the following items:

• the tab and group layout of the service template. Each top level 
component has its own tab and group. Each subcomponent has its own 
group under the parent tab.

— A tab is a collection of groups that you define. The collection is 
shown on the service template as a tab. You can specify the name of 
the tab.

— A group is a collection of components that you define. The 
collection is shown on the service template as a bordered panel. You 
can specify a name for the panel.

• the details about an item that you have selected in the form layout tree. 
The form Details panel lets you change the instance value for each 
component and select the component attributes that you want to include 
in the service template

When you open the Template Editor main window the Template Details 
panel is blank. 

Table 24
Details panel for a component dropsite

Title of the 
Details panel

Details panel content Description

Component 
Details

Component A drop down list of components in the component 
layout tree. The selected component appears by 
default. The details are for the component selected 
from the list.

Available Attributes list A list of available attributes for the selected 
component

Included in Template list A list of attributes that are in this template
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See the following tables for additional information the details panel when you 
select the following item in the Form Layout tree:

• “Details panel for a tab” (page 241)

• “Details panel for a Group” (page 242)

• “Details panel for a Component” (page 243)

• “Details panel for an Attribute” (page 245)

Table 25
Details panel for a tab

Title of Details 
panel

Details panel content Description

Tab Details Tab Name An editable field in which you can enter a name for 
the Tab.

Location

• Position

A combo box containing a list of valid positions for 
the tab. The current position of the tab in the form 
layout tree is shown. You can change the position of 
the tab by selecting another position from the combo 
box.
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Table 26
Details panel for a Group

Title of Details 
panel

Details panel content Description

Group Details Group Name An editable field in which you can enter a name for 
the Group.

Location

• Tab

• Position

The Tab combo box provides a list of valid tabs to 
which you can move the Group. The current Tab 
position for the Group in the form layout tree is 
shown. 

The Position combo box lets you move a Group’s 
position in the Tab by selecting a position number 
from the combo box.
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Table 27
Details panel for a Component

Title of details 
panel

Details panel content Description

Component 
Details

Name You can select from a drop down list of components 
in the component layout tree. The selected 
component appears by default. The details are for 
the component selected from the list.

Instance Value A drop down list of available naming schemes for the 
selected component. 

• none - is displayed for components that do not 
need an instance value. You cannot edit this 
instance value. By default, the Show check box is 
deselected. You can select it to display the value 
to the user.

• predefined - is displayed as the instance value for 
components that have a predefined instance 
value. The value is displayed in the 
accompanying value field. You cannot edit this 
instance value. By default, the Show check box is 
deselected. You can select it to display the value 
to the user.

• auto named - the Nodal Provisioning tool 
suggests an instance value data for the 
component. The user of this template can change 
the suggestion when using this template. 
Autonaming is only supported for numerical 
instance value data.

• user entered - you must provide the instance 
value data. If only one instance of the component 
can exist, then this is the instance used.

• user selected - you must select from a list of 
existing instances of this component.

• gets value from - you must select from a list of 
items with the same data type component or 
attribute
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Show check box A check box that allows you to show or hide the key 
value from the user of this template

Attributes Included in 
template list

A list of available attributes included in the template

Displayed in Form list A list of attributes displayed in the service creation 
form

Command buttons:

• Add

• Add All

• Remove

• Remove All

Add moves a selected attribute from the Included in 
Template lists and adds it to the Displayed in Form 
list.

Add All moves all the attributes from Included in 
Template list to Displayed in Form list.

Remove moves the selected attribute from the 
Displayed in Form list to the Included in Template 
list.

Remove All moves all the attributes from the 
Displayed in Form list to the Included in Template 
list.

Location:

• Tab

• Group

• Position

The Tab combo box lets you select a new tab 
location for the component from a drop down list. The 
current position shows by default.

The Group combo box lets you select a new group 
location for the component from the drop down list. 
The current position shows by default.

The Position combo box lets you change the position 
of the component in the group.

Table 27  (Continued)
Details panel for a Component

Title of details 
panel

Details panel content Description

 (Sheet 2 of 2)
241-6001-610   15.1RSUP   



Chapter 9 Nodal Provisioning Template Editor   245
Table 28
Details panel for an Attribute

Title of details 
panel

Details panel content Description

Details for Attribute combo box A list of available attributes.The name of the attribute 
selected in the form layout tree appears by default.

Label An editable field that shows the label that appears on 
the service creation form for this attribute.

Value: The value is set to default unless otherwise 
specified. The options are:

• override - overrides the default value

• default - the value that is provided by the Nodal 
Provisioning tool

• gets value from - gets any item with the same data 
type

• user selected - lets the user of this template select 
a value from a list of instances

Initial Value A field where you can set the original value of two 
attributes that share the same value. This is only 
enabled when the value type is “gets value from”.

Display in Form check 
box

If Display in Form is checked, the new label is 
displayed in the service creation form.

Deselecting Display in Form prevents an attribute 
from appearing in the service creation form.
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Status bar
The status bar at the bottom of the Nodal Provisioning Template Editor 
window shows the following items:

• Model Version shows the selected model version. 

• Valid Model versions shows the valid model version range or ranges. 
When you open the Nodal Provisioning Template Editor for the first 
time, the Valid Model Versions is All.

Mandatory check box The Mandatory check box is enabled when Display 
in Form is checked. If selected, this attribute is 
mandatory and must be filled in by the user before a 
service creation will be valid.

Editable check box The Editable check box is enabled when Display in 
Form is checked. If selected, this attribute’s values 
can be edited.

Table 28 (Continued)
Details panel for an Attribute

Title of details 
panel

Details panel content Description
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Procedures
Note: The procedures in this section apply to the MDM Toolset and 
Operator Client environments, unless otherwise specified.

This section contains the following Nodal Provisioning Template Editor 
procedures:

• “Maximizing and minimizing panels in the Nodal Provisioning Template 
Editor window” (page 249)

• “Creating or modifying service templates task flow” (page 250)

• “Starting the Nodal Provisioning Template Editor” (page 251)

• “Opening a saved service template file” (page 256)

• “Clearing the template editor window to create a new service template 
file” (page 257)

• “Selecting a model version overview” (page 258)

• “Specifying a model software version range” (page 262)

• “Specifying template identification attributes” (page 270)

• “Component layout procedures” (page 273)

• “Adding a component” (page 274)

• “Changing the component parent designation” (page 276)

• “Adding sub-components to a dropsite or component node” (page 277)

• “Adding a link” (page 278)

• “Moving a sub-component to another parent” (page 280)

• “Removing components from the Component Layout” (page 281)

• “Adding or removing a dropsite” (page 282)

• “Adding a parent dropsite” (page 284)

• “Resolving a previous parent dropsite” (page 285)

• “Adding a link dropsite” (page 286)

• “Resolving a previous link dropsite” (page 288)
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• “Adding or removing a dropsite drop target” (page 289)

• “Selecting the component parent designation” (page 290)

• “Changing the component designation” (page 292)

• “Removing links” (page 294)

• “Adding or removing attributes” (page 295)

• “Form Layout procedures overview” (page 296)

• “Saving service template files” (page 308)

• “Exiting Nodal Provisioning Template Editor” (page 313)

• “Updating the service template palette in Nodal Provisioning” 
(page 314)

• “Version checking tool overview” (page 315)

• “Starting the version checking tool” (page 316)

• “Customizing how the Nodal Provisioning Template Editor starts” 
(page 318)
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Maximizing and minimizing panels in the Nodal 
Provisioning Template Editor window

Use this procedure to maximize or minimize the Template Identification, 
Template Details, and Details For panels in the Nodal Provisioning Template 
Editor window:

Procedure steps
1 Click on the arrow found to the left of the panel title (Template 

Identification, Template Details, or Details for).

The panel expands, or minimizes.
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Creating or modifying service templates task flow
Use the following sequence of procedures to create or modify a service 
template:

• “Starting the Nodal Provisioning Template Editor” (page 251)

• If you are modifying a service template, see “Opening a saved service 
template file” (page 256)

• If you are creating a new service template, see “Clearing the template 
editor window to create a new service template file” (page 257)

• “Selecting a model version overview” (page 258)

•  Specify a valid software model version range or ranges for a service 
template “Specifying a model software version range” (page 262)

• Identify the template. See, “Specifying template identification attributes” 
(page 270)

• Add components, see“Adding a component” (page 274)

• Adding or modifying links. See, “Adding a link” (page 278)

• To Specify a parent or link dropsite for the first component that you add. 
See, “Adding or removing a dropsite” (page 282)

• For all attributes in the component, modify attribute details. See, 
“Modifying attribute details” (page 306)

• Arrange the tabs and groups of the Form Layout tab. See, “Form Layout 
procedures overview” (page 296)

• “Saving service template files” (page 308)

Note: When editing a text field in Nodal Provisioning Template Editor, 
the changes may not take effect until you hit enter.
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Starting the Nodal Provisioning Template Editor 
Use one of the following procedures to open the Nodal Provisioning Template 
Editor:

• “Starting Nodal Provisioning Template Editor from the Toolset 
environment” (page 252)

• “Starting Nodal Provisioning Template Editor from the Operator Client 
environment” (page 253)

• “Starting Nodal Provisioning Template Editor from Nodal Provisioning” 
(page 254)

• “Starting Nodal Provisioning Template Editor from the command line” 
(page 255)
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Starting Nodal Provisioning Template Editor from the Toolset 
environment

Use this procedure to start the Nodal Provisioning Template Editor from the 
Toolset environment.

Procedure steps
1 Select one of the following actions, depending on the device you want to 

select. 

The Nodal Provisioning Template Editor window opens. The fields in 
the window are empty.

For... On the MDM Toolset...

Passport Click Configuration, Passport and then Nodal 
Provisioning Template Editor.

MPE Click Configuration, MPE and then Nodal 
Provisioning Template Editor.
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Starting Nodal Provisioning Template Editor from the 
Operator Client environment

Use this procedure to start the Nodal Provisioning Template Editor from the 
Operator Client environment.

Prerequisite
• The Operator Client environment is open.

Procedure steps
1 Select one of the following actions, depending on the device you want to 

select. 

The Nodal Provisioning Template Editor window opens. The fields in 
the window are empty.

For... In the Operator Client window...

Passport Click Configuration and then Passport Nodal 
Provisioning Template Editor.

MPE Click Configuration and then MPE Nodal 
Provisioning Template Editor.
Preside MDM Nodal Provisioning User Guide   15.1RSUP



254   Chapter 9 Nodal Provisioning Template Editor
Starting Nodal Provisioning Template Editor from Nodal 
Provisioning 

Use this procedure to start the Nodal Provisioning Template Editor from the 
Nodal Provisioning window.

Procedure steps
1 Complete one of the following actions:

• On the Templates panel, right-click on a template and select Edit 
from the popup menu.

• On the External Tools menu, click Nodal Provisioning Template 
Editor.

The Nodal Provisioning Template Editor window opens.
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Starting Nodal Provisioning Template Editor from the 
command line 

Use this procedure to start the Nodal Provisioning Template Editor from a 
command line.

Procedure steps
1 Open an xterm on the configuration server workstation and type the 

following command:

/opt/MagellanNMS/bin/anpte [-devicetype SRS|EM]

If a device type is not specified, the default is Passport (EM). 

The Nodal Provisioning Template Editor window opens. The fields in 
the window are empty.

To modify a service template, proceed to “Opening a saved service 
template file” (page 256).
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Opening a saved service template file
Use this procedure to open a saved template file. When you open a saved 
template file, you do not need to select a model version, since templates 
created by the template editor are saved with a version.

Service template files are stored in /opt/MagellanNMS/ cfg/ANP/<device 
type>/Service/<category folder>. The device type is EM (Passport) or SRS 
(MPE 9500). A service template file has the extension .st.

Procedure steps
1 In the template editor main window, select File -> Open.

A file browser Open dialog box opens to the service directory.

Note:  If you have permissions, you can add folders, remove folders, 
rename folders, and remove files from the Open dialog box. Permissions 
are based on the userid of the account from where the template editor 
was launched.

2 Select the folder that contains the service template file that you want to 
edit and click Open.

The file browser displays the service templates (.st) files in the selected 
category folder.

3 From the list of service template files, select the file that you want to open 
and click Open

If you have selected a service template file with a model version specified 
in it, the template editor window is populated with the information 
contained in the selected service template file. You can proceed to modify 
the template. See the section “Creating or modifying service templates 
task flow” (page 250).

If you select a template that does not have a model version specified in it, 
the Choose Model Version dialog box opens. To choose a model 
version, see the procedure, “Selecting a model version overview” 
(page 258).

ATTENTION The directory used to store the service template files will be 
on the server workstation if Service Selection has been used.
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Clearing the template editor window to create a new service 
template file

Use this procedure to clear the Nodal Provisioning Template Editor window 
so that you can create a new service template.

Procedure steps
1 If you are not starting with a cleared Nodal Provisioning Template 

Editor window, select File -> New.

If there are unsaved changes in the current template, a dialog box opens 
to indicate that the current template has been modified. You are prompted 
to save your changes. After you save the file, or choose not to save the 
changes, the information in the main window is cleared.

2 If the template already has a model version associated with it, you can 
proceed to create the template with the existing model version. 

If you wish to base the template on a new model version, proceed to 
“Changing the model version of a service template” (page 260).

If you wish to specify valid Passport software version ranges, proceed to 
“Specifying a model software version range” (page 262).
Preside MDM Nodal Provisioning User Guide   15.1RSUP



258   Chapter 9 Nodal Provisioning Template Editor
Selecting a model version overview
When the Nodal Provisioning Template Editor starts, it loads the latest model 
version found on the workstation. The model version determines the 
hierarchy model, the component attributes, and any defaults. If required, you 
can select a different model version for your service template by using the 
Change Model Version command. As well, the model version changes when 
you open a template based on a different model.

The Choose Model Version dialog box also opens in the following 
circumstances:

• you select File -> Open and select an service template file that has no 
version specified.

• you select File -> Change Model Version to select a model version on 
which to base a new service provisioning template, or to change the 
model version of the template that you are currently working on.

By default, the most current model version available is selected and appears 
in the model version field.

The procedure to select the device model version of a template depends on 
whether you are starting with a cleared template, or if you want to change the 
model version of an existing template. For the relevant procedures, see the 
following sections:

• “Selecting the model version for a new service template” (page 259)

• “Changing the model version of a service template” (page 260)
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Selecting the model version for a new service template
Use this procedure to select a model version for a new service template. 

Procedure steps
If you have already loaded a service template file, and you want to select a 
model version on which to base a new template, you first need to clear the 
template editor. If the Nodal Provisioning Template Editor window has not 
been cleared, go to “Clearing the template editor window to create a new 
service template file” (page 257) dialog box.

1 On the File menu, click Change Model version.

The Choose Model Version dialog box opens.

2 In the dialog box, accept the default model version, or from the drop down 
list of available versions, select the model version that you want to change 
to.

By default, the most current and available model version is selected and 
appears in the Model version field.

3 Click OK.

The left side of the status bar of the Nodal Provisioning Template Editor 
window contains the model version that you selected. This version 
remains until you load a different template that specifies a version or you 
select a new model version.
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Changing the model version of a service template
Use this procedure to change the model version of your template. You can 
change the model version immediately upon opening the service template 
file, or you can change the model version at any time while you are modifying 
a service template. You can open a saved template file without first changing 
the model version since templates created by the template editor are saved 
with a version.

Procedure steps
You use the Choose Model Version dialog box to select a new model version.

1 On the File menu, click Change Model version.

The Choose Model Version dialog box opens.

2 In the dialog box, select the model version that you want to change to from 
the drop down list of available versions.

By default, the most current and available model version is selected and 
appears in the Model version field.

3 Click OK.

The template editor checks the template’s attributes and components 
against the new version.

If all the components and attributes are available, and have the same 
ranges of values, the template editor changes the version of the template 
and the new model version appears in the status bar at the bottom of the 
Nodal Provisioning Template Editor window. The template is reloaded 
with the new model version so any attributes and components that do not 
exist in the new model version are no longer available to change or to add 
to the template.

If one or more of the components or attributes do not exist in the new 
model version, or has a different range of values, an error dialog box 
opens. Go to step 4

4 Select Show Details.

The error dialog box displays which items are not consistent with the 
newly chosen model version and the template remains unchanged.

5 If you want to make the template consistent with the new model version, 
leave the error dialog box open, and go to step 6.

If you do not want to make the template consistent with the new model 
version, close the error dialog box and continue to edit the template.
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6 Make the changes to the template to make it consistent with the new 
model version.

7 On the he File menu, click Change Model Version.

If the template is now consistent with the model version, the error dialog 
box closes. The template’s model version is updated and the template is 
re-loaded with the new version.

If the template is still not consistent with the newly chosen model, the error 
dialog box updates with the new reasons why this template is not 
consistent with the model version. Return to step 6, or close the error 
dialog box and continue to edit the template without changing the model 
version.
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Specifying a model software version range 
You use the Set Valid Model Versions dialog box to specify the valid device 
model version range or ranges for a service template. 

When you specify a software version range or ranges, the template can only 
be used to provision devices whose software version is included within the 
specified range or ranges. Nodal Provisioning filters out all templates that do 
not apply to the software version of the connected device. The Nodal 
Provisioning window displays only those templates that apply to the software 
version or versions of the connected device.

You can specify the software version at any time after you launch the Nodal 
Provisioning Template Editor, either to create a new service template, or to 
modify an existing service template.

The Set Valid Model Versions dialog box opens with the default setting of All 
Model Versions and displays a single empty row in the range selection table.

You are provided two options for selecting a model version range or ranges:

• All Model Versions lets you create a template that applies to all device 
model software versions.

• Specify model range(s) lets you create a template which applies to 
specific Passport model software versions.

When you open an existing service template file, and then select Set Valid 
Model Versions, the template editor will read from the service template file 
to find the list of previously selected software ranges that apply to the 
template. One of the following occurs:

• If any software version applies to the template, then the software range 
selection table is list is empty. The All Model Versions option is 
selected, and the range area, Add Range button and Remove Range 
button are disabled. The template file is not tagged with a device version 
tag.

• If specific software versions apply to the template, then the software 
range selection table is populated with the list of valid software versions. 
The range table displays the From and To columns of combo boxes that 
display the lower and upper limit pairs of a model version range. When 
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a combo box is expanded, it shows the list of all available software 
versions. For example, the following information is an example for 
Passport:

— The From column may appear as follows: <“ “, All later versions”, 
CA*, CB*, CC*..., BA*, BB*, ..., FMR*, UWM*, ...> 

— The To column may appear as follows: <“ “, All previous versions”, 
CA*, CB*, CC*..., BA*, BB*, ..., FMR*, UWM*, ...>

where: 

“All later versions” means all Passport software versions which 
succeed the version specified in the From columns.

“All previous versions” means all Passport software versions which 
precede the version specified in the To column.

<matchingString>* means all Passport software versions which start 
with the <matchingString> 

The Specify Model range(s) option is selected and the Add Range and 
Remove Range buttons are enabled.

See the table “Examples of Passport Model ranges” (page 265) for 
examples of valid model ranges.

• If no software version was specified in the template, as is the case with 
the older templates, the Set Valid Model Versions dialog box defaults to 
All Model Versions. The template file is not tagged with a device 
version tag.

When you click OK in the Set Valid Model Versions dialog box the following 
occurs:

• Template editor initiates a comparison of the ranges selected in the To 
(upper range) and From (lower range) columns to confirm that the upper 
range is always greater than or equal to the lower range.
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• Another check is performed if you have already set the model version 
and this base version has the same software version as either the upper or 
lower range. The template editor checks to ensure that the base model 
version is equal to or greater than the lower limit and equal to or less than 
the upper limit.

• The template is tagged with a device version tag. 

• The range or ranges are saved in the service template XML file in the 
following format:

deviceVersion=”<lower1>-<upper1>, <lower2>-
<upper2>,...,<lowerN>-<upperN>”

where:

lowerN, upperN can be “All later versions”, “All previous versions” (*) 
or any software version (for example, CA*, BA*). The upperN limit 
must be greater or equal to the lowerN limit.

• If a range is unacceptable, an Error dialog box opens and the Set Valid 
Model Versions dialog box remains open. See “Error messages” 
(page 266) for additional information on the conditions that create error 
messages and the error messages that are generated.

For additional information, see the following sections:

• “Examples of model software version ranges” (page 264)

• “Error messages” (page 265)

• “Specifying the software version range or ranges for a new service 
template” (page 267)

• “Specifying template identification attributes for a new template” 
(page 271)

Examples of model software version ranges
The table “Examples of Passport Model ranges” (page 265) provides 
examples of valid model software version ranges.
241-6001-610   15.1RSUP   



Chapter 9 Nodal Provisioning Template Editor   265
Error messages
The table “Error messages” (page 266) describes possible error messages 
when specifying version ranges in the Set Valid Model Versions dialog box.

Table 29
Examples of Passport Model ranges

In Set Model 
Range Dialog 
box

From

In Set Model 
Range Dialog 
box

To

In XML file
<lower>-<upper>

Explanation

All previous 
versions

CD* *-CD* applies to all model versions which are 
released earlier and include release 
CD<version><developmentNumber>
<cycleNumber><debugNumber>

CD* All later versions CD*-* applies to all model versions which are 
released from model version 
CD<version><developmentNumber><
cycleNumber><debugNumber> and 
later

CD* CE* CD*-CE* applies to all model versions which are 
released from model version 
CD<version><developmentNumber>
<cycleNumber><debugNumber> to 
CE<version><developmentNumber><
cycleNumber><debugNumber>

CD* CD* CD*-CD* applies to the exact model version 
which starts with CD
Preside MDM Nodal Provisioning User Guide   15.1RSUP



266   Chapter 9 Nodal Provisioning Template Editor
Procedures for setting the software version range or ranges
Use the following procedures to specify the Passport software version range 
for a new service template. You can specify the software version at any time 
after you launch the Nodal Provisioning Template Editor. For relevant 
procedures, see the following sections:

• “Specifying the software version range or ranges for a new service 
template” (page 267)

• “Changing the software version range or ranges of a service template” 
(page 268)

Table 30
Error messages

Error condition Error message Solution

The version in the To column is not 
greater than or equal to the version 
in the from column.

The version in the To column 
must be greater than or equal 
to the version in the From 
column.

Enter a valid version 
range in the selected 
row.

The model software version 
specified in the From column and 
the To column do not belong to the 
same software solution.

Range must specify the same 
software solution.

Enter a valid version 
range in the selected 
row.

The base version of the template is 
outside of the selected valid model 
versions.

The base version <version> is 
outside the valid model 
versions range at the selected 
row.

Select Yes to save the 
selected valid versions.
Select No to not save 
the selected valid 
versions.
Select Cancel to cancel 
all selected valid 
versions.

One of the selected valid model 
versions is already included in other 
valid model versions.

There exists an other version 
range which includes this 
selected range.

Enter a valid version 
range in the selected 
row.
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Specifying the software version range or ranges for a new 
service template

Use this procedure to select the valid software version range or ranges for a 
device.

Procedure steps
1 On the File menu, click Set Valid Model Versions.

The Set Valid Model Versions dialog box opens and displays a single 
empty row. By default, the All Model Versions option is selected, and the 
Add Range and Remove Range buttons are disabled.

2 If you wish the template to apply to all device model software versions, 
click OK to save the valid model versions. The template file is not tagged 
with a device version tag.

If you wish to create a template which applies to specific device model 
software versions, select the Specify Model range(s) option and go to 
step 3. The rows in the software range selection table, and the Add 
Range and Remove Range buttons are enabled

3 Click in the From column, and select the lower limit or starting point for 
your range from the dropdown list of available versions in wildcard format. 
See “Examples of Passport Model ranges” (page 265).

You can also type a new valid software version range in the From cells of 
the new row.

4 Click in the To column to select the upper limit, or endpoint for your range 
from the dropdown list of available ranges. you can also type a new valid 
software version range in the To cells of the new row.

If no additional ranges are required, proceed to step 7.

5 If additional ranges are required, click Add Range. A new row is added to 
the software range selection table, with the initial selected value as an 
empty string. You can set another range by specifying the lower and upper 
limits.

To remove a selected row from the software range selection table, click 
Remove Range. The software range selection table has one less 
element.

6 Repeat steps 3 to 5 until you have specified all the required ranges.

7 Click OK.

The template file is tagged with a device version tag.
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Changing the software version range or ranges of a service 
template

Use this procedure to change the device software version range or ranges of 
a service template.

Procedure steps
1 From the File menu, select Set Valid Model Versions.

The Set Valid Model Versions dialog box opens. The template editor 
reads the service template file to find the list of software ranges that apply 
to the template. One of the following scenarios occurs:

• If any device software version applies to the template, the dialog box 
opens with an empty range selection table, the All Model Versions 
option selected, and the Add Range and Remove Range buttons 
are disabled.

• if a specific device software version or versions apply to the template, 
the software range selection table is populated with the list of valid 
software versions. The Specify Model range(s) option is selected 
and the Add Range and Remove Range buttons are enabled.

• if no device software version was specified in the template, as in 
older service templates, the Set Valid Model Versions dialog box 
defaults to All Model Versions.

2 To create a service template that applies to specific device software 
versions, select the Specify Model range(s) option.

The rows in the software version range selection table are enabled. Add 
Range and Remove Range are enabled.

3 Click in the From column, and select the lower limit or starting point for 
your range from the dropdown list of available versions in wildcard format. 
See “Examples of Passport Model ranges” (page 265).

You can also type a new valid software version range in the From cells of 
the new row.

4 Click in the To column to select the upper limit, or endpoint for your range 
from the dropdown list of available ranges. you can also type a new valid 
software version range in the To cells of the new row.

If no additional ranges are required, proceed to step 7.

5 If additional ranges are required, click Add Range. A new row is added to 
the software range selection table, with the initial selected value as an 
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empty string. You can set another range by specifying the lower and upper 
limits.

To remove a selected row from the software range selection table, click 
Remove Range. The software range selection table has one less 
element.

6 Repeat steps 3 to 5 until you have specified all the required ranges.

7 Click OK.

The template editor initiates a comparison of the ranges selected in the 
To (upper range) and From (lower range) columns to ensure that the 
base model version is equal to or greater than the lower limit and equal to 
or less than the upper limit. If these conditions are met, the range or 
ranges are saved and the Set Model Range dialog box closes.
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Specifying template identification attributes 
The Template Identification panel provides fields to enter general information 
to identify the template. The template identification attributes can be edited. 
See the following sections for additional information:

• “Specifying template identification attributes for a new template” 
(page 271)

• “Modifying template identification attributes of an existing service 
template (.st) file” (page 272)
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Specifying template identification attributes for a new 
template

Use this procedure to provide identifying information about the service 
template. 

Prerequisites
This procedure requires that you have opened the Nodal Provisioning 
Template Editor to create a new template.

Procedure steps
1 In the Title field, type a name to identify the service template. This field is 

mandatory.

You should create a unique title for each template within the same service 
category. The title that you enter in the Title field is the title that appears 
for the template in the service template palette of the Nodal Provisioning 
window.

2 In the Author field, type the name of the author of the service template. 
This field is mandatory.

If the template is created by Nortel Networks, this field displays “Nortel 
Networks”. 

3 Optionally, provide a description of the service template by completing 
one of the following steps”

• directly in the Description field, type an explanation or details about 
the service template

• click Edit... to open a larger editing window. This window is empty. 
Type an explanation or details about the service template in this 
window and click Close.

4 Click Browse....

An icon chooser window opens containing icon images.

5 Select an icon image that represents the service template and click OK.

This icon images appears to the left of the service template title in the 
Nodal Provisioning window.
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Modifying template identification attributes of an existing 
service template (.st) file

Use this procedure to make changes to the following attribute fields in the 
template identification panel of the Nodal Provisioning Template Editor 
window after you open a service template (.st) file:

• title

• author

• icon

• description

Procedure steps
1 In the Nodal Provisioning Template Editor window, make one or more 

of the following modifications:

• If you are modifying the Title or Author fields, highlight the contents 
of the field that you want to modify and make the changes directly in 
the fields. If the template was created by Nortel Networks, the Author 
field contains “Nortel Networks”. 

• If you are modifying the contents of the Description field, select Edit 
to the right of the Description field to open a larger Edit Description 
window. When you open a service template file, this window opens 
with a the same information as contained in the Description field in 
Make your changes and click Close to close the window.

• If you are modifying the icon, select Browse to open an icon browser 
window and select the icon that you want to use.

2 From the File menu, select Save to save the changes. See “Saving 
service template files” (page 308).

You cannot overwrite a template created by Nortel Networks. You need to 
save your changes under a new name.
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Component layout procedures 
See the following for procedures relating to the component layout tree.

• “Adding a component” (page 274)

• “Changing the component parent designation” (page 276)

• “Adding sub-components to a dropsite or component node” (page 277)

• “Adding a link” (page 278)

• “Moving a sub-component to another parent” (page 280)

• “Removing components from the Component Layout” (page 281)

• “Adding or removing a dropsite” (page 282)

• “Adding a parent dropsite” (page 284)

• “Resolving a previous parent dropsite” (page 285)

• “Adding a link dropsite” (page 286)

• “Resolving a previous link dropsite” (page 288)

• “Adding or removing a dropsite drop target” (page 289)

• “Selecting the component parent designation” (page 290)

• “Changing the component designation” (page 292)

• “Removing links” (page 294)

• “Adding or removing attributes” (page 295)
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Adding a component 
Use this procedure to add a new component.

Prerequisites
• If this is the first component you add under EM, the Model Version must 

be selected. See “Selecting the model version for a new service template” 
(page 259).

Procedure steps
1 From the Selected menu, click Add Component.

The Add Component dialog box opens.

2 Select the component that you want to add or begin typing the component 
name in the Choose a component field. 

As you type the name, the corresponding component is highlighted in the 
Component Name list.

3 Click Ok.

If the component is a root level component, it displays in the Component 
Layout panel. If the component is a non-root level component, the 
Component Parent Designation dialog opens and you continue to 
step 4.

4 From the radio buttons, select the option for how the component should 
be derived.

5 From the pick list associated with the selected radio button, specify the 
parent component.

6 Click OK.

If you selected Create Parent Now, the component and its parent 
components will be created when the template is applied.

If you selected Find Parent at Runtime, Find Component at Runtime, 
or Parent is a Dropsite, a list of all existing parent components will be 
displayed when the template is applied.
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Adding a component attribute
When you add a component to a template, component attributes are 
not automatically added. Use this procedure to add an attribute to the 
template.

Prerequisites
This procedure requires that you have selected the attribute to add to the 
template.

Procedure steps
1 Complete one of the following steps:

• right-click the attribute and select Add to Template from the pop-up 
menu.

• on the Selected menu, click Add to Template.

2 To preview the template with the attribute, on the View menu, click 
Preview.
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Changing the component parent designation
Use this procedure to change how a component should be derived.

Procedure steps
1 Open the template that you want to edit.

2 Select the Component Layout tab.

3 From the Component Layout panel, select the component whose 
derivation you want to change.

4 Right-click to open the popup menu and select Change Component 
Designation.

The Component Parent Designation dialog opens.

5 From the available radio buttons, select the option for how the component 
should be derived.

6 From the pick list associated with the selected radio button, specify the 
parent component.

7 Click OK.

If you selected Create Parent Now, the component and its parent 
components will be created when the template is applied.

If you selected Find Parent at Runtime, Find Component at Runtime, 
or Parent is a Dropsite, a list of all existing parent components will be 
displayed when the template is applied.

Note:  This procedure changes only the selected component. If you select 
the parent options, new parent components are created. The existing 
parent components remain in the template and you can remove them. If 
you want to change the parent component, then you must select the 
parent component in step 3.
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Adding sub-components to a dropsite or component node
Use this procedure to add a sub-component to a component or to a dropsite.

The Add Sub-component command is enabled only when you select a 
component that can have sub-components.

You use the Add Component dialog box to add a sub-component to a dropsite. 
You can only add a sub-component to a dropsite that is a parent-type dropsite.

Procedure steps
1 In the Nodal Provisioning Template Editor window, select the 

Component Layout tab.

2 In the component layout tree, select the component or dropsite to which 
you want to add a sub-component.

3 Right-click to open the popup menu and select Add Sub-Component.

The Add Component dialog box opens and displays a list of sub-
components that can be added to the selected component.

4 Select the component that you want to add or begin typing the component 
name in the Choose a component field. 

As you type the name, the corresponding component is highlighted in the 
Component Name list.

5 Click OK.

The component and all of its required sub-components are added to the 
component layout tree. 
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Adding a link
Use this procedure to add a link to a dropsite component, or to another 
component in the component layout tree.

The Add Link Component command is only enabled if it is a valid action for 
the selected component.

Note: The value of the link attribute between two components can be 
added in either the Component Layout or Form Layout tab, but not in 
both.

Procedure steps
1 In the template editor main window, select the Component Layout tab.

2 In the component layout tree, select the component to which you want to 
add a linked component.

3 On the Selected menu, click Add Link:

The Add Link dialog box opens.

In the From panel, the Component field is populated with the component 
that is selected in the component layout tree.

The Attribute list lets you select the link attribute of the source 
component.

4 In the To panel, select one of the following options:

• New Component if you want to link the currently selected 
component and attribute (or dropsite) to a new component.

• Existing Component if you want to link the currently selected 
component and attribute to a component that already exists in the 
template.

5 In the Choose Component panel, select the linked component that you 
want to link to by typing the linked component’s name in the Choose a 
component field or choose a component under Component Name list.

As you type the name, the corresponding linked component’s name is 
highlighted in the Component Name list. The Component Names list 
contains the names of all the components that can link to the selected 
component or attribute.

6  Click OK.
241-6001-610   15.1RSUP   



Chapter 9 Nodal Provisioning Template Editor   279
If you have selected the New Component option, and the component is 
found directly under EM, the component is added to the component layout 
tree.

If the linked component is not a root-level component, that is, it needs a 
parent, the Component Parent Designation dialog box opens. You will 
need to resolve the parent path for it. See “Selecting the component 
parent designation” (page 290).

If you have selected the Existing Component option, the selected 
component is linked to a component that already exists in the template.

If you wish to cancel the operation, click Cancel to close the Add Link 
dialog box and return to the Nodal Provisioning Template Editor 
window.
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Moving a sub-component to another parent
Use this procedure to move sub-components from one compatible parent to 
another.

Procedure steps
1 From the Component Layout, select the sub-component that you want to 

move.

2 From the Selected menu, select Move Component.

The Move Component dialog opens with all the compatible parent 
components available in the Select parent to move component picklist.

3 From the Select parent to move component picklist, select the parent 
component.

4 Click OK.

The Component Layout changes to show the new parent component.
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Removing components from the Component Layout
Use this procedure to remove top level components, linked components, or 
sub-components from the component layout tree.

Procedure steps
1 In the Nodal Provisioning Template Editor window, click on the 

Component Layout tab. 

2 Navigate the Component Layout tree to the item you want to remove 
and select it.

3 Complete one of the following steps:

• right-click and select Remove from the pop-up menu.

• on the Selected menu, click Remove.

The selected item and all its sub-components and link attributes are 
removed from the Component Layout. In the case of a linked dropsite, the 
dropsite and its links are removed. 
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Adding or removing a dropsite 
A dropsite is the component location where the service template can be 
dropped in the component hierarchy in the Nodal Provisioning window.

Only one dropsite node is allowed for the template because the template can 
only be dropped on a single component at a time in the NP window. However, 
a dropsite node can contain several drop targets because it is possible to drop 
the template on several different components. 

There are two types of dropsites:

— link dropsite
A link dropsite uses the dropsite to set the link attribute for a 
component in the template. When the template is dropped in Nodal 
Provisioning, the location of the drop is used to set the linkAttribute 
of the associated component(s). A link-type dropsite is used to link 
an existing component with one or more components in the 
template. The link is bi-directional which means that both 
components know which component their link attribute is connected 
to. 

— parent dropsite
A parent dropsite is a component that will become the parent of one 
or more components in the template. A parent-type dropsite is used 
to add a component that is to be created as a sub-component of a 
component that already exists on the device. 

When a template is dropped on an existing parent component, the 
components in the template are created as subcomponents to the 
parent component.

You can add a dropsite by selecting Add Dropsite from the Selected menu. 
This opens the Select Dropsite dialog. See “Select Dropsite dialog box with 
Link dropsite type selected” (page 283). 

ATTENTION If you don’t add a dropsite, the dropsite default is the root 
component.
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Figure 14
Select Dropsite dialog box with Link dropsite type selected
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Adding a parent dropsite
Use this procedure to add a parent-type dropsite. A parent drop-site is used to 
add a component that is to be created as a sub-component of a component that 
already exists on the device. The template is applied to the existing 
component when using Nodal Provisioning. 

Prerequisites
This procedure requires that the following conditions exist. 

• You want to add a component that must be created as a child component 
of a parent component that is not currently in the template.

• You want the template drop action in Nodal Provisioning to locate the 
parent component.

Procedure steps
1 Select the component from the Component Layout and right-click to open 

the popup menu.

2 Select Add Component.

3 Enter a component which is to be created under the dropsite.

The Component Parent Designation Dialog opens.

4 Select Parent is a Dropsite.

5 Select a parent path.

6 Click OK.

7 If further drop targets are needed, see “Adding or removing a dropsite 
drop target” (page 289).

8 If more sub-components are to be added under the parent dropsite, see 
“Adding sub-components to a dropsite or component node” (page 277)
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Resolving a previous parent dropsite
Use this procedure when you want to modify a template, which contains a 
previous parent (non-root) dropsite, to specify a new dropsite.

Prerequisites
This procedure requires that the following conditions exist. 

• You have opened the template with the component whose parent dropsite 
you want to resolve.

• You have attempted to add a new dropsite using the Add Parent Dropsite 
or Add Link Dropsite procedures and the warning dialog is opened to 
indicate the template already contains a previous dropsite. 

Procedure steps
1 Select the appropriate action from the warning dialog:

If you select Remove, the previous dropsite and all its sub-components 
and links are removed. Go to step 3.

If you select Resolve, the Change Parent Designation dialog opens. 

2 From the Change Parent Designation dialog, select one of the following:

• Create Component Now so the component and its parent 
components will be created when the template is applied

• Find Component at Runtime so a list of all existing parent 
components will be displayed when the template is applied.

3 Click OK.
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Adding a link dropsite
Use this procedure to resolve a previous parent dropsite. This occurs when a 
new dropsite is added to a template which already contains a parent dropsite.

Prerequisites
This procedure requires that the following conditions exist. 

• You have opened the template with a non-root parent dropsite and you 
want to change the dropsite.

• You have added a component and that component needs to link to a 
component outside of the template, and you want the template drop 
action in Nodal Provisioning to locate that component.

Procedure steps
1 Select the Component Layout tab.

2 From the Component Layout, select the component which contains a link 
attribute and right-click to open the popup menu.

3 Select Add Link.

The Add Link dialog opens. In the From panel, the Component field is 
populated with the component that you selected in the Component 
Layout.

4 From the Attribute list, select the link attribute of the source component.

5 In the To panel, select New Component.

6 In the Choose Component panel, select New Link Dropsite.

7 Click OK.

8 In the Available Dropsites list, select one or more of the components in the 
list. The list contains all the components that can be linked to the 
component you have selected.

9 Click the Add or Add All button to move the selected component(s) from 
the Available list to the Chosen Dropsites list. If you want to remove one 
or more components, go to step 10. Otherwise go to step 11.

ATTENTION You can select more than one link dropsite only if they all can 
have the same type of sub-component.
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10 Click the Remove or Remove All button to remove one or more 
components from the Chosen Dropsites list to the Available Dropsites 
list.

11 Click OK

The link dropsite node is added to the Component Layout tab as a child 
of the root node. It is labeled with a drop icon to distinguish it as a dropsite 
node. 
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Resolving a previous link dropsite
Use this procedure to resolve a previous link dropsite. This occurs when a 
new dropsite is added to a template which already contains a link dropsite.

Prerequisites
• You have opened the template with a link dropsite and you want to 

change the dropsite.

• You have attempted to add a new dropsite using the Add Parent Dropsite 
or Add Link Dropsite procedures and the warning dialog is opened to 
indicate the template already contains a previous link dropsite.

Procedure steps
1 Click OK to remove the previous link dropsite.

The Select Dropsite dialog opens.

2 Select the new dropsite type and specify the dropsite component.

3 Click OK.

The new link dropsite component is created and the dialog closes.

The previous link dropsite components are removed.
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Adding or removing a dropsite drop target
Use this procedure to add or remove a dropsite from the template.

Procedure steps
1 In the Nodal Provisioning Template Editor window, in the component 

layout tree, click on the dropsite node. 

The heading at the lower part of the Component Layout tab is labelled 
Dropsite Details.

If the dropsite is a parent-type dropsite, the list of parents for the 
component will appear in either the Available Dropsites or Chosen 
Dropsites list.

If the dropsite is a link-type dropsite, the list of components that have a 
link attribute that can link to the component is in the Available Dropsites 
list

2 From the Available Dropsites or Chosen Dropsites list, select the 
dropsite or dropsites that you want to add or remove.

3 Click Add to move a dropsite from the Available to the Chosen dropsites 
list or click Remove to move a dropsite from the Chosen to the Available 
dropsites list.

4 Save the template.

When you reopen the template, the selected dropsite is removed from the 
component layout tree.
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Selecting the component parent designation 
Use this procedure to indicate how a non-root component is to be created or 
located. This occurs when a non-root component is added through the Add 
Component or Add Link procedures.

Component Parent Designation dialog box
The Component Parent Designation dialog box opens when you add a 
component that is not a sub-component of the root EM or if you add a linked 
component. The dialog box gives you the options to either create the 
component, find it at runtime, or make it a child of a parent dropsite.

Procedure steps
1 In the Component Parent Designation dialog box, select one of the 

following options:

• To create a parent for a new component, select the Create Parent 
Now option. The adjacent parent field is enabled. You can select from 
a list of one or more paths of parents up to EM. 

• To search for available parents on the device at runtime, select the 
Find Parent at Runtime option. The adjacent field is enabled and 
contains a dropdown list of one or more search strings of parents up 
to EM. Select the search string to the component that is to be a parent 
of the component that is created by the template. This search string 
is applied to existing components on the device at runtime.

• To search for this component of this type on the device at runtime, 
select the Find Component at Runtime option. The adjacent field is 
enabled and contains a drop down list of one or more search strings 
of this component and its possible parents up to EM. Select the 
search string to the type of component that you want to search for at 
runtime. This search string is applied to existing components on the 
device at runtime.

• To create the component using the location where the template is 
dropped in Nodal Provisioning, select the Parent is a Dropsite 
option.

2 Click Ok.

If you selected the Create Parent Now option and the parent path, Ok 
creates the selected parent components as branches in the component 
layout tree.
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If you selected the Find Parent at Runtime option and the search string 
of parents, an instance list node is added as the root node, and is 
identified as an instance icon. The component is added as a branch from 
the Instance List node in the component layout tree. You can have more 
than one instance list per template. 

If you selected the Find Component at Runtime option, the component 
is not created by the template but is added as an instance list. An instance 
list node is added to the template to represent the type of component that 
you want to search for at runtime. It is identified by an instance icon. 

If you selected the Parent is a Dropsite option, the component is created 
as a sub-component of the component where you drop the template in 
Nodal Provisioning.
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Changing the component designation
Use this procedure to change how a component is created or located.

Procedure steps
1 From the Component Layout, select the component whose designation 

you want to change and right-click to open the popup menu.

2 Select Change Component Designation.

The Component Designation dialog opens.

3 In the Component Designation dialog box, select one of the following 
options:

• To create the new component, select the Create Component option. 
The adjacent field contains only the component that you are adding, 
in other words, the component that you selected in the Add 
Component dialog box when adding a component. See “Adding a 
component” (page 274). You do not have to choose anything in this 
field.

• To search for the component on the device at runtime, select the Find 
Component at Runtime option. The component is not created by 
this template but is added as an instance list. The adjacent field is 
enabled. It contains the search string of the component you are 
adding. You do not need to choose anything in this field.

• To search for available parents on the device at runtime, select the 
Find Parent at Runtime option. The adjacent field is enabled and 
contains a dropdown list of one or more search strings of parents up 
to EM. Select the search string to the component that is to be a parent 
of the component that is created by the template. This search string 
is applied to existing components on the device at runtime.

• To indicate that the parent is a dropsite, select the Parent is a 
Dropsite option.

4 Click Ok.

If you selected Create Component option, OK creates the selected 
component.

If you selected the Find Parent at Runtime option and the search string 
of parents, an instance list node is added as the root node, and is 
identified as an instance icon. The component is added as a branch from 
the Instance List node in the component layout tree. You can have more 
than one instance list per template. 
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If you selected the Find Component at Runtime option, an instance list 
node is added to the template that represents the type of component that 
you want to search for at runtime. The search string is applied to existing 
components on the switch at runtime.

If you selected the Parent is a Dropsite option, the component is created 
as a sub-component of the component where you drop the template in 
Nodal Provisioning.
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Removing links
Use this procedure to remove a link from a currently selected component. 

Procedure steps
1 In the Nodal Provisioning Template Editor window, click on the 

Component Layout tab. 

2 In the component layout tree, navigate to the linked component that you 
want to remove and select it.

3 On the Selected menu, click Remove Link.

If more than one link exists, a selection menu opens; go to step 4. 
Otherwise, the selected link is removed. The components remain.

4 Select the link to be removed and click OK.

The selected link is removed. The components remain.
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Adding or removing attributes
Use this procedure to add to or remove attributes from a selected component 
in the component layout tree.

Procedure steps
1 In the Nodal Provisioning Template Editor window, click on the 

Component Layout tab. 

2 Complete one of the following steps:

• in the component layout tree navigate to the component whose 
attributes you want to add to or remove and select it

• in the Component Details section, select the component from the 
Components drop down list.

3 To add an attribute, select the attribute in the Available attributes list and 
click Add to move the attribute to the Included in Template list.

To remove an attribute, select the attribute in the Included in Template 
list and click Remove to move the attribute to the Available attributes list.

4 Save the template. See the section “Saving service template files” 
(page 308).
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Form Layout procedures overview
The following procedures apply to the form layout tab in the Nodal 
Provisioning Template Editor window. You can add and remove tabs and 
groups, and show and hide components from the form layout tree.

A tab is a collection of groups that you define. The collection is shown on the 
service template as a tab with a name that you specify.

A group is a collection of components that you define. The collection is 
shown on the service template as a bordered panel. You can specify a title for 
the panel.

See the following sections for additional information:

• “Reorganizing tabs or groups” (page 297)

• “Renaming tabs or groups” (page 298)

• “Adding tabs to the form layout tree” (page 299)

• “Deleting tabs from the form layout tree” (page 300)

• “Adding Groups to the form layout tree” (page 301)

• “Deleting Groups from the form layout tree” (page 302)

• “Hiding a component in the form layout tree” (page 303)

• “Showing components in the form layout tree” (page 304)

• “Removing a component from the form layout tree” (page 305)

• “Modifying attribute details” (page 306)
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Reorganizing tabs or groups
Use this procedure to move a tab or group on the Form Layout tree.

Procedure steps
1 In the Form Layout tree, select the Tab or Group that you want to move.

The area below the tree shows the name of the selected tab or group and 
its details.

2 To move a tab or group to a new location in the form, use the drop down 
lists in the Location section of the Details area.

To move a tab, in the Location section, select a new position from the 
available positions listed in the drop down list. The tab moves to the 
selected position.

You can move a selected group to a new tab location and a new position. 
Select the desired tab location from the Tab drop down list. Select the 
desired position under the Tab from the Position drop down list.
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Renaming tabs or groups
Use this procedure to edit the name of a tab or group.

Procedure steps
1 In the Form Layout tree, select the Tab or Group that you want to 

rename.

If you select a tab, the name of the tab appears in the Tab Name field of 
the Details area.

If you select a group, the name of the group appears in the Group Name 
field of the Details area.

2 Edit the name in the text field.

The new tab or group name appears in the Form Layout tree.
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Adding tabs to the form layout tree
Use this procedure to add a new tab to the form layout tree.

Procedure steps
1 Select the Form Layout tab.

2 Complete one of the following steps:

• On the Form Layout tab, right-click Main Dialog Window and then 
select Add tab.

• On the Selected menu, click Add tab.

The new tab appears as the last tab in the form layout tree. It has the 
default name of “New Tab”. You can edit the default name to any new 
string.
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Deleting tabs from the form layout tree
Use this procedure to delete a tab from the form layout tree.

Procedure steps
1 Select the Form Layout tab.

2 In the Form Layout tab, select the tab that you want to remove from the 
form layout tree.

Note:  You can not remove tabs that have subcomponents.

3 Complete one of the following steps:

• Right-click on the tab and select Remove from the pop-up menu.

• On the Selected menu, click Remove. 

The tab is deleted from the form layout tree.
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Adding Groups to the form layout tree
Use this procedure to add a Group to a tab in the form layout tree. A Group 
shows a grouping of components that should be displayed together under a 
tab in the service creation form. A Group can only be added to tabs in the form 
layout tree.

Procedure steps
1 Select the Form Layout tab.

2 Select the tab to which you want to add a group.

3 Complete one of the following steps:

• Right-click and select Add Group from the pop-up menu.

• On the Selected menu, click Add Group.

The new group appears as the last group in the tab. It has the default 
name of “New Group”. You can edit the default name to any new string.
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Deleting Groups from the form layout tree
Use this procedure to remove a group from a tab in the form layout tree.

Procedure steps
1 Select the Form Layout tab.

2 Select the group that you want to delete.

Note:  .You can not delete a group that has sub-components. The Delete 
Group menu item is disabled.

3 Complete one of the following steps:

• Right-click and select Remove from the pop-up menu

• On the Selected menu, click Remove.

The selected group is removed from the form layout tree.
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Hiding a component in the form layout tree
Use this procedure to hide a selected component in the form layout tree.

Note: The Hide Component menu item is disabled for components 
whose key needs to be filled in at run-time.

Procedure steps
1 Select the Form Layout tab.

2 In the form layout tree, navigate to the component that you want to hide 
and select it.

3 Complete one of the following steps:

• Right-click and select Hide from the pop-up menu.

• On the Selected menu, click Hide. 

The component is no longer accessible in the form layout tree. The value 
of key display and attribute display are set to false for each of the 
component’s attributes and the instance value will not display. However, 
the component will still be in the template, and any values that were set 
for its attributes are applied when the component is created.
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Showing components in the form layout tree
Use this procedure to display hidden components in the form layout tree.

Procedure steps
1 Select the Form Layout tab.

2 Select the hidden component that you want to display.

3 Complete one of the following steps:

• On the Selected menu, click Show.

• Right-click and select Show from the pop-up menu.

The selected component becomes visible in the form layout tree. Display 
in form is set to true for each of the component’s attributes that has a non-
default value and the instance value is displayed.
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Removing a component from the form layout tree
To remove a component from the form layout tree, you need to remove it from 
the component layout tree. When you remove a component from the 
component layout tree, the change is reflected in the form layout tree. 
Removing a component has the following impact on the groups and tabs in 
the form layout tree:

• if the tab and groups have been automatically generated, and if the group 
is empty, the tab and group are removed

• if the tab and groups have been automatically generated, and if the tab 
contains multiple groups, only the empty groups are removed

• if you have created the tab, or changed the name of the automatically 
created tab, the tab and groups are not removed

For the procedure to remove a component from the Component layout tree, 
see “Removing components from the Component Layout” (page 281). 
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Modifying attribute details
Use this procedure to modify the attributes of the service template.

Procedure steps
1 In the Nodal Provisioning Template Editor window, click on the Form 

Layout tab. 

2 Select the attribute that you want to modify from the form layout tree:

• Display in Form value,
To modify the Display in Form value, select Display in Form check 
box.

If Display in Form is not checked, you will not see the attribute displayed 
in the service template form. Display in Form is normally left unchecked 
only if there is an override value for a specific attribute.

• Value field
To modify the value, either select the desired value from the list that 
appears when you select Value, or edit the selection to be the value 
that you want. You have the following choices:
-override
-default
-gets value from
-user selected
When you change Value, it is the override value for the Attribute.

• Label field
To modify the Label, enter a new value in the Label field. Verify that 
the Display in Form check box is checked. This ensures that the 
new label is seen in the service creation form.

• Initial Value
To modify the Initial Value, change the selected value in the widget 
that appears if this field is enabled.

• Mandatory check box
To modify the Mandatory check box, click on it. A checked box 
means that this attribute is mandatory and must be filled in before a 
service creation form is valid. If left unchecked, the service creation 
form allows users to proceed without filling in a value for this attribute.

• Editable check box
To modify the Editable check box, click on it. A checked box means 
that this attribute’s values can be edited. Mandatory is ignored if 
Editable is unchecked.
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3 Save the changes. See the section “Saving service template files” 
(page 308).
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Saving service template files 
The Save dialog box opens when you select Save As to save a service 
template file for the first time, or if you select Save and you have not yet saved 
the file. 

When you select Save As to open the Save dialog box, the default directory/
folder for the saved template is Service/UserTemplates. You can change this 
by selecting another directory and folder in the dialog box.

The Save dialog box lets you add folders, remove folders, and rename folders. 
You can also remove and rename files if you have file permissions. These 
permissions are based on the userid of the account from where the editor was 
launched.

The Save dialog box provides the option of saving the template as a read-only 
file.

For additional information on saving service template files, see the following 
sections:

• “Saving a service template file for the first time” (page 309)

• “Saving a service template file after you have modified it” (page 312)
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Saving a service template file for the first time
Use this procedure after you create a new service template file and you are 
saving it for the first time.

Note: You can write to /opt/MagellanNMS/cfg/... but you cannot 
overwrite the files that have been installed by Nortel Networks

Note: You cannot save a template with a name that is the same as the 
typeId of any component.

Procedure steps
1 In the menu bar of the Nodal Provisioning Template Editor window, 

select File -> Save As.

A Save file browser dialog box opens. The dialog box opens to the service 
directory and category subdirectory.
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Note:  If you have permissions, you can add folders, remove folders, 
rename folders, and remove files from the Save dialog box. Permissions 
are based on the userid of the account from where the template editor 
was launched.

If you have not completed all the fields in the Template Identification 
panel, an error dialog box opens indicating the missing template 
identification details. Click OK and enter the missing information and click 
Save As again.

2 Do one of the following:

• To replace or rename an existing file, select the service category 
folder and select the file that you want. You can only replace or 
rename files for which you have write permissions.

• To save a new template file in an existing service category folder, 
select the service category folder that you want, and in the File Name 
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field, enter a new file name. The default folder for template files is 
UserTemplates

• To save a new template file in a new folder, click the new folder icon, 
enter a name for the new folder, and in the File Name field, enter a 
new file name.

3 To save the template as a read-only file, click Save read-only. Otherwise, 
click Save.

The save actions generate a service template file in xml formal in the 
selected directory and with the specified name. If you try to save another 
file with the same name, a warning dialog box opens explaining that the 
action is not allowed and why it is not allowed.
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Saving a service template file after you have modified it
Use this procedure to save a service template after you have already saved the 
service template file at least once.

Note: You can write to /opt/MagellanNMS/cfg/... but you cannot 
overwrite the files that have been installed by Nortel Networks.

Procedure steps
1 In the Nodal Provisioning Template Editor window, edit the contents.

2 On the File menu, click Save.

If you are modifying a.st file that was shipped with the product, or if it is a 
read-only file, you will be warned that you cannot overwrite the file. You 
can then select File -> Save As to save the file with a new name.

If you try to save the file with a typeId as a name, a dialog box opens that 
explains that this action is not allowed and why.

If the file is not read-only, clicking Save generates a service template file 
in XML format with the same filename that was used to open the file.
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Exiting Nodal Provisioning Template Editor
Use this procedure to close the Nodal Provisioning Template Editor window 
and exit the tool.

Procedure steps
1 From the File menu, select Exit.

The Nodal Provisioning Template Editor window closes. 

If you have not yet saved your changes, you are prompted to save your 
changes. See “Saving service template files” (page 308).
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Updating the service template palette in Nodal Provisioning 
Use this procedure to update the template palette in the Nodal Provisioning 
window to include any newly created or edited templates. 

Procedure steps
1 Complete one of the following steps:

• In the menu bar of the Nodal Provisioning window, select View -> 
Reload Templates, or 

• In the toolbar of the Nodal Provisioning window, click the reload 
template icon.
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Version checking tool overview
The version checking tool is an off-line tool that identifies inconsistencies 
between the following, when the Passport software version is upgraded:

• service templates and component models

• service models and the hierarchy model

You should run the service template version checking tool any time that the 
version of the software is changed since changes made in the new version 
may affect the current service model or templates.

The tool compares existing service model and template files with the 
hierarchy model and component model files. It reports when a service model 
or template refers to the following:

• removed attributes

• removed components

• obsoleted components

• obsoleted attributes.

When the tool finds inconsistencies, it outputs a line that specifies which files 
are affected. If no inconsistencies are found, the output line states that all files 
are OK.
Preside MDM Nodal Provisioning User Guide   15.1RSUP



316   Chapter 9 Nodal Provisioning Template Editor
Starting the version checking tool
Use this procedure to start the version checking tool to identify 
inconsistencies between service templates and component models and 
hierarchy models when a software version is upgraded in a device.

Procedure steps
1 Type the following command line.

/opt/MagellanNMS/bin/anpstcheck [-devicetype 
<type>][-h] [-st | -fst <service template filename>] 
-version <model version> 

The tool outputs any inconsistencies that it has found between versions.

Command line options
-devicetype <type> is the option to select a Passport or MPE 9500 
template. The <type> is either SRS or EM. If this option is not specified, the 
default is Passport.

-h is the option to display command usage.

-st is the option to check all service templates.

-fst <service template filename> is the option to only check a 
particular service template. The file name must include the path and 
extension.

-version <model version> is the version of the node to check against.

Sample outputs
The following sections provide examples of the tool’s outputs when it finds 
the following:

• all files are consistent

• an error is found in the service template

Version checking tool output when all files are consistent

All service model and template files are consistent 
with the hierarchy and component model files.
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Version checking tool output when an error is found in the 
service template

An error was found in <filename>: Value of <attribute 
name> on component <component name> is not valid in 
this version of the <device> software.
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Customizing how the Nodal Provisioning Template Editor 
starts

Preside Multiservice Data Manager (MDM) provides a set of default files that 
determine how MDM tools start. If required, you can customize the way the 
Nodal Provisioning Template Editor starts. For Nodal Provisioning Template 
Editor, multiple instances of the plug-in can run. You can change the default 
so that only a single instance of the plug-in is permissible. To customize the 
start up, you need to copy the original configuration file provided by MDM 
and then make any required changes to the copy. 

Procedure steps
1 Copy the default application launch configuration files to the appropriate 

directory.

2 Using a UNIX editor, open the copy of the MDMALaunch.cfg file.

If running... Copy the file from... Save the file to...

Toolset /opt/nortel/config/applications/
desktop/local/MDM/launchscripts/
default/MDMALaunch.cfg

/opt/nortel/config/applications/
desktop/local/MDM/launchscripts/
custom/MDMALaunch.cfg

Operator Client /opt/nortel/config/applications/
desktop/jws/MDM/launchscripts/
default/MDMALaunch.cfg

/opt/nortel/config/applications/
desktop/jws/MDM/launchscripts/
custom/MDMALaunch.cfg
241-6001-610   15.1RSUP   



Chapter 9 Nodal Provisioning Template Editor   319
3 Within the file, locate the Nodal Provisioning Template Editor command 
block. See the following sample Nodal Provisioning Template Editor 
command block.

4 Modify the file by changing the parameter Single=”no” to Single=”yes” on 
the line that begins with “Command =”. See the following sample of a 

{

Menutype = MenuBar

Menu/Submenu = Configuration

CommandLabel = Nodal Provisioning Template Editor

CommandType = Plugin

Command = 
Class=“com.nortel.anp.template.gui.ServiceTemplateEditor”, 
Client=“yes”, Single=“no”

SandboxName = NPsteSandbox_<sandbox_id>

SandboxJars = /opt/MagellanNMS/lib/jar/ANPClient.jar
/opt/MagellanNMS/lib/jar/ANPShared.jar 
/opt/MagellanNMS/lib/jar/ANPTemplateIcons.jar 
/opt/MagellanNMS/lib/jar/MdmLib-MftApp.jar 
/opt/MagellanNMS/lib/jar/nmsweb.jar
/opt/MagellanNMS/lib/jar/parser.jar
/opt/MagellanNMS/lib/jar/jaxp.jar
/opt/MagellanNMS/lib/jar/ANPTemplateEditor.jar
/opt/MagelanNMS/lib/mft/pluginJars/applications/SharedJVMApp.jar

}

Nodal 
Provisioning 
Template 
Editor 
command 
block
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customized Nodal Provisioning Template Editor command block. The 
modification is shown in bold font.

5 Save the file.

Modify the 
“Command=” 
line

{

Menutype = MenuBar

Menu/Submenu = Configuration

CommandLabel = Nodal Provisioning Template Editor

CommandType = Plugin

Command = 
Class=“com.nortel.anp.template.gui.ServiceTemplateEditor”, 
Client=“yes”, Single=“yes”

SandboxName = NPsteSandbox_<sandbox_id>

SandboxJars = /opt/MagellanNMS/lib/jar/ANPClient.jar
/opt/MagellanNMS/lib/jar/ANPShared.jar 
/opt/MagellanNMS/lib/jar/ANPTemplateIcons.jar 
/opt/MagellanNMS/lib/jar/MdmLib-MftApp.jar 
/opt/MagellanNMS/lib/jar/nmsweb.jar
/opt/MagellanNMS/lib/jar/parser.jar
/opt/MagellanNMS/lib/jar/jaxp.jar
/opt/MagellanNMS/lib/jar/ANPTemplateEditor.jar
/opt/MagelanNMS/lib/mft/pluginJars/applications/SharedJVMApp.jar

}

241-6001-610   15.1RSUP   



321
Chapter 10
Template Generator

The template generator of the Nodal Provisioning tool enables you to create 
a new template from an existing provisioned component of the connected 
node. The new template can be used to quickly configure other like 
components on the same node and on other nodes of the same type.

Prerequisites to using the template generator
• Nodal Provisioning GUI open in either the component hierarchy or the 

shelf view

Navigation
• “Generate Template From Existing Component dialog” (page 322)

• “Link Solutions Attribute dialog” (page 322)

• “Show template with NPTE option de-selected” (page 324)

• “Starting the template generator” (page 325)

• “Generating a template from an existing component” (page 326)

• “Applying a generated template” (page 327)
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Generate Template From Existing Component dialog
The Generate Template From Existing Component dialog shows the selected 
component in a tree hierarchy with its subcomponents. The subcomponents 
can be expanded to show their subcomponents. This enables you to select or 
deselect the exact subcomponents that you want to include in the generated 
template. You cannot deselect the component that you initially selected in the 
Nodal Provisioning GUI component hierarchy. 

The Show template with NPTE option is selected by default.

Command buttons
Use the command buttons in the Generate Template From Existing 
Component dialog to perform the following operations:

• OK
Click this button to generate the template. 
If there is no link attribute in the selected component and if the Show 
template with NPTE option was de-selected, the template is 
automatically saved. Otherwise the NPTE launches so you can edit the 
template before you save it. 
If there is a link attribute, the template is not immediately generated and 
the Link Attributes Solution dialog opens.

• Cancel
Click this button to cancel the template generator and return to the Nodal 
Provisioning GUI.

• Help
Click this button to launch the information about the dialog.

Link Solutions Attribute dialog
The Link Solutions Attribute dialog opens only if there is a link attribute in 
the component when you click the OK button in the Generate Template from 
Existing Component dialog.

The dialog shows the link attributes for the components you selected in the 
Generate Template From Existing Component dialog. Each link attribute is 
shown with its linked component name. You use this dialog to select the link 
option for each link attribute and its linked component.
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There are three possible link options:

• “Find linked component at run-time” (page 323)

• “Create linked component (and its parent if it has one)” (page 323)

• “Create linked component and find its parent at run-time” (page 323)

Find linked component at run-time
Select this option when you do not want to include the linked component in 
the template. This allows you to find the linked component when you apply 
the template.

Create linked component (and its parent if it has one)
Select this option when you want to include the linked component in the 
template. If the linked component has a parent component, the parent will 
automatically be included in the template. When you apply the template, the 
component and parent are created as new components.

Create linked component and find its parent at run-time
This option is available only if the existing linked component has a parent 
component. Select this option when you want to include the linked 
component in the template as a new component. When you apply the 
template, the component is created and its parent is found.

Command buttons
Use the command buttons in the Link Attributes Solution dialog to perform 
the following operations:

• OK
Click this button to close the Link Attributes Solution dialog. The 
template will be immediately generated and saved unless the Show 
template with NPTE option was selected in the Generate Template 
From Existing Component dialog. Otherwise, the NPTE launches and 
you can edit the template before you save it.

• Cancel
Click this button to cancel the selection of link options and return to the 
Generate Template From Existing Component dialog.

• Help
Click this button to launch the information about the dialog.
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Show template with NPTE option de-selected
If you de-selected the Show template with NPTE option, the template is 
saved automatically when you click OK in either the Generate Template 
From Existing Component or in the Link Attributes Solution dialog. The 
template is saved with a default file name on the server host workstation in 
the directory /opt/MagellanNMS/ANP/EM/Service/UserTemplates.

 The default settings for the generated template are as follows:

• Title is the name of the component

• Author is the user login id

• Icon is default.gif

• Description is a string <Created by <user login id> on <created date> 
based on the view <view name> of Passport node <node name> whose 
Passport software version is <CDL version>. The CDL version is that of 
the current Passport node connected to the Nodal Provisioning tool.

• the component template file name is <user login id>_<component path 
without root>.st

• the template dropsite is set to the parent of the component.

To display the generated template in the Nodal Provisioning main window, 
select Reload templates from the View menu.
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Starting the template generator
Start the template generator from the component hierarchy view or the shelf 
view of the Nodal Provisioning tool.

Prerequisites
• Nodal Provisioning tool is open in either component hierarchy or shelf 

view.

Procedure steps
1 Select the existing component that you want to use to generate a new 

template.

2 From the Nodal Provisioning Selected menu, click Generate Template.

The Generate Template From Existing Component dialog box opens.
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Generating a template from an existing component
Use the template generator to create a template based on an existing 
provisioned component.You can use the template to provision a similar 
component on the node you are connected to, or on another node.

Prerequisites
• Nodal Provisioning tool is open in either the component hierarchy view 

or the shelf view.

Procedure steps
1 Select the existing component that you want to use to generate the 

template.

2 From the Nodal Provisioning Selected menu, click Generate Template.

The Generate Template From Existing Component dialog box opens with 
the component and its first level subcomponents shown in a tree 
hierarchy.

Optionally, de-select the Show template with NPTE option.

3 Optionally, expand a subcomponent to display lower level 
subcomponents. 

4 Optionally, click on the check box beside a subcomponent to select it.

5 Click OK.
If the Link Attributes Solution dialog opens, go to step 6. If the NPTE 
opens, go to step 8. Otherwise, the procedure is complete.

6 For each link attribute and its linked component, select the Link Option 
from the popup menu.

7 Click OK. If the NPTE opens, go to step 8. Otherwise, the procedure is 
complete

8 In the NPTE, edit and save the newly generated template as required. 
See “Creating or modifying service templates task flow” (page 250).
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Applying a generated template
Apply a newly generated template to provision a similar component on the 
same node or on another node.

Prerequisite
• Nodal Provisioning tool is open in either the component hierarchy view 

or the shelf view.

Procedure steps
1 If you have not already done so after you generated the template, select 

Reload templates from the View menu.

2 From the Templates panel, click on User-templates or the directory where 
you have saved the template.

The available templates display as a list of titles.

3 Select the title of the template you created in “Generating a template from 
an existing component” (page 326).

4 Select a parent component to use as the dropsite for the template.

5 Right-click on the template title and select Launch from the popup menu.

6 Create the new component. See “Service template palette” (page 80). 
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Report Generator 

For information on the Report Generator tool, see the following sections

• “Overview” (page 329)

• “Report Generator window” (page 329)

• “Filtering dialog boxes” (page 339)

• “Procedures” (page 344)

Overview
Use the Report Generator to create, compare, and save custom reports on 
component data. Report Generator lets you do the following tasks:

• reorganize the component data 

• filter the component data to create a report on a subset of the data

• export the data in a desired format

• save the data and filters to a file

You can use these reports to record changes to components and services and 
to compare the component data of services. 

Report Generator window
The Component Data panel of the Report Generator window is populated 
with a copy of the component that you selected in the hierarchy tree in the 
Nodal Provisioning main window, and includes the children that are visible in 
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the expanded component hierarchy at the time the Report Generator is 
launched. The corresponding component data is displayed in the Component 
Data panel.

You can choose what data will display in the Component Data panel through 
your selections in the Component Selection panel.You can select and deselect 
components in the Component Selection panel. The tool retrieves the data for 
the selected components and displays the data in the Component Data panel. 
For a list of procedures, see “Manipulating component data” (page 344)

You can filter the component data to create a report on a subset of component 
data. See the sections “Filtering dialog boxes” (page 339) and “Creating a 
component data report on a subset of component data” (page 362).

You can save Report Generator files. You can retrieve the saved file using a 
text editor or spreadsheet. The saved file appears with the title at the head, 
followed by column headers, and the column data. The column data is 
separated by tabs with carriage returns separating the rows. See the section 
“Retrieving saved Report Generator files” (page 364)

You can also save report templates. These templates are saved with the 
extension .rtp. 

For an illustration of the relationship between the expanded component 
hierarchy in the Nodal Provisioning tool main window and the data contained 
in the Report Generator window, see“Report Generator window in relation to 
the selected component in the Nodal Provisioning window” (page 331).
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Figure 15
Report Generator window in relation to the selected component in the Nodal Provisioning 
window

Selected component in the 
Nodal Provisioning window

Data corresponding to the selected 
component and its visible children
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For a description of the parts of the Report Generator window, see the 
following sections:

• “Menu bar” (page 332)

• “Tool bar” (page 337)

• “Title field” (page 338)

• “Component Selection panel” (page 338)

• “Component Data panel” (page 338)

• “Status bar” (page 339)

For related procedures, see “Procedures” (page 344).

Menu bar
 See the following sections for information on the menu bar options:

• “File menu” (page 332)

• “Edit menu” (page 333)

• “View menu” (page 334)

• “Tools menu” (page 335)

• “Selected menu” (page 335)

• “Help menu” (page 337)

File menu
The table “File menu commands” (page 333) describes the commands.
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Edit menu
The table “Edit menu commands” (page 334) describes the menu commands.

Table 31
File menu commands

Menu command Description of menu command Related information

Save Overwrites the current saved file. If this is the first 
time that you have saved the file, the Save 
Report dialog box opens.

“Creating and saving 
service data reports” 
(page 360)

Save As Opens the Save Report dialog box to save a 
new file. Specify a location and filename. Report 
Generator adds the extension.rpt to the report 
file. At a later time, you can open the saved file 
using a text editor.

“Creating and saving 
service data reports” 
(page 360)

Save Report 
Template

Overwrites the current report template file if you 
have already saved. If you have not already 
saved, Save Report Template opens a Save 
Report Template dialog box that lets you save 
the report template as a new file. 

“Saving the report template” 
(page 374)

Save As Report 
Template

Opens a Save Report Template dialog box that 
lets you save the report template as a new file. 
When you save for the first time the tool 
automatically adds the extension .rtp to the 
report template file name.

“Saving the report template” 
(page 374)

Load Report 
Template

Opens a file selection dialog box. Locate the 
report template that you want to open and click 
OK.

“Loading a report template” 
(page 375)

Print Opens a Print dialog box.

Exit Exits the Report Generator. If you have made 
changes a dialog box opens prompting you to 
save your changes.

“Exiting the Report 
Generator” (page 377)
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View menu
The table “View menu commands” (page 335) describes the menu 
commands.

Table 32
Edit menu commands

Menu command Description of menu command Related information

Undo Lets you undo any previous actions, such as 
editing filters, deleting rows, loading templates, 
clearing filters, expanding and compressing 
components, back to the point when the Report 
Generator was launched. The Undo label in the 
edit menu changes to reflect the action being 
undone; for example, Undo Select Component.

“Undoing and Redoing 
actions” (page 347)

Redo Lets you redo previously undone actions. If you 
undo actions and then perform a new action, the 
redo command is disabled. This indicates that 
the previously undone operations have been 
lost. The Redo label in the edit menu changes to 
reflect the action being undone; for example, 
Redo Select Component.

“Undoing and Redoing 
actions” (page 347)

Copy Copies the selected component information from 
the Report Generator window to a clipboard. You 
can open a text editor and paste the copied 
information to a text editor. 

“Copying component data 
reports to a text editor” 
(page 376)

Delete Row(s) Deletes a selected row from the Component 
Data panel.

“Deleting rows in 
component data reports” 
(page 359)

Find Launches a component filter dialog box that lets 
you search for a subset of component 
information. This dialog box works in the same 
manner as the dialog box that opens when you 
select Add/Edit Filter in the Tools menu. 

“Filtering dialog boxes” 
(page 339)

“Creating a component data 
report on a subset of 
component data” 
(page 362)

Select All Select All selects all the visible components in 
the Component Data panel. 

“Selecting all components in 
the Component Data panel” 
(page 358)
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Tools menu
The table “Tools menu commands” (page 335) describes the commands.

Selected menu
The table “Selected menu commands” (page 336) describes the commands.

Note: The Search, Hide, and Hide Children commands are enabled only 
when you select a component in the component hierarchy that has too 
many instances to display. These components are represented by a folder. 

Table 33
View menu commands

Menu command Description of menu command Related information

Toolbar Displays or hides the tool bar “Displaying and hiding the 
tool bar” (page 348)

Statusbar Displays or hides the status bar “Displaying and hiding the 
status bar” (page 349)

Table 34
Tools menu commands

Menu command Description of menu command Related information

Add/Edit Filter Opens the Filter Component Data dialog box. “Creating a component data 
report on a subset of 
component data” 
(page 362)

Save Filter Opens a Save dialog box. Specify a filename 
and location to save the filter. When you save for 
the first time the tool automatically adds the 
extension .ftr to the filter file name.

“Creating a component data 
report on a subset of 
component data” 
(page 362)

Load Filter Load Filter opens a file selection dialog box to 
locate and open a saved filter.

Clear Filter Clears the current filter
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Table 35
Selected menu commands

Menu command Description of menu command Related information

Sort selected 
column

Provide the options to reorganizing component 
data in a selected column in the Component 
Data panel by ascending or descending order.

“Sorting component data” 
(page 350)

Select 
Component

Selects or deselects the currently selected 
component in the component hierarchy.

“Selecting and deselecting 
components in the 
component hierarchy” 
(page 351)

Select All Selects a component and all of its visible children 
in the component hierarchy. The tool retrieves 
the component data and displays it in the 
Component Data panel.

“Selecting all components” 
(page 352)

Clear All Deselects a selected component and all of its 
visible children. The component data is removed 
from the Component Data panel.

“Clearing component data” 
(page 353)

Search Opens the Search dialog box which lets you 
search for component instances or a subset of 
component instances, for large components that 
exceed a pre-defined maximum number of 
instances. You can add a component to the 
component hierarchy. The data for the 
component is retrieved and displayed in the 
Component Data panel. 

“Searching for a component 
in a large instance set” 
(page 126)

Hide Removes the selected child of a folder from the 
component hierarchy in the Component 
Selection panel. 

“Hiding a child in a folder” 
(page 354)

Hide Children Removes all the children for a selected folder 
from the component hierarchy in the Component 
Selection panel.

“Hiding all children in a 
folder” (page 355)

Expand/Collapse Expands or collapses the selected component to 
show or hide its children.

“Expanding or collapsing a 
component and its children” 
(page 356)

Expand All Expands the selected component and all its 
children.

“Expanding a component 
and its children” (page 357)
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Help menu
The table “Help menu commands” (page 337) describe the commands.

Tool bar
The tool bar contains the following icons:

• save icon
The save icon saves the report. If you have already saved the file, 
selecting Save overwrites the current saved version. If this is the first time 
that you have saved the file, the Save dialog box opens. 

• exit icon
The exit icon closes the Report Generator tool.

• search icon
The search icon opens the Component Data dialog box. See “Filtering 
dialog boxes” (page 339).

• copy icon
The copy icon copies selected data to a clipboard.

• delete row(s) icon
The delete row(s) icon deletes a selected row of data in the Report 
Generator.

• undo icon
The undo icon lets you undo previous actions.

Note: The undo text tool tips change to reflect the action being undone; 
for example, Undo Select Component.

Table 36
Help menu commands

Menu command Description of menu command Related information

On Help Opens information on using help. “Help options” (page 35)

On Window Opens the online documentation for the Report 
Generator window.

“Displaying help on the 
Nodal Provisioning window” 
(page 145)

About Report 
Generator

Provides the Report Generator version and 
copyright information.
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• redo icon
The redo icon lets you redo previous actions.

Note: The redo text tool tips change to reflect the action being undone; 
for example, Redo Select Component.

Title field
The Title field displays a default title. You can edit this field and enter your 
own title to be added to the saved file.

Component Selection panel
The component selection panel displays a copy of the component that you 
have selected in the Nodal Provisioning tool window, and any visible children 
at the time that you opened the Report Generator window. 

When you select a component in the Component Selection panel, you can 
perform the following actions by either selecting commands from the pop-up 
menu or from the Selected menu:

Note: the Search, Hide, and Hide Children commands are enabled only 
for folders.

• select a component

• select all components in the hierarchy tree

• clear all components in the hierarchy tree

• search for component instances

• hide a child

• hide all children

• expand or collapse a selected component 

• expand the selected component and all its children 

Component Data panel
The component data panel displays the data for the selected component and, 
if the component hierarchy is expanded, the data for the visible children. It 
provides a list of components, their attributes and their values. 
241-6001-610   15.1RSUP   



Chapter 11 Report Generator   339
The Component Data panel has a pop-up menu that contains the following 
commands:

• Copy copies the component data for the component that you have 
selected in the Component Data panel

• Delete deletes the rows that you have selected in the Component Data 
panel

• Select All selects all the contents of the Component Data panel.

• Sort provides the following options to sort the components:

— Ascending

— Descending

Status bar
The status bar is found at the bottom of the Report Generator window. It 
shows the filename and the date and time of the last save.

Filtering dialog boxes
A filtering dialog box opens when you select Add/Edit Filter from the Tools 
menu, or Find from the Edit menu, in the Report Generator window. 

All the data for the selected component and its visible children are displayed 
in the Report Generator window. The filtering dialog box lets you specify 
criteria to filter component data. You can specify one or more filters 
(compound filter) and subfilters.

You can save your filters to file and open the saved filter at a later time.

For an illustration of the filtering dialog box that opens when you select Add/
Edit Filter in the Tools menu see the figure “Filter dialog box for a simple 
filter” (page 340). This illustration shows the Filter Component Data dialog 
box for a simple filter. 
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Figure 16
Filter dialog box for a simple filter

For an illustration of the Filter Component Data dialog box for a compound 
filter, see “Filter dialog box for a compound filter” (page 340).

Figure 17
Filter dialog box for a compound filter
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You can further refine the subset of data by apply a sub filter. For an 
illustration of a compound filter with a subfilters, see “Compound filter 
showing a sub-filter” (page 341).

Figure 18
Compound filter showing a sub-filter

For a description of the parts of the Filter Component Data dialog box, see the 
following sections:

• “Fields” (page 342)

• “Find” (page 342)

• “Matching criteria buttons” (page 342)

• “Add Sub Filter command button” (page 342)
Preside MDM Nodal Provisioning User Guide   15.1RSUP



342   Chapter 11 Report Generator
• “Command buttons” (page 343)

Note: The Fields drop down list, Find field, matching criteria buttons and 
Add Subfilters buttons are repeated in each filter and sub filter.

For the procedures to display a subset of component data by using filters, see 
“Creating a component data report on a subset of component data” 
(page 362).

Fields
Use the Fields drop down list to select the field on which you want to search. 
You have the following options:

• All searches in all fields. When you open the Find Component Data 
dialog box, All is the default. 

• Component searches in the Component field.

• Name searches in the Name field

• Value searches in the Value field

Find
In the Find field enter a find string to match the subset of data that you want 
to find. 

Matching criteria buttons
The following check boxes let you customize your search:

• Match Case lets you select or deselect the option to search for an item 
with specific capitalization.

• Match Whole Word lets you match on a complete word. Enter a word 
in the Find field and select Match Whole Word.

Add Sub Filter command button
The Add Sub Filter command button lets you search for a subset of the data 
generated by the filter.
241-6001-610   15.1RSUP   



Chapter 11 Report Generator   343
Command buttons
The Find Component Data dialog box contains the following command 
buttons:

• OK completes the search. The Filter Component Data dialog box closes. 
The Report Generator window displays the results of the search.

• Apply apply the search. The Filter Component Data dialog box remains 
open. The Report Generator window displays the results of the search.

• Cancel cancels the search. The Filter Component Data dialog box closes 
and you return to the Report Generator window.

• Add Filter expands the Filter component data dialog box to add another 
filter to the data.

• Help accesses the online help information for the Filter Component Data 
dialog box.
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Procedures 
Note: The procedures in this section apply to the Toolset and Operator 
Client environments, unless otherwise specified.

This section contains the following procedures: 

Basics
• “Starting the Report Generator” (page 346)

• “Exiting the Report Generator” (page 377)

• “Undoing and Redoing actions” (page 347)

• “Displaying and hiding the tool bar” (page 348)

• “Displaying and hiding the status bar” (page 349)

• “Sorting component data” (page 350)

• “Selecting and deselecting components in the component hierarchy” 
(page 351)

• “Selecting all components” (page 352)

• “Clearing component data” (page 353)

• “Hiding a child in a folder” (page 354)

• “Creating a component data report on a subset of component data” 
(page 362)

• “Retrieving saved Report Generator files” (page 364)

• “Saving the report template” (page 374)

• “Loading a report template” (page 375)

• “Copying component data reports to a text editor” (page 376)

Manipulating component data
• “Sorting component data” (page 350)

• “Selecting and deselecting components in the component hierarchy” 
(page 351)

• “Selecting all components” (page 352)
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• “Clearing component data” (page 353)

• “Hiding a child in a folder” (page 354)

• “Hiding all children in a folder” (page 355)

• “Expanding or collapsing a component and its children” (page 356)

• “Expanding a component and its children” (page 357)

• “Selecting all components in the Component Data panel” (page 358)

• “Deleting rows in component data reports” (page 359)

• “Copying component data reports to a text editor” (page 376)

Working with data reports
• “Creating and saving service data reports” (page 360)

• “Creating a component data report on a subset of component data” 
(page 362)

• “Copying component data reports to a text editor” (page 376)

• “Retrieving saved Report Generator files” (page 364)

• “Example” (page 366)

Report templates
• “Saving the report template” (page 374)

• “Loading a report template” (page 375)
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Starting the Report Generator
Use this procedure to start the Report Generator from the Nodal Provisioning 
window.

Prerequisites
The following conditions must exist:

• You have started Nodal Provisioning. See the section “Starting Nodal 
Provisioning” (page 37).

•  you are connected to the Passport device. See “Starting Nodal 
Provisioning” (page 37)

Procedure steps
1 In the Nodal Provisioning window, select a valid component in the 

component hierarchy.

Note:  A folder is not a valid component.

2 Select one of the following steps:

• On the selected component, right-click and from the pop-up menu, 
select Generate Report.

• In the Nodal Provisioning window, select Selected -> Generate 
Report.

The Report Generator window opens.
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Undoing and Redoing actions
You can undo and redo previous actions. The Undo and Redo command 
toggle depending on your last command. 

You can undo any previous actions, such as editing filters, deleting rows, 
loading templates, clearing filters, expanding and compressing components 
to the point that you started Report Generator. The Undo label in the Edit 
menu, is dynamic, that is, it reflects the action being undone.

The Redo command lets you redo previously undone actions. The Redo label 
in the Edit menu, is dynamic, that is, it reflects the action being undone. If you 
undo actions and then perform a new action, the Redo command is disabled. 
This indicates that the previously undone actions have been lost.

Procedure steps
1 To undo an action, on the Edit menu, click Undo….

The previous action is undone. For example, if your last action was to 
select a component, the Undo command is labelled as Undo Selected 
Component.

2 To redo an action, on the Edit menu, click Redo….

The previous Undo action is undone. For example, if your last action was 
to Undo Selected Component, the Redo command is labelled as Redo 
reSelected Component.
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Displaying and hiding the tool bar
Use this command to display or hide the Report Generator tool bar.

Procedure steps
1 From the View menu in Report Generator, select Toolbar.

If the tool bar is displayed, it is hidden.

If the tool bar is hidden, it becomes visible.
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Displaying and hiding the status bar
Use this procedure to display or hide the Report Generator status bar.

Procedure steps
1 From the View menu in Report Generator, select Statusbar.

If the status bar is displayed, it is hidden.

If the status bar is hidden, it becomes visible.
Preside MDM Nodal Provisioning User Guide   15.1RSUP



350   Chapter 11 Report Generator
Sorting component data
Use this procedure to reorganize component data for a selected column in 
ascending or descending order.

Procedure steps
1 In the Component Data panel, select the column that you want to sort. 

You can select the Component, Name or Value column.

2 If you want to sort the column data in ascending order, in the Selected 
menu, select Sort selected column -> Ascending 

If you want to sort the column data in descending order, in the Selected 
menu, select Sort selected column -> Descending.

The data is sorted in the columns in the specified manner.
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Selecting and deselecting components in the component 
hierarchy

You can select and deselect a component data in the component hierarchy. 

Procedure steps
1 Select the component in the component hierarchy

2  From the Selected menu, select Select Component.

The component is checked in the component hierarchy to indicate that it 
is selected.

Deselecting the component removes the check.
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Selecting all components 
Use this procedure to select a component and all its subcomponents.

Procedure steps
1 In the component hierarchy, select the component.

2 complete one of the following steps:

• From the Selected menu, select Select All.

• From the component’s pop-up menu, select Select All.

The component and all its visible children are selected in the component 
hierarchy and the component data for the component and its children are 
retrieved and displayed in the Component Data panel.
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Clearing component data
Use this procedure to clear all component data from the Component Data 
panel.

Procedure steps
1 In the Component Selection panel, select the component that you want 

to clear.

2 Complete one of the following steps:

• From the Selected menu, select Clear All.

• right-click on the component and from the pop-up menu, select Clear 
All.

The selected component and its visible children are deselected in the 
Component Selection panel and the components’ data is cleared from the 
Component Data panel.
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Hiding a child in a folder
Use this procedure to remove a selected child component from a folder in the 
component hierarchy in the Component Selection panel. 

Procedure steps
1 In the component hierarchy, select the folder containing the child 

component.that you want to hide.

2 From the Selected menu, select Hide.

The selected child component is removed from the component hierarchy 
in the Component Selection panel.
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Hiding all children in a folder
Use this procedure to remove all child components of a folder from view in 
the component hierarchy in the Component Selection panel. 

Procedure steps
1 In the component hierarchy, select the folder containing the children that 

you want to hide.

2 From the Selected menu, select Hide Children.

All child components of the folder are removed from the component 
hierarchy in the Component Selection panel.
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Expanding or collapsing a component and its children
Use this procedure to expand or collapse the view of all the subcomponents 
of a component.

Procedure steps
1 Select the component that you want to expand or collapse.

2 Complete one of the following steps:

• From the Selected menu, select Expand/Collapse.

• Right-click on the component and from the pop-up menu, select 
Expand/Collapse.

The selected component and all its children are expanded or collapsed to 
show or hide its children in the component hierarchy.
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Expanding a component and its children
Use this procedure to expend a component in the component hierarchy.

Procedure steps
1 Complete one of the following steps:

• From the Selected menu, select Expand All.

• Right-click on the component and from the pop-up menu, select 
Expand All.

The selected component and all its child components are expanded in the 
component hierarchy.
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Selecting all components in the Component Data panel
You can select all the component data in the Component Data panel. You can 
then copy or delete the selected data.

Procedure steps
1 From the Edit menu, select Select All.

All the visible components in the Component Selection panel are 
selected and displayed in the Component Data panel.
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Deleting rows in component data reports 
Use this procedure to delete data from the component data reports.

Procedure steps
1 In the Component Data panel, select the row, or rows, that you want to 

delete.

2 From the Edit menu, select Delete Row(s) or use the delete icon in the 
toolbar. 

The selected row, or rows, of data is removed from the Component Data 
panel.
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Creating and saving service data reports
Use this procedure to create and save a report on a selected component in the 
component hierarchy.

Procedure steps
1 In the Nodal Provisioning window, expand the component hierarchy to 

display the children that you want to report on.

2 Right-click on any valid component in the component hierarchy.

Note:  Folders are not valid components.

3 Complete one of the following steps:

• From the View menu, select Generate Report.

• right-click on the component and from the pop-up menu, select 
Generate Report.

The Report Generator window opens, and shows the component and its 
visible subcomponents and their attributes and values.

4 Change the file title, if desired.

5 Adjust the report, as desired:

If you wish to create a report on a subset of the data, in the Tools menu, 
select Add/Edit Filter. This opens the Filter Component Data dialog 
box. For the procedure to select a subset of the data, see “Creating a 
component data report on a subset of component data” (page 362).

6 From the File menu, select Save.

If you have not previously saved the file, the Save Report dialog box 
opens allowing you to select or specify the file name to save the report as. 

If you want to specify a different file name, or if you are saving for the first 
time, select Save As from the File menu. The Save Report dialog box 
opens. Specify a location and provide a filename for the report and then 
select Save to save the file to the specified location.

Select Cancel to return to the Report Generator window without saving.

The report is saved with the .rpt extension.

7 From the File menu, select Exit to close the Report Generator window.

If you have changed the report data, a dialog box opens asking you if you 
want to save the changes.

Click Yes to save the changes.
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Click Cancel to return to the Report Generator window.

8 Select Save As to open a Save Report dialog box.

9 Specify a location and enter a file name for the report.

10 Click Save.

The report is saved to the specified location with the extension .rpt.
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Creating a component data report on a subset of 
component data

Use this procedure to filter component data to create a report on a subset of 
component data.

Procedure steps
1 Start the Report Generator. See “Starting the Report Generator” 

(page 346).

2 To open the Filter Component Data dialog box, do one of the following:

• From the Tools menu of the Report Generator window, select Add/
Edit Filter.

• From the Edit menu of the Report Generator window, select Find.

The Filter Component Data dialog box opens.

3 From the Fields drop down list, select the field on which you wish to 
perform a search. You options are All, Component, Name, or Value.

Note:  The fields drop down list corresponds to the columns in the Report 
Generator spreadsheet.

4 In the Find field, enter a find string.

To restrict the search to match the capitalization in the find string, select 
Match Case.

To restrict the search to match the whole word, select Match Whole 
Word.

5 If this completes your search, click OK to close the Find Component 
Data dialog box. The data matching the search criteria appear in the 
Report Generator window.

Click Apply to apply the search without closing the Find Component 
Data dialog box. You can continue to add filters for your search.

If you want to cancel the search, click Cancel. This action closes the Find 
Component Data dialog box.

If you want to search for a subset of the component data, click Add 
Subfilter. The Filter Component Data dialog box expands to add 
another filter panel labelled as Filter 2 sub-filter of Filter 1. Repeat steps 
3 to 5 for the subfilter.
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If you want to add another filter Click Add Filter. This expands the Filter 
Component dialog box to add another filter, labelled as Filter 2. Repeat 
steps 3 to 5.
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Retrieving saved Report Generator files
Use this procedure to retrieve Report Generator files using a text editor or 
spreadsheet.

Procedure steps
1 Open a text editor.

2 Select the file that you want to retrieve.

For an illustration of the saved file that is retrieved using a text editor, see 
“Saved Report Generator file” (page 365).
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Figure 19
Saved Report Generator file
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Example
The following example assumes that you wish to find the following subset of 
component data for the FrUni/1:

• all the dna data containing out in the data name

• all the Ca data containing bandwidth in the data name.

1  In Nodal Provisioning window, select FrUni/1.

2 Open the Report Generator. See see “Starting the Report Generator” 
(page 346)
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3 In the Component Selection panel of the Report Generator window, 
select FrUni/1.

4 the Tools menu in the Report Generator window, select Add/Edit Filter.

5 In the Filter 1 area, do the following:
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a. In the Fields drop down list, select Component.

b. In the Find field, enter Dna

c. If desired, select a matching case.

The Report Generator window shows all the FrUni/1 Dna components.

6 In the Filter Component Data (Filter 1), select Add Sub Filter.

The Filter Component Data dialog box expands to add another filter 
panel (Filter 2 with subfilter of Filter 1).
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7 In the Filter 2 sub-filter of Filter 1 panel, do the following:

a. In the Fields drop down list, select Name

b. In the Find field, enter out

c. If desired, select a matching case.

The Component Data panel shows the FrUni/1 Dna components with the 
Name out.

8 Select Add Filter.

The Find Component Filter dialog box expands to show another Filter 
panel (Filter 3)
Preside MDM Nodal Provisioning User Guide   15.1RSUP



370   Chapter 11 Report Generator
9 In the Filter 3 panel, do the following:

a. in the Fields drop down list, select Component

b. in the Find field, Ca
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c. if desired, select Match Case.

The Component Data panel now shows the FrUni/1 Dna 
components with the name out and all the Ca components.
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10 In the Filter 3 section, select Add Sub Filter.

The Find Component Filter dialog box expands to show another Filter 
panel (Filter 4 Sub Filter of Filter 3)

11 In the panel, do the following:

a. in the Fields drop down list, select Value

b. in the Find field, 1000

c. if desired, select a Matching Case

The Component Data panel now shows the FrUni/1 Dna 
components with the name out and all the Ca components with the 
value 1000.
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Saving the report template
Use this procedure to save the report template.

Procedure steps
1 If you have previously saved the report template, from the File menu, 

select Save Report Template.

If this is the first time that you save the report template, from the File 
menu, select Save As Report Template. A Save Report Template 
dialog box opens. Proceed to step 2.

2 In the save dialog box, select a location and specify a file name for the 
report template.

3 Click Save.

The report template is saved to the specified location with the file 
extension rtp.
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Loading a report template 
Use this procedure to retrieve a saved report template.

Procedure steps
1 From the File menu, select Load Report Template.

A Load Report Template file browser dialog box opens.

2 Select the file that you want to retrieve.

3 Click OK.

The saved report template is retrieved.
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Copying component data reports to a text editor
Use this procedure to copy some or all component data displayed in the 
Report Generator window to a text editor.

Procedure steps
1 Edit the service data report contained in the Report Generator window, 

as desired. 

2 In the Edit menu, of the Report Generator window, select Select All if 
you want to copy all the data contained in the report. 

If you only want to copy a subset of the data, select the rows that you want 
to copy.

3 In the Edit menu, select Copy.
The selected data are copied to a clipboard.

4 Open a text editor.

5 In the Edit menu, select Paste.

The selected component data appear in the text editor.
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Exiting the Report Generator
Use this procedure to close the Report Generator tool.

Procedure steps
1 In the Report Generator window, select File -> Exit.

The Report Generator window closes.
Preside MDM Nodal Provisioning User Guide   15.1RSUP



378   Chapter 11 Report Generator
241-6001-610   15.1RSUP   



379
Chapter 12
Embedded Nodal Provisioning

This section describes the Preside Multiservice Data Manager Embedded 
Nodal Provisioning application and how to use it. It contains the following 
sections:

• “Tool fundamentals” (page 379)

• “Embedded Nodal Provisioning window” (page 390)

• “Embedded Nodal Provisioning dialog boxes” (page 409)

• “Procedures” (page 410)

Tool fundamentals
Embedded Nodal Provisioning is embedded within a selection of other MDM 
tools such as Passport Shelf View and MPE Shelf View and provides a subset 
of Nodal Provisioning capabilities. The Embedded Nodal Provisioning tool is 
intended for small and discrete provisioning changes to a small number of 
Passport or Nortel Networks Multiservice Provider Edge (MPE) components.

Both Passport and MPE Shelf View are diagnostic tools that let you 
troubleshoot problems in real time. You access Embedded Nodal 
Provisioning from within these Shelf View tools to resolve any number of 
discrete problems. Using Embedded Nodal Provisioning, you define the 
required provisioning tasks and the order in which these tasks are to be 
applied. The provisioning changes that you make from Embedded Nodal 
Provisioning are reflected in the Shelf View tools when the tasks have been 
successfully applied. Provisioning tasks are always performed on the Passport 
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current view or MPE candidate configuration. If required, from Embedded 
Nodal Provisioning you can start Nodal Provisioning and the service 
provisioning tools.

Embedded Nodal Provisioning supports the following series of devices:

• Passport 6400

• Passport 7400

• Passport 15000

• Passport 20000

• MPE 9500

If you need to navigate and provision a large number of components or a 
variety of Passport views or MPE configurations, use Nodal Provisioning 
instead of Embedded Nodal Provisioning. Nodal Provisioning uploads the 
entire view file at startup resulting in quicker component access whereas 
Embedded Nodal Provisioning uploads one component at a time. Nodal 
Provisioning automatically retrieves possible values for link attributes 
whereas Embedded Nodal Provisioning does not. You need to search for these 
link values. This search may be slow because the entire view is not loaded.

The following sections describe the provisioning capabilities of Embedded 
Nodal Provisioning in greater detail:

• “Passport Embedded Nodal Provisioning overview” (page 381)

• “MPE Embedded Nodal Provisioning overview” (page 381)

• “Provisioning tasks” (page 382)

• “Provisioning actions” (page 383)

• “Task Application overview” (page 384)

• “User preferences” (page 388)

• “User logs” (page 388)

• “Service selection” (page 389)

• “Related information” (page 389)
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Passport Embedded Nodal Provisioning overview
Embedded Nodal Provisioning permits simultaneous provisioning tasks on a 
Passport device. Provisioning through Embedded Nodal Provisioning does 
not reserve the provisioning session until you apply a task. Multiple users can 
initiate the provisioning and application processes on-switch, even if they 
have not secured the provisioning session on-switch. This capability is 
achieved by the queueing of provisioning requests. These requests are 
processed serially on a first-come-first-served basis. Automatic provisioning 
session retry ensures that you do not have to intervene to have your request 
processed and you can move on to the next provisioning task while your 
previous tasks, or tasks from another user, are being applied.

The Embedded Nodal Provisioning session secures the on-switch 
provisioning session when you apply a provisioning change. If the 
provisioning session is available when the request is issued, the apply 
operation proceeds. If the provisioning session is unavailable, the task 
periodically tries to obtain the provisioning session. You can configure the 
retry period in the Nodal Provisioning Server Administration tool. See 
241-6001-303 Preside MDM Administrator Guide. 

You can cancel the application of a provisioning task at any time while the 
automatic provisioning session retry is ongoing. 

Note: Embedded Nodal Provisioning does not notify you if the current 
view has changed between the time you start a provisioning task and the 
time you apply the provisioning task. It also does not identify or resolve 
conflicts caused by more than one person trying to initiate provisioning 
or application processes on-switch at the same time. Such conflicts may 
occur when more than one person makes incompatible changes to the 
same components. Conflict checking and identification is done through 
the Passport semantic checks, and you must manually resolve the 
conflict.

MPE Embedded Nodal Provisioning overview
The configuration data currently running on the MPE is the running 
configuration. When you make provisioning changes, the changes are made 
to a candidate configuration. This configuration is the collection of 
configuration changes against the running configuration. The candidate 
configuration is not made part of the running configuration until it is 
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semantically correct, free of conflicts, and a commit operation has been 
performed. The commit operation first saves a copy of the unmodified 
running configuration to disk with a unique filename and then merges all the 
candidate configuration changes to create a new running configuration. This 
method lets you rollback to previous configurations, if required. 

You have the option of specifying a confirm option for the commit 
operation.With the confirm option in effect, whenever you commit a 
configuration, a timer is started. If a confirmation of the new running 
configuration is not specified within the specified time frame, a rollback to the 
previously working configuration occurs. This option is useful for protecting 
against configuration changes that may cause a loss of connectivity.

Provisioning tasks
Embedded Nodal Provisioning arranges the provisioning actions that you 
require into tasks. You manage the selection of actions that comprise each 
provisioning task by such activities as adding, deleting, and reordering the 
actions. 

Embedded Nodal Provisioning supports the following provisioning actions:

• adding a subcomponents

• changing a component

• deleting a component 

• applying a service template

You can access these provisioning actions from the Shelf View tools or from 
the Embedded Nodal Provisioning tool. When you access these actions from 
the Shelf View tools, the Embedded Nodal Provisioning window 
automatically opens. If the Embedded Nodal Provisioning window is already 
open, it becomes the active window. Once the Embedded Nodal Provisioning 
window is open, you can also access the provisioning actions directly from 
the Embedded Nodal Provisioning window.

Embedded Nodal Provisioning uses the same component creation, 
component edit, and service creation forms as are used by Nodal 
Provisioning.
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Provisioning actions 
You can add a new provisioning action from the Passport and Nortel 
Networks Multiservice Provider Edge (MPE) Shelf View tools or from the 
Embedded Nodal Provisioning tool.

To add a provisioning action from the Shelf View tools

• Select a component and a provisioning action. The action and component 
are added to the Provisioning Tasks panel in the Embedded Nodal 
Provisioning window according to the following rules:

— If the Embedded Nodal Provisioning window is not already open, or 
if there are not tasks in the Provisioning Tasks panel, the action is 
added as a new task with an automatically generated name.

— If there is only one task in the Provisioning Tasks panel, the action 
is added to that task.

— If there is more than one task in the Provisioning Tasks panel, a 
dialog box prompts you to specify the task to which the action is to 
be added.

To add a provisioning action from the Embedded Nodal Provisioning tool

• Use the New Action command when the Embedded Nodal Provisioning 
tool is already open. The action and component are added to the 
Provisioning Tasks panel according to the following rules

— If there is only one task in the Provisioning Tasks panel, the action 
is added to that task.

— If there is more than one task in the Provisioning Tasks panel, a 
dialog box prompts you to specify the task to which the action is to 
be added.

Managing provisioning actions 
See the following procedures for managing provisioning actions:

• “Adding a subcomponent using the Shelf View tools” (page 416)

• “Adding a subcomponent using Embedded Nodal Provisioning” 
(page 419)

• “Modifying a component using the Shelf View tools” (page 422)
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• “Modifying a component using Embedded Nodal Provisioning” 
(page 423)

• “Refreshing a component modification form” (page 425)

• “Deleting a component using the Shelf View tools” (page 426)

• “Deleting a component using Embedded Nodal Provisioning” 
(page 427)

• “Applying a service template using the Shelf View tools” (page 429)

• “Applying a service template using Embedded Nodal Provisioning” 
(page 431)

• “Linking a new service to a new port” (page 439)

Task Application overview 
The following sections describe the various scenarios that may occur after 
you have applied the provisioning changes:

• “When a node’s provisioning session is available” (page 384)

• “When the node’s provisioning session is in use” (page 385)

• “When a task or action fails” (page 386)

• “When a service creation fails” (page 387)

The following section lists the procedures for tasks:

• “Managing provisioning tasks” (page 388)

When a node’s provisioning session is available
The following events occur after you apply a task and the node’s provisioning 
session is unavailable to you. 

1 The task icon changes to indicate that the task is being applied.

2 The task is placed at the top of the Task Application Queue, and its status 
changes to “Application in progress”.

3 A provisioning session opens. 
For Passport, an edit view is created from the current view. For MPE, a 
candidate configuration is created from the running configuration.
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4 The provisioning actions in the task are applied in sequential order. Each 
action is logged in the Task Details panel.

5 The semantic check is done to verify that the provisioning details are 
valid. The results of the semantic check are logged to the Task Details 
panel.

6 The Passport edit view is activated or the MPE candidate configuration 
is committed.

7 The activation or commit operation is confirmed.

8 The task icon changes to indicate that the task has been applied.

9 The task is removed from the Task Application Queue.

When the node’s provisioning session is in use
The following events occur after you apply a task and the node’s provisioning 
session is in use. When this situation occurs, the task application enters retry 
mode:

1 The task icon changes to indicate that the task is pending application.

2 The task is placed at the end of the Task Application Queue, and its status 
changes to “Waiting for provisioning session”.

3 The task tries to obtain the node provisioning session based on the 
configured Retry interval. The default is every minute. This is logged in 
the Task Details panel.

4 When the provisioning session becomes available, the task obtains the 
provisioning session. 

5 The task moves to the top of the Task Application Queue, and its status 
changes to “Application in progress”.

6 A provisioning session opens. For Passport, an edit view is created from 
the current view. For MPE, a candidate configuration is created from the 
running configuration.

7 The provisioning actions in the task are applied in sequential order. Each 
action is logged in the Task Details panel.

8 The semantic check is done to verify that the provisioning details are 
valid. The results of the semantic check are logged to the Task Details 
panel.
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9 The Passport edit view is activated or the MPE candidate configuration 
is committed.

10 The activation or commit operation is confirmed.

11 The task icon changes to the Completed icon.

12 The task is removed from the Task Application Queue.

When a task or action fails
1 The task icon changes to indicate that the task is being applied.

2 The task is placed at the top of the Task Application Queue, and its status 
changes to “Application in progress”.

3 The provisioning session is reserved. For Passport, an edit view is created 
from the current view. For MPE, a candidate configuration is created 
from the running configuration.

4 The provisioning actions in the task are applied in sequential order. Each 
action is logged in the Task Details panel.

5 The task icon changes to indicate an error has occurred.

6 The task is removed from the Task Application Queue.

7 The error message displays. You can retain the provisioning session 
while errors are repaired or release the provisioning session. 

8 If you retain the provisioning session, the Application Error dialog box 
opens. Acknowledge the error and cancel other task applications, or leave 
the Task Application Queue unchanged. The Task Application Error 
dialog box closes.

9 Resolve the problem and apply the task again. If the Check Prov has 
failed, see the next step.

10 The Check Prov of a component creation task can fail in some cases. 
Normally, a node adds subcomponents with a default set of attributes and 
you are not required to perform any other task if the default attributes are 
acceptable. In some cases, though, (for example, FRUNI on a Passport), 
the Check Prov fails because of missing or invalid information set by the 
node when the subcomponent is added (for example, in the case of 
FRUNI, the FRUNI DNA (DataNetwork Address and the FRUNI 
FRAMER interfaceName attribute must be set).
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Resolve the problem with one of the procedures below if it fits this situation:

• Modify the existing task
Create a new action within the task for the component that caused the 
error and change the values for the attributes. Apply the task.

• Use a service template, if available, for creating the component.
Create a new task. Apply the appropriate service template to the 
component and enter the attribute values. Apply the task. 

When a service creation fails
1 The task icon changes to indicate that the task is being applied.

2 The task is placed at the top of the Task Application Queue, and its status 
changes to “Application in progress”.

3 The provisioning session is reserved. For Passport, an edit view is created 
from the current view. For MPE, a candidate configuration is created 
from the running configuration.

4 The provisioning actions in the task are applied in sequential order. Each 
action is logged in the Task Details panel.

5 A service creation fails. The error is logged in the Task Details panel.

6 The Service Creation Errors dialog box opens. If this window is open for 
more than 3 minutes, you are prompted to confirm that you wish to 
continue holding the provisioning session. If you do not respond, the task 
icon changes to indicate an error, the task is removed from the Task 
Application Queue, and the provisioning session is released. You are 
prompted to determine if you want to cancel other pending applications.

7 If you select the accept or delete all options, the task application 
continues.

8 If you select the cancel option, the Service Creation Errors dialog box 
closes, the task icon changes to indicate an error, the task is removed 
from the Task Application Queue, and the provisioning session is 
released. You are prompted to determine if you want to cancel other 
pending applications. 

9 If you select the repair option, the Service Creation Errors dialog closes. 
A repair dialog opens in which you can modify the service values that 
were involved in the service creation failure. If the repair dialog remains 
open for more than 3 minutes, you are prompted to confirm hat you wish 
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to continue holding the provisioning session. If you do not respond, the 
task icon changes to indicate an error, the task is removed from the Task 
Application Queue, and the provisioning session is released. You are 
prompted to determine if you want to cancel other pending applications.

Managing provisioning tasks
See the following procedures for managing provisioning tasks:

• “Applying a task” (page 454)

• “Applying a task without sufficient provisioning privileges” (page 455)

• “Setting user preferences for Embedded Nodal Provisioning” (page 456)

• “Applying provisioning changes” (page 462)

• “Viewing the Task Application Queue” (page 463)

• “Viewing the state of the provisioning session” (page 464)

• “Canceling the application of a single provisioning task” (page 465)

• “Canceling the application of multiple provisioning tasks” (page 466)

User preferences
Preside Multiservice Data Manager provides default preferences for 
Embedded Nodal Provisioning. You can override these values to establish 
your own preferences for activities such as opening, saving, and activating or 
committing a view.

To set user preferences, see

• “Setting user preferences for Embedded Nodal Provisioning” (page 456)

User logs
User logs for Embedded Nodal Provisioning are collected to capture the 
following information during each session:

• the start of the provisioning session

• the name of each action against the current view when a task is applied

• semantic check results

• activation or commit results
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• end of provisioning session

User logs for both the Toolset and Operator Client environments are stored in 
the file $HOME /.nortel_desktop/logs/MDM/ENP.

The type of information captured in the log file is similar to the status 
information that displays during an apply operation.

Service selection
Embedded Nodal Provisioning uses service selection to determine which 
configuration management (CONFIGMAN) server it communicates with. 
For details, see “Service selection” (page 28).

Related information
For more information about 

• Passport or MPE Shelf View tools, see 241-6001-011 Preside MDM 
Fault Management User Guide

• service provisioning tools, see 

— 241-6001-600 Preside MDM Service Provisioning for ATM User 
Guide

— 241-6001-616 Preside MDM IP VPN Service Configuration User 
Guide

— 241-6001-603 Preside MDM Service Provisioning for Frame Relay 
User Guide

• Nodal Provisioning component creation, component edit, and service 
creation forms, see 241-6001-610 Preside MDM Nodal Provisioning 
User Guide
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Embedded Nodal Provisioning window
Embedded Nodal Provisioning lets you provision the device viewed in the 
Passport or Nortel Networks Multiservice Provider Edge (MPE) Shelf View 
tool. Each instance of the Shelf View opens one instance of Embedded Nodal 
Provisioning for provisioning purposes.

The Embedded Nodal Provisioning window contains the following items:

• “Menu bar” (page 391)

• “Provisioning Tasks panel” (page 398)

• “Provisioning forms panel” (page 401)

• “Task Application Queue panel” (page 408)

• “Status bar” (page 408)

For an illustration of the Embedded Nodal Provisioning window, see the 
figure “Embedded Nodal Provisioning window” (page 391).
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Figure 20
Embedded Nodal Provisioning window

Menu bar
The Embedded Nodal Provisioning menu bar contains the following menus:

• “File menu” (page 392)

• “Edit menu” (page 392)

• “Task menu” (page 393)

• “Action menu” (page 395)

• “View menu” (page 396)

Menu bar

Provisioning 
Tasks 
panel

Task 
Application 
Queue 
panel

Status bar

When an action is selected, the associated form displays 
When a task is selected the task details display
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• “Tools menu” (page 397)

• “Help menu” (page 398)

Each task and provisioning action in the Provisioning Tasks panel, has a pop-
up menu that contains commands that correspond to those contained in the 
Task and Action menus.

File menu
The table “File menu commands” (page 392) describes the menu commands.

Edit menu
The table “Edit menu commands” (page 392) describes the menu commands.

Table 37
File menu commands

Command Description Related information

Exit Exits the provisioning window. If you have not 
completed some tasks, a confirmation dialog box 
prompts for confirmation. If there is a task 
currently being applied on the device, the Exit 
command is disabled.

“Exiting Embedded Nodal 
Provisioning” (page 415)

Table 38
Edit menu commands

Command Description Related information

Cut Cuts the selected text.

Copy Copies the selected text.

Paste Pastes the copied text.

Options... Opens a dialog box to set the options for 
Embedded Nodal Provisioning.

“Setting user preferences 
for Embedded Nodal 
Provisioning” (page 456)
241-6001-610   15.1RSUP   



Chapter 12 Embedded Nodal Provisioning   393
Task menu
The Task menu provides the commands to manipulate the tasks in the 
Provisioning Task panel. The table “Task menu commands” (page 394) 
describes the menu commands.

The following commands also appear in the pop-up menu when you right-
click on a task in the Provisioning Tasks panel:

• New Action... opens a dialog from which a new provisioning action can 
be added to the task. It is disabled if no task is selected.

• Remove Task removes the selected provisioning task from the 
Embedded Nodal Provisioning. It is disabled if no provisioning task is 
selected.

• Apply Task applies the currently selected task and adds it to the Task 
Application queue. It is disabled if no task is selected, or if the selected 
task is in retry or being applied.

• Close Session closes the provisioning session on the device.

• Cancel Pending Apply cancels the pending application of the selected 
task if it is in the retry state. The task returns to the open state and is 
removed from the Task Application Queue. It is disabled if there is no 
task selected or if the selected task is not in the retry state.
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Table 39
Task menu commands

Command Description Related information

New Task Adds a new task to the provisioning task tree. “Adding a new provisioning 
task” (page 444)

Move Task Up Changes the order in which the tasks in the 
queue are applied. This menu item moves the 
selected provisioning task up in the queue above 
the preceding task. If the selected task is the first 
in the queue, it becomes the last.
This command is disabled under the following 
circumstances 

• if no provisioning task is selected

• if the selected task is not in the Task 
Application queue, or

• if the selected task is “In progress”

“Rearranging the order of 
tasks” (page 453)

Move Task Down Changes the order in which the tasks in the 
queue are applied. This command moves the 
selected provisioning task down in the queue 
below the task that formerly followed it. If the 
selected task is the last in the queue, and the first 
task is not in application or retry state, it 
becomes the first. Otherwise it stays in the last 
position. This command is disabled under the 
following circumstances:

• if no provisioning task is selected

• if the selected task is not in the Task 
Application queue, or

• if the selected task is “In progress”

“Rearranging the order of 
tasks” (page 453)

Remove Task Removes the selected provisioning task from 
Embedded Nodal Provisioning. This command is 
disabled if you have not selected a task or if the 
task is in progress.

“Removing a provisioning 
task” (page 451)

Remove 
Completed Tasks

Removes all the tasks that have been 
successfully applied and are complete.

“Removing all provisioning 
tasks that are completed” 
(page 452)

 (Sheet 1 of 2)
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Action menu
The Action menu provides the commands to manipulate the actions in the 
Provisioning Tasks panel. The table “Action menu commands” (page 396) 
describes the menu commands.

The following commands also appear in the pop-up menu when you right-
click on an action in the Provisioning Tasks panel. They have the same effect 
as when you select the command from the Action menu.

• Move Action Up

• Move Action Down

• Move Action to Task...

• Remove Action

Apply Task Applies the currently selected tasks and adds it 
to the Task Application Queue. This command is 
disabled under the following circumstances:

• if no task is selected

• if the selected task is in retry, or

• if the selected task is being applied

“Setting user preferences 
for Embedded Nodal 
Provisioning” (page 456)

“Applying provisioning 
changes” (page 462)

Cancel 
Application

Cancels the application of the selected task if it 
is in retry state or queue status. The task returns 
to the open state. This command is disabled 
when there is no task selected or if the selected 
task is not in the retry state.

“Canceling the application 
of a single provisioning task” 
(page 465)

Cancel 
Applications

Opens a dialog box to cancel one or more 
applications that are in the retry state or queue 
status. This command is disabled if there are no 
applications in the retry state.

“Canceling the application 
of multiple provisioning 
tasks” (page 466)

Close Session Closes the provisioning session on the device.

Table 39  (Continued)
Task menu commands

Command Description Related information

 (Sheet 2 of 2)
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View menu
The table “Tools menu commands” (page 397) describes the menu 
commands.

Table 40
Action menu commands

Command Description Related information

New Action... Opens a dialog box from which a new 
provisioning action can be added to the task. 
This command is disabled if you have not 
selected a task.

“Adding a provisioning 
action” (page 447)

Move Action Up Changes the order in which the provisioning 
actions in the task are applied. This command 
moves the selected provisioning action up so 
that it precedes the action that formally preceded 
it. If the selected action is the first in the task, if 
becomes the last. This command is disabled if 
no provisioning action is selected.

“Changing the order of 
actions within a task” 
(page 445)

Move Action 
Down

Changes the order in which the provisioning 
actions in the task are applied. This command 
moves the selected provisioning action down so 
that it will follow the action that formerly followed 
it. If the selected action is the last in the task, it 
becomes the first. This command is disabled if 
no provisioning action is selected.

“Changing the order of 
actions within a task” 
(page 445)

Move Action to 
Task...

Opens a dialog box to move the selected 
provisioning action to another task. This 
command is disabled if you have not selected a 
provisioning action.

“Moving an action to a 
specific task” (page 446)

Remove Action Removes the selected provisioning action from 
the task. This command is disabled if you have 
not selected a provisioning action.

“Removing a provisioning 
action” (page 450)
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Tools menu
The tools menu provides launch points for the Nodal Provisioning and service 
provisioning tools. The table “Tools menu commands” (page 397) describes 
the menu commands.

Table 41
View menu commands

Command Description Related information

Provisioning 
Session...

Displays or hides the state of the provisioning 
session. 

Displays who is using the session when the 
provisioning session is in use.

“Viewing the state of the 
provisioning session” 
(page 464)

Task Application 
Queue

Displays or hides the Task Application Queue 
panel at the bottom of the window. 

“Viewing the Task 
Application Queue” 
(page 463)

Table 42
Tools menu commands

Command Description Related information

Nodal 
Provisioning

Starts Nodal Provisioning. “Starting other MDM tools 
from Embedded Nodal 
Provisioning” (page 475)

Service 
Provisioning

Opens a sub-menu of commands to start the 
following service provisioning tools:

• ATM

• Frame Relay

• IP VPN Service Provisioning

• IP VPN Provider Edge

For details, see 
241-6001-600 Preside 
MDM Service Provisioning 
for ATM User Guide

241-6001-603 Preside 
MDM Service Provisioning 
for Frame Relay User Guide

241-6001-616 Preside 
MDM IP VPN Service 
Configuration User Guide
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Help menu
The Help menu provides a launch point to the on-line documentation. The 
table “Help menu command” (page 398) describes the menu command.

Provisioning Tasks panel
The left side of the Embedded Nodal Provisioning window is the 
Provisioning Tasks panel. This panel lists the provisioning tasks and their 
associated actions. From this panel, you can browse the components being 
changed through the application of each task. 

Provisioning actions are ordered top to bottom under each task. Each action 
is applied to the device in the order in which it appears in the task. You can 
create, order, and delete tasks. You can also create, order, and delete actions. 

Icons indicate the nature of the provisioning change to the component. For a 
description of the tree icons, see the following tables:

• “Task icon descriptions” (page 399). The tree icons for tasks display the 
type of provisioning change to the component and their status.

• “Action icon descriptions” (page 400). The tree icons for actions display 
the actions within each task. 

There are tool tips for each task and action in the Provisioning Tasks panel. 
These tooltips display the full name of the task or action, so you have this 
information when the tree width is too small to display the full text of the 
tasks and actions.

Table 43
Help menu command

Command Description Related information

On Window Opens the online help documentation for the 
Embedded Nodal Provisioning window.
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Table 44
Task icon descriptions 

Icon Name Description

Task Open The provisioning task has not been 
applied.

Task Completed The provisioning task has been applied 
and is now complete. No further work can 
be done with this task.

Task in Retry You have requested to apply this 
provisioning task. However, the 
provisioning session is currently in use. 
Retry is in progress and this task will be 
applied as soon as the provisioning 
session is free.

Task in Queue You have requested to apply this 
provisioning task. However, the 
provisioning session is currently in use 
and there is already a task in Retry. This 
task is in the queue pending application.

Task Applying The provisioning task is in the process of 
being applied.

Errors in Task You have requested to apply the 
provisioning task. However, the apply 
operation failed because the provisioning 
task did not pass the node’s semantic 
checks. You may modify the task and try 
to apply again.
Preside MDM Nodal Provisioning User Guide   15.1RSUP



400   Chapter 12 Embedded Nodal Provisioning
The bottom of the Provisioning Tasks panel also provides the shortcut 
buttons. See the table “Provisioning Tasks panel buttons” (page 401).

Table 45
Action icon descriptions

Icon Name Meaning

Service Template action This is a service template that is applied to 
a component.

Add Component action This is a new component to be created.

Change Component action This is a component to be modified.

Delete Component action This is a component to be deleted.
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Provisioning forms panel
When you select a provisioning action, the right panel of the Embedded 
Nodal Provisioning window displays the forms associated with the 
provisioning action selected in the Provisioning Tasks panel. When you select 
a provisioning task, the right panel provides the task details. For details about 
the Task Details panel, see “Task details panel” (page 406).

The provisioning forms panel displays the forms corresponding to the 
selected provisioning action. These forms are the same as those used in Nodal 
Provisioning. You can set provisionable attribute values. Attribute entry field 
have tooltips that display the range and type of data that is valid for that 
attribute.

Attribute value range and type checking is done when the form displayed in 
the Provisioning Forms panel changes, or when the task that contains the 
component creation is applied, whichever comes first. The range and type are 
checked against those defined in the device Command Description Language 

Table 46
Provisioning Tasks panel buttons

Toolbar icon Action

This icon functions the same as the Move Action Up command in the 
Action menu. It changes the order in which the provisioning actions in 
the task are applied. It moves the selected provisioning action up so 
that it precedes the action that formerly preceded it. This icon is 
disabled if you have not selected a provisioning action.

This icon functions the same as the Move Action Down command in the 
Action menu. It changes the order in which the provisioning actions in 
the task are applied. It moves the selected provisioning action down so 
that it follows the action that formerly followed it. This icon is disabled if 
you have not selected a provisioning action.

This icon functions the same as the Apply Task command in the Task 
menu. This icon applies the currently selected task and adds it to the 
Task Application Queue. This icon is disabled if you have not selected 
a task or if the selected task is in retry or is being applied.
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(CDL). If an invalid attribute is found, the task, action, and attribute that are 
in error are identified in a message dialog box, as well as the Task Details 
panel.

• “Provisioning forms panel for the Add Component action” (page 402)

• “Provisioning forms panel for the Change Component action” 
(page 403)

• “Provisioning forms panel for the Delete Component action” (page 404)

• “Provisioning forms panel for the Service Template action” (page 405)

Provisioning forms panel for the Add Component action 
When you select Add Component, the panel displays a component creation 
form. You need to identify the component that is to be the parent of the new 
subcomponent. This component may, or may not, exist in the current view on 
the device. If it does not exist in the current view, you need to create the parent 
component by the same task, and before the new subcomponent is created. 

The component creation form lets you specify the instance identifier for the 
new component, as well as modify any of the provisionable attributes for the 
new component.

Note: When you add a new parent component, you can change or delete 
automatically added subcomponents in the same task.

For an illustration of the Provisioning Forms panel when you have selected an 
Add Component action, see the figure “Provisioning Forms panel for an Add 
Subcomponent action” (page 403). This figure shows an example of creating 
a new DS1 component as a subcomponent of Lp/1. 
241-6001-610   15.1RSUP   



Chapter 12 Embedded Nodal Provisioning   403
Figure 21
Provisioning Forms panel for an Add Subcomponent action

Provisioning forms panel for the Change Component action 
When you select Change Component, the panel displays a component edit 
form. The form lets you modify any of the provisionable attributes for the 
component. The form contains a Refresh button to retrieve the component 
data from the device and redisplay it in the Component edit form. When you 
refresh, you lose any changes that you have already made in the form. The 
form also displays the date and time of the last refresh.

For an illustration of the Provisioning Forms panel when you have selected an 
Change Component action, see the figure “Provisioning Forms panel for a 
Change Component action” (page 404). This figure is an example for 
modifying the Lp/2 X21/0.
Preside MDM Nodal Provisioning User Guide   15.1RSUP



404   Chapter 12 Embedded Nodal Provisioning
Figure 22
Provisioning Forms panel for a Change Component action

Provisioning forms panel for the Delete Component action 
When you select Delete Component, the panel displays a component deletion 
form. You can view the provisionable attributes for the component. However, 
the form is disabled so you cannot make any changes to the component data.

For an illustration of the Provisioning Forms panel when you have selected a 
Delete Component action, see the figure “Provisioning Forms panel for a 
Delete Component action” (page 405).
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Figure 23
Provisioning Forms panel for a Delete Component action

Provisioning forms panel for the Service Template action 
When you select Service Template, the panel displays a service template 
form. This form lets you modify the visible provisionable attributes for the 
components contained in the template.

For an illustration of the Provisioning Forms panel when you have selected an 
Service Template action, see the figure “Provisioning Forms panel for a 
Service Template action” (page 406). This figure shows an example for 
applying the Create ATM Interface Service Template to Lp/1
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Figure 24
Provisioning Forms panel for a Service Template action

Task details panel
When you select a provisioning action, the right panel of the Embedded 
Nodal Provisioning window displays the forms associated with the 
provisioning action selected in the Provisioning Tasks panel. For details about 
the Provisioning Tasks panel, see “Provisioning Tasks panel” (page 398). 
When you select a provisioning task, the right panel provides the task details 
about the apply operation. The details in the window are similar in content to 
that collected in the user logs. For details about the user logs, see “User logs” 
(page 388).

The task details panel provides a log of all the steps performed by the system 
after you apply a task. You can view the status of the following actions:

• acquiring the provisioning session

• creating, modifying or deleting components

• applying service templates

• checking, saving, applying the view or configuration
241-6001-610   15.1RSUP   



Chapter 12 Embedded Nodal Provisioning   407
• activating the view or committing the configuration 

• releasing the provisioning session

• warning or error messages encountered during the task application

You can change the name of the task by entering a name in the Task Name 
field of the Task Details panel. The task name is updated in the Provisioning 
Tasks panel.

The figure “Task Details panel” (page 407) shows an example of the Task 
Details panel for a task that is currently being applied.

Figure 25
Task Details panel
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Task Application Queue panel
The Task Application Queue panel is an optional panel that appears at the 
bottom of the Embedded Nodal Provisioning window. It shows the tasks 
being applied in decreasing order from top to bottom. 

You can show the Task Application Queue by selecting Task Application 
Queue from the View menu.

You can cancel the application of any task that has the status “Waiting for 
provisioning session by selecting the Cancel Application command from 
either the Task menu, or the task pop-up menu. You can also reorder tasks by 
using the Move Task Up and Move Task Down commands from the Task 
menu.

Status bar
The status bar shows the host name, CDL version, and the device to which 
you are connected.
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Embedded Nodal Provisioning dialog boxes
Embedded Nodal Provisioning includes the following dialog box:

• “Add Component Action Dialog” (page 409)

Add Component Action Dialog
For some components that you add, Embedded Nodal Provisioning 
automatically adds any associated mandatory subcomponents. For example, 
if you add a FrUni, Embedded Nodal Provisioning also adds the mandatory 
FrUni DataNetworkAddress and FrUni Framer InterfaceName attributes. 
When there are mandatory subcomponents, the Add <component> Action 
dialog box opens. (The title bar of the dialog box changes according to the 
component being added.) This dialog box lists the component to add along 
with its mandatory subcomponents. If required, you can make a selection of 
provisioning changes to the subcomponents. 

If there are no mandatory subcomponents, the dialog box does not display. 

Instance value
If you require an instance value for the component, a text box displays beside 
the component name. Type an appropriate instance value in the box. When 
you click the OK button in the dialog box, the instance value displays in the 
form on the right side of the Embedded Nodal Provisioning window. You 
cannot edit the instance value in the Embedded Nodal Provisioning window.

Provisioning actions
The mandatory subcomponents are listed in the dialog box. If required, you 
can create provisioning actions to modify or delete these subcomponents. If 
you select a mandatory subcomponent for deletion, any children of that 
subcomponent that also display in the list will not be available for other 
provisioning actions.

Command buttons
The dialog box contains the following command buttons:

• OK closes the dialog box and adds the provisioning actions to the task.

• Cancel closes the dialog box without adding any provisioning actions.

• Help displays online help for the dialog box.
Preside MDM Nodal Provisioning User Guide   15.1RSUP



410   Chapter 12 Embedded Nodal Provisioning
Procedures
See the following sections for the procedures for Embedded Nodal 
Provisioning:

General procedures

• “Starting Embedded Nodal Provisioning” (page 412)

• "Viewing on-line help" on page 414

• “Exiting Embedded Nodal Provisioning” (page 415)

Provisioning procedures

• “Adding a subcomponent using the Shelf View tools” (page 416)

• “Adding a subcomponent using Embedded Nodal Provisioning” 
(page 419)

• “Modifying a component using the Shelf View tools” (page 422)

• “Modifying a component using Embedded Nodal Provisioning” 
(page 423)

• “Refreshing a component modification form” (page 425)

• “Deleting a component using the Shelf View tools” (page 426)

• “Deleting a component using Embedded Nodal Provisioning” 
(page 427)

• “Setting component context” (page 433)

• “Getting a context for a component” (page 434)

• “Applying a service template using the Shelf View tools” (page 429)

• “Applying a service template using Embedded Nodal Provisioning” 
(page 431)

• “Linking a new service to a new port” (page 439)

Organizing provisioning tasks and actions

• “Adding a new provisioning task” (page 444)

• “Changing the order of actions within a task” (page 445)
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• “Moving an action to a specific task” (page 446)

• “Adding a provisioning action” (page 447)

• “Renaming a provisioning task” (page 449)

• “Removing a provisioning action” (page 450)

• “Removing a provisioning task” (page 451)

• “Removing all provisioning tasks that are completed” (page 452)

• “Rearranging the order of tasks” (page 453)

Application tasks

• “Applying a task” (page 454)

• “Applying a task without sufficient provisioning privileges” (page 455)

• “Setting user preferences for Embedded Nodal Provisioning” (page 456)

• “Applying provisioning changes” (page 462)

• “Viewing the Task Application Queue” (page 463)

• “Viewing the state of the provisioning session” (page 464)

• “Canceling the application of a single provisioning task” (page 465)

• “Canceling the application of multiple provisioning tasks” (page 466)

Concurrent provisioning conflicts and error resolution

• “Concurrent provisioning conflicts and resolution” (page 467)

• “Error messages” (page 468)

• “Repairing Passport service creation errors” (page 199)

• “Resolving a restorePossible error condition” (page 201)

• “Resolving a journalDisabledReason error condition” (page 203)
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Starting Embedded Nodal Provisioning 
You start Embedded Nodal Provisioning from within the Passport Shelf View 
or MPE Shelf View tool. As Embedded Nodal Provisioning starts, it performs 
a group authentication to access the device that displays in the Shelf View 
tool.

Prerequisites
This procedure assumes that you have opened either Passport Shelf View or 
MPE Shelf View. For information about these tools, see 241-6001-011 
Preside MDM Fault Management User Guide.

Procedure steps
1 In the Shelf View tool, right-click a component.

A pop-up menu opens.

2 On the pop-up menu, click one of the following provisioning tasks:

• Add Subcomponent…

• Change Component…

• Delete Component…

• Apply Service Template…

A Group Authentication dialog box opens. 

3 In the Group Authentication dialog box, complete the following steps.

•  In the Group Name box, type or select an appropriate group name.

• In the User ID box, type or select an appropriate user name

• In the Password box, type or select an appropriate password. 
Depending on your previous activities and any predefined 
preferences, the User ID and Password fields may be populated. If 
the entries are not correct, edit the values. 

• click OK.

If the authentication succeeds, the dialog box closes and a read-only 
session of Embedded Nodal Provisioning opens. The provisioning action 
selected in the Shelf View tool shows as a new provisioning task in the 
Provisioning Tasks panel.
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If the authentication fails, a message displays in the Group Authentication 
dialog. Click Details for information about the cause of failure. Correct the 
entries in the dialog box and click OK.
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Viewing on-line help
Use this procedure to view the on-line help about the Embedded Nodal 
Provisioning window.

Prerequisites
This procedure requires that you have started Embedded Nodal Provisioning.

Procedure steps
1 On the Help menu, click Help On Window.

The online documentation for the Embedded Nodal Provisioning 
window opens in a Netscape window.
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Exiting Embedded Nodal Provisioning
Use this procedure to exit Embedded Nodal Provisioning. 

Prerequisites
This procedure requires that Embedded Nodal Provisioning is not holding a 
provisioning session and is not in the process of applying a task. If Embedded 
Nodal Provisioning has the provisioning session and is in the process of 
applying a task, the Exit menu item is disabled.

Procedure steps
1 On the File menu, click Exit.

The Embedded Nodal Provisioning window closes.

If there are tasks in the Provisioning Tasks panel that have not yet been 
completed, either because they have not been applied, or the applied 
tasks were unsuccessful, an Exit dialog box opens and prompts for the 
next action. 

2 In the Exit dialog box, select one of the following actions: 

• To exit Embedded Nodal Provisioning, click Yes. All inactivated 
tasks are lost.

• To return to the Embedded Nodal Provisioning window, click No.

• To cancel the exit operation, click Cancel.
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Adding a subcomponent using the Shelf View tools
From Passport Shelf View or MPE Shelf View, you can add a subcomponent 
and, if required, edit its own automatically added subcomponents. 

Mandatory subcomponents of components are automatically added with 
default attribute values. If needed, you can edit these default attribute values. 
For example, if you add a Fruni subcomponent, you can modify the default 
values for the dataNetworkAddress and framer attributes. 

Prerequisites
This procedure requires the following conditions:

• you have opened the Passport or MPE Shelf View tool 

• you have sufficient privileges to provision the device.

Procedure steps
1 Right-click a component and on the pop-up menu, click Add 

Subcomponent.

The Select subcomponent type dialog box opens.

2 In the Select subcomponent type dialog box 

a. Select the type of subcomponent that you need to create.
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b. Click OK.

The Select subcomponent type dialog box closes.

If you added a subcomponent that has its own mandatory 
subcomponents, the Add <Component> Action dialog box opens. Go 
to step 3. 

Otherwise, if you added a subcomponent that does not have its own 
associated subcomponents, the new action is placed in the 
Embedded Nodal Provisioning window’s task list. Go to step 4

3 In the Add <Component> Action dialog box,

a. add an instance value, if required. You cannot edit this instance value 
in the Embedded Nodal Provisioning window.

b. modify any mandatory subcomponents as required, using the actions 
in the drop-down list.

c. click OK.

The Add <Component> Action dialog box closes and the new action 
is placed in the Embedded Nodal Provisioning window’s task list.

4 If the Embedded Nodal Provisioning window already contains multiple 
tasks, the Move to Task dialog box opens and lets you specify the task to 
which the action should be added. See the procedure “Moving an action 
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to a specific task” (page 446). Otherwise, the Embedded Nodal 
Provisioning window opens.

5 In the Provisioning Tasks panel, select the new action.

The Add <subcomponent type> form opens in the panel on the right side 
of the Embedded Nodal Provisioning window. 

6 Enter the component identifier for the new subcomponent, and modify 
attribute values, as required.
Optionally, set or get the context for this component. See “Setting 
component context” (page 433) or “Getting a context for a component” 
(page 434).

7 Optionally, add more provisioning actions to the task by repeating step 1 
to step 6.

8 Optionally, modify or delete automatically added subcomponents of the 
parent component. See “Modifying a component using Embedded 
Nodal Provisioning” (page 423) or “Deleting a component using 
Embedded Nodal Provisioning” (page 427).

9 Apply the task. See “Task Application overview” (page 384).

If the application is successful, the new subcomponent is added.
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Adding a subcomponent using Embedded Nodal 
Provisioning 

Use this procedure to add a subcomponent from within Embedded Nodal 
Provisioning window.

Prerequisites
This procedure requires the following conditions:

• You have opened Embedded Nodal Provisioning.

• You have sufficient privileges to provision the device

• You know the full name of the parent component.

Procedure steps
1 Select one of the following actions:

• Right-click a task in the Provisioning Tasks panel and on the popup 
menu, click New Action….

• Select a task in the Provisioning Tasks panel and then on the Action 
menu, click New Action....

The New Action dialog box opens. 

2 In the New Action dialog box, complete the following steps.

• In the Component Name field, enter the name of the parent 
component to which the subcomponent is to be added. This may be 
the name of an existing component or the name of a component that 
will be created as part of the same provisioning task. 

Optionally, set or get the context for this component. See “Setting 
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component context” (page 433) or “Getting a context for a 
component” (page 434).

• In the Provisioning Action list, click Add Subcomponent.

• Specify the task to which the provisioning action is to be added. To 
add the action to an existing task, select existing and then select the 
task name from the drop down list. Otherwise, select new and the 
task name is automatically generated. You can choose to use the 
default name for the new task or modify it to provide a new name.

• Click OK.

The Select Component Type dialog box opens.

3 In the Select Component Type dialog box, complete the following steps.

• Select the type of component to create.

• Click OK.

The Select subcomponent type dialog box closes. 

If you added a subcomponent that has its own mandatory 
subcomponents, the Add <Component> Action dialog box opens. Go to 
step 4. 

Otherwise, if you added a subcomponent that does not have its own 
associated subcomponents, the new action is placed in the Embedded 
Nodal Provisioning window’s task list. Go to step 5.
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4 In the Add <Component> Action dialog box, complete the following steps.

a. Add an instance value, if required. You cannot edit this instance value 
in the Embedded Nodal Provisioning window.

b. Modify any mandatory subcomponents as required, using the actions 
in the drop-down list.

c. Click OK.

The Add <Component> Action dialog box closes and the new action 
is placed in the Provisioning Tasks panel.

5 In the Provisioning Tasks panel, select the new action.

The Add <subcomponent type> form opens on the right side of the 
Embedded Nodal Provisioning window.

6 Enter the component identifier for the new subcomponent and modify 
attribute values, as required.

7 Optionally, add more provisioning actions to this task.

8 Apply the task. See “Task Application overview” (page 384).

If the apply action is successful, the new subcomponent is added.
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Modifying a component using the Shelf View tools
Use this procedure to modify a component using the Passport Shelf View or 
MPE Shelf View tool. 

Prerequisites
This procedure requires the following conditions:

• You have opened the Passport Shelf View or MPE Shelf View tool

• You have sufficient provisioning privileges to provision the device.

• You have located the component that you want to modify.

Procedure steps
1 Right-click a component and on the pop-up menu, click Change 

Component….

The Select subcomponent type dialog box opens.

2 On the pop-up menu, click Change Component….

If the Embedded Nodal Provisioning window is not already open, it now 
opens.

The component to be modified is added to the Provisioning Tasks panel. 
The icon for the subcomponent is the Change Component icon and the 
label is Change <component name>.

3 Select the new action in the Provisioning Tasks panel.

The Change <component name> form opens on the right of the 
Embedded Nodal Provisioning window. 

4 Modify the provisional attribute values in the form, as desired.

5 Optionally, add more provisioning actions to the task.

6 Apply the task. See “Task Application overview” (page 384).
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Modifying a component using Embedded Nodal 
Provisioning 

Use this procedure to modify a component from within the Embedded Nodal 
Provisioning window.

Prerequisites
This procedure requires the following conditions:

• You have opened the Embedded Nodal Provisioning window.

• You have sufficient privileges to provision a device.

• You know the full name of the component that you want to modify.

Procedure steps
1 Select one of the following actions:

• Right-click a task in the Provisioning Tasks panel and on the popup 
menu, click New Action….

• Select a task in the Provisioning Tasks panel and then on the Action 
menu, click New Action....

The New Action dialog box opens. 

2 In the New Action dialog box, complete the following steps.

• Type a Component Name.

• In the Provisioning Action list, click Change.

• Specify the task into which to place this provisioning action.

• Click OK.
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The component to be modified is added to the Provisioning Tasks panel. 
The icon for the subcomponent is the Change Component icon and the 
label is the component name.

3 In the Provisioning Tasks panel, select the new action.

The Change <component name> form appears on the right of the 
Embedded Nodal Provisioning window.

4 Modify the provisional attribute values in the form, as desired.

5 Optionally, add more provisioning actions to the task.

6 Apply the task. See “Task Application overview” (page 384).
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Refreshing a component modification form
Use this procedure to refresh the display in the Embedded Nodal Provisioning 
window of a component modification form with the data from the current 
view of the device.

Procedure steps
1 Right-click a component in the Provisioning Tasks panel, and on the 

pop-up menu, click Change Component….

The Change Component form appears on the right of the window.

2 In the Change Component form, click Refresh.

The Last refresh timestamp is updated with the current date and time. 
The component data is replaced with data from the node’s current view or 
candidate configuration.

If Embedded Nodal Provisioning is unable to retrieve the component data 
from the node, an error message displays. A possible cause of the error 
may be that the component has been deleted from the node.
Preside MDM Nodal Provisioning User Guide   15.1RSUP



426   Chapter 12 Embedded Nodal Provisioning
Deleting a component using the Shelf View tools
Use this procedure to delete a component using the Passport Shelf View or 
MPE Shelf View tools. 

Prerequisites
This procedure requires the following conditions:

• You have opened the Passport Shelf View or MPE Shelf View tool

• You have sufficient privileges to provision a device.

Procedure steps
1 Right-click a component and on the pop-up menu, click Delete 

Component.

If the Embedded Nodal Provisioning window is not already open, it 
opens.

The component to be deleted displays in the Provisioning Tasks panel. 
The icon for the subcomponent is the Delete Component icon and the 
label is the component name.

2 In the Provisioning Tasks panel, select the new delete action.

The Delete <component name> form opens on the right of the Embedded 
Nodal Provisioning window. The provisionable attributes are visible but 
disabled so that you cannot change them.

3 Optionally, add more provisioning actions to the task.

4 Apply the task. See “Task Application overview” (page 384).
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Deleting a component using Embedded Nodal Provisioning 
Use this procedure to delete a component from within the Embedded Nodal 
Provisioning window.

Prerequisites
This procedure requires the following conditions:

• You have opened Embedded Nodal Provisioning.

• You have sufficient privileges to provision a device.

• You know the full name of the component that you want to delete.

Procedure steps
1 Select one of the following actions:

• Right-click a task in the Provisioning Tasks panel and on the popup 
menu, click New Action….

• Select a task in the Provisioning Tasks panel and then on the Action 
menu, click New Action....

The New Action dialog box opens. 

2 In the New Action dialog box, complete the following steps.

• In the Component Name field, type the name of the component that 
you want to delete

• In the Provisioning Action list, click Delete.

• Specify the task into which to place this provisioning action.

• Click OK. 
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The component to be deleted displays in the Provisioning Tasks panel. 
The icon for the subcomponent is the Delete Component icon and the 
label is the component name.

3 In the Provisioning Tasks panel, select the new action.

You can view the provisionable attribute values in the component but they 
are disabled so you cannot change them.

4 Optionally, add more provisioning actions to the task.

5 Apply the task. See “Task Application overview” (page 384).
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Applying a service template using the Shelf View tools
Use this procedure to apply a service template to a component that you have 
selected in the Passport Shelf View or MPE Shelf View tool.

Prerequisites
This procedure requires that the following conditions are met:

• You have opened the Passport Shelf View or MPE Shelf View tool

• You have sufficient privileges to provision the device.

Procedure steps
1 Right-click the component to which you want to apply a service template 

and from the pop-up menu, click Apply Service Template….

The Select Service Template dialog box opens. 

2 In the Select Service Template dialog box, complete the following steps.

• Select a template to apply from the Templates list.

• Click OK.

See “Selecting a service template” (page 435) for the procedure to select 
a service template.
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The Embedded Nodal Provisioning window opens if it is not already 
open. The component to which the service template is being applied 
displays in the Provisioning Tasks panel. The icon for the subcomponent 
is the Apply Template icon and the label contains the name of the 
template and the name of the component that it is being applied to.

3 In the Provisioning Tasks panel, select the new action.

The Apply Service Template form display on the right of the Embedded 
Nodal Provisioning window. 

4 Enter the required component identifier and attribute values.

5 Optionally, add more provisioning actions to the task.

6 Apply the task. See “Task Application overview” (page 384).
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Applying a service template using Embedded Nodal 
Provisioning 

Use this procedure to apply a service template to a component that you have 
selected in the Embedded Nodal Provisioning window.

Prerequisites
This procedure requires that the following conditions are met:

• you have opened the Embedded Nodal Provisioning window

• you have sufficient privileges to provision the device

• you know the full name the component to which to apply the service 
template.

Procedure steps
1 Select one of the following steps:

• Right-click a task in the Provisioning Tasks panel and from the pop-
up menu, click New Action….

• On the Action menu, click New Action….

The New Action dialog box opens.

2 In the New Action dialog box, complete the following steps.

• In the Component Name field, type the name of the component to 
which you want to apply the service template.

• From the Provisioning Action drop down list, select Apply Service 
Template.

• Specify the task into which to place this provisioning action.

• Click OK.

See the detailed procedure “Adding a provisioning action” (page 447).
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The Select Service Template dialog box opens.

3 In the Select Service Template dialog box, complete the following steps.

• Select a service template.

• Click OK.

See the procedure “Selecting a service template” (page 435).

The Select Service Template dialog box closes. The component to 
which the template will be applied displays in the Provisioning Tasks 
panel. The icon for the subcomponent is the Apply Template icon and the 
label contains the name of the template and the name of the component 
it is applied to in the form <template name> to <component name>.

4 In the Provisioning Tasks panel, select the new action.

The Apply Service Template form appears on the right side of the 
Embedded Nodal Provisioning window.

5 Enter the service template data, including the component identifiers and 
attribute values.

6 Optionally, add more provisioning actions to the task.

7 Apply the task. See “Task Application overview” (page 384).
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Setting component context 
Use this procedure together with the “Adding a subcomponent using 
Embedded Nodal Provisioning” (page 419) to set the context for a selected 
component. Once the context is set for a component, this context can be 
applied to other components.

Prerequisites
This procedure requires the following conditions:

• you have opened the Embedded Nodal Provisioning window and have 
added a new component

• you have sufficient privileges to provision the device

• you know the full name of the component that you want to set as the 
context.

Procedure steps
1 In the New Action dialog box right-click in the Component Name box and 

from the pop-up menu, click Set Context.

The Set Context Completed confirmation dialog opens.
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Getting a context for a component
Use this procedure to get the context for a selected component from another 
component in the component hierarchy. 

Prerequisites
This procedure requires the following conditions:

• you have opened the Embedded Nodal Provisioning window and have 
added a new component

• you have sufficient privileges to provision the device

• you know the full name of the component that you want to set as the 
context.

Procedure steps
1 In the New Action dialog box right-click in the Component Name box and 

from the pop-up menu, click Get Context.

The context component name appears in the text field.
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Selecting a service template
Use this procedure to select a service template to apply to a component. You 
can use this procedure from Embedded Nodal Provisioning or from the 
Passport and MPE Shelf View tools. You use the Select Service Template 
dialog box to select the service template to apply. The Select Service 
Template dialog box is populated with the names of all the templates that can 
be applied to the selected component, including custom templates.

Prerequisites
This procedure requires the following conditions:

• You have sufficient privileges to provision the device.

• You have selected the component to which the template will be applied.

• You have selected the Apply Service Template command from a 
component’s pop-up menu in the Shelf View tools, or in Embedded 
Nodal Provisioning, from the Provisioning Action drop down list in the 
New Action dialog box.

Procedure
1 Optionally, use the Service Group drop down list and the Template 

Name list to restrict the templates shown in the Templates list.

• From the Service Group drop down list, select a service group. The 
Service Group list contains all of the template categories for which 
there are templates that can be applied to the component. Minimally 
one category is required for the dialog box to open.
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• In the Templates Name field start to enter the name of the template 
that you want to apply. The template that most closely matches what 
you type in this field is highlighted in the list.

2 Click OK to apply the selected template.

selected service 
template for the apply 
service template 
operation
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Browsing for available component instances
Use this procedure to browse for component instances for node component 
attributes that have a value that is in reference to another component instance. 
You can type the component name of the other instance in the attribute value 
text field, or you can use the Component Link Search dialog box to search for 
such component instances. A browse button[...] is provided beside each 
attribute with a component instance.

The ability to browse for component instances improves the ability to handle 
situations where there are large numbers of components for a linked attribute. 

Prerequisites
This procedure requires that the following conditions are met:

• You have opened Embedded Nodal Provisioning.

• You have sufficient privileges to provision the device.

• The component attribute has a value that is a reference to another 
component instance, as indicated by a browse button [...] beside the 
attribute.

Procedure
1 For those attributes that have a value that is in reference to another 

component instance, type the component name of the other instance in 
the text field, or click the browse button [...] next to the attribute with a 
component instance.

2 If you click the browse button, the Component Link Search dialog box 
opens.

3 Enter search criteria in the Search Criteria panel:

• In the Start Search at Component field, type the name of the other 
instance or use the wild card (*) to search for all instances.

• In the Max Number to Retrieve, type the number of instances to 
retrieve. The default is 100.

4 Click Search.

The list of available component links found as a result of the search, are 
listed in the Search Results panel.

5 Select a component link from the list and click OK.
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The selection is entered in the field beside the browse button.
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Linking a new service to a new port
Use this procedure as an example of how you can create a new port and link 
a new service to it in a single task.

Prerequisites
This procedure requires that the following conditions are met:

• You have opened the Passport Shelf View or MPE Shelf View tool

• You have sufficient privileges to provision the device.

Procedure
1 Right-click the component for which you want to create a new port and 

from the pop-up menu, click Add Subcomponent….

The Select subcomponent type dialog box opens.

2 In the Select subcomponent type dialog box, complete the following 
steps.

• In the type Name list, select the port component (for example DS3).

• Click OK.
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The Select Component Type dialog box closes and the add port action 
appears in the Provisioning Tasks panel.

3 In the Provisioning Tasks panel, select the task associated with the 
newly added action item.

4  On the action menu, click New Action.

The New Action dialog box opens.

5 In the New Action dialog box, complete the following steps.

• In the Component Name field, type the name of the parent 
component of the new service component that is being created, (for 
example, EM/Atlanta, EM, or empty string).

• In the Provisioning Action list, click Add Subcomponent.

• Click OK.

The New Action dialog box closes and the Select subcomponent type 
dialog box opens.

6 In the Select subcomponent type dialog box, complete the following 
steps.

• In the type Name list, select a service component type (for example, 
AtmIf)

• Click OK.
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The Select Component Type dialog box closes and the service action is 
added to the Provisioning Task panel.

7 In the Provisioning Task panel, select the add port action that was added 
in step 2.

The Add Lp/1 DS3 form appears in the right side panel of the Embedded 
Nodal Provisioning window.

8 In the Add Lp/1 DS3 form, complete the following steps. 

• Type the component identifier for the new port.

• Modify the attribute values, as required.

• Do not set the Application Framer Name attribute.

9 In the Provisioning Tasks panel, select the add service action.

The Add EM/Atlanta AtmIf form displays on the right side of the 
Embedded Nodal Provisioning window.

10 In the Add EM/Atlanta AtmIf form, complete the following steps.

• Type the component identifier for the new service

• Set the attribute values, as required.
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• Type Lp/1 DS3/2 for the value of the Interface attribute.

11 Apply the task. See “Task Application overview” (page 384).
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Organizing provisioning tasks and actions overview
This section describes the procedures for organizing provisioning actions into 
provisioning tasks as well as reorganizing actions within a task. See the 
following procedures for additional information:

• “Adding a new provisioning task” (page 444)

• “Changing the order of actions within a task” (page 445)

• “Moving an action to a specific task” (page 446)

• “Adding a provisioning action” (page 447)

• “Renaming a provisioning task” (page 449)

• “Removing a provisioning action” (page 450)

• “Removing a provisioning task” (page 451)

• “Removing all provisioning tasks that are completed” (page 452)

• “Rearranging the order of tasks” (page 453)
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Adding a new provisioning task
Use this procedure to add a new provisioning task.

Prerequisites
This procedure requires that the following conditions are met:

• You have opened the Embedded Nodal Provisioning window.

• You have sufficient privileges to provision the device.

Procedure
1 On the Embedded Nodal Provisioning Task menu, click New Task.

A new task is added to the bottom of the Provisioning Tasks panel with the 
format Task_X, where X is a unique number in the task list. Tasks are 
automatically added sequentially.

2 Select the new task.

The panel on the right side of the Embedded Nodal Provisioning 
window displays the task details.

3 If desired, in the task details panel, change the name of the new task in 
the Task Name field.
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Changing the order of actions within a task
Use this procedure to change the order of actions within a task. Action items 
within a task are applied in consecutive order. 

Prerequisites
This procedure requires that the following conditions are met:

• You have opened the Embedded Nodal Provisioning window.

• You have sufficient privileges to provision the device.

• The Provisioning Tasks panel contains one or more tasks with several 
actions.

Procedure
1 In the Provisioning Tasks panel, select a provisioning action.

2 Complete one of the following steps to move an action up one position. (If 
the provisioning action is the first one in the task, it becomes the last.)

• On the Action menu, click Move Action Up.

• Right-click on the action in the Provisioning Tasks panel and on the 
pop-up menu click Move Action Up.

3 Complete one of the following steps to move an action down one position. 
(If the provisioning action is the last one in the task, it becomes the first.)

• From the Action menu, select Move Action Down.

• Right-click on the action in the Provisioning Tasks panel and select 
Move Action Down from the popup menu.
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Moving an action to a specific task
Use this procedure to add a provisioning action to a new task or to move an 
action from one task to another. The Move to Task dialog box opens 
automatically when you specify an action and there is more than one open 
task in the Embedded Nodal Provisioning window. 

When you add a provisioning action to a task, the action is added to the 
bottom of any existing list of actions. When you move a provisioning action 
from one task to another, the action is removed from the one task and added 
to the bottom of any existing list of actions in the other task.

Prerequisites

This procedure requires the following conditions:

• You have opened Embedded Nodal Provisioning.

• You have sufficient privileges to provision the device.

• The Move to Task dialog box is open, either because Embedded Nodal 
Provisioning has more than one open task, or you have selected Move to 
Task from the menu bar.

Procedure
1 To create a new task for the action, in the Move to Task dialog box, click 

new.

2 To add or move an action to an existing task, in the Move to Task dialog 
box, click existing and then select the task from the list.

3 Click OK. 
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Adding a provisioning action
Use this procedure to add a provisioning action to a task.

Prerequisites
This procedure requires that the following conditions are met:

• You have opened the Embedded Nodal Provisioning window.

• You have sufficient privileges to provision the device.

• You know the name of the component to which the subcomponent is to 
be added.

Procedure
1 Select one of the following steps:

• Right-click an action in the Provisioning Tasks panel and from the 
pop-up menu, click New Action….

• On the Action menu, click New Action….

The New Action dialog box opens.

2 In the Component Name field, enter the name of the parent component 
that the action will operate on. This may be the name of an existing 
component or the name of a component that will be created as part of the 
same provisioning task.

Note:  The only provisioning action appropriate to a component that does 
not yet exist is Add Subcomponent. Any other action will result in an 
error message, since the provisioning form cannot open for a component 
that does not exist.

3 From the Provisioning Action drop down list, select an action. You have 
the following options:.

• Add

• Change

• Delete deletes a subcomponent

• Add Subcomponent

• Apply Template 

4 Specify the task into which the current provisioning action will be placed;
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• If in an existing task, select existing and then select from the list of 
existing task names in the drop down list. 

• If in a new task, select new. The new task name is automatically 
generated. 

5 Click OK.

6 Use the existing name of the task, or optionally, select the task in the 
Provisioning Tasks panel and change the name in the Task Name field in 
the task details panel. See “Renaming a provisioning task” (page 449).
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Renaming a provisioning task
Use this procedure to rename a provisioning task.

Prerequisites
This procedure requires that the following conditions are met:

• You have opened the Embedded Nodal Provisioning window.

• You have sufficient privileges to provision the device.

• The Provisioning Tasks panel contains at least one task.

Procedure
1 In the Provisioning Task panel, select a provisioning task.

2 In the Task Name field in the task details panel, change the name of the 
task. The task name must be different than any existing task name.

The task name is updated in the Provisioning Tasks panel when the focus 
moves from the Task Name field. If the new task name is the same as one 
of the existing task names, it reverts to the previous task name.
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Removing a provisioning action
Use this procedure to remove a provisioning action from a provisioning task.

Prerequisites
This procedure requires that the following conditions are met:

• You have opened the Embedded Nodal Provisioning window.

• You have sufficient privileges to provision the device.

• The Provisioning Tasks panel contains at least one task and one action.

Procedure
1 Select one of the following steps:

• Right-click an action in the Provisioning Tasks panel and from the 
pop-up menu, click Remove Action….

• On the Action menu, click Remove Action….

The provisioning action is removed from the Provisioning Tasks panel.
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Removing a provisioning task
Use this procedure to remove a provisioning task from the Provisioning Tasks 
panel.

Prerequisites
This procedure requires that the following conditions are met:

• You have opened the Embedded Nodal Provisioning window.

• You have sufficient privileges to provision the device.

• The Provisioning Tasks panel contains at least one task.

Procedure
1 Select one of the following options:

• Right-click a task in the Provisioning Tasks panel and from the pop-
up menu, click Remove Task….

• Select a task in the Provisioning Tasks panel and then on the Task 
menu, click Remove Task….

If the task has not been completed through a successful apply operation, 
you are prompted to confirm that you want to remove the task.

2 Click OK.
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Removing all provisioning tasks that are completed
Use this procedure to remove all the tasks from the Provisioning Tasks panel 
that have been completed, that is successfully applied.

Prerequisites
This procedure requires that the following conditions are met:

• You have opened the Embedded Nodal Provisioning window.

• You have sufficient privileges to provision the device.

• The Provisioning Task list contains at least one or more tasks that have 
been successfully applied

Procedure
1 On the Task menu, click Remove Completed Tasks.

The completed tasks are removed from the Provisioning Tasks panel.
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Rearranging the order of tasks
Use this procedure to rearrange the order of tasks in the Task Application 
Queue. This procedure applies to either moving a task up the queue or moving 
a task down a queue.

Prerequisites
This procedure requires that the following conditions are met:

• You have opened the Embedded Nodal Provisioning window.

• You have sufficient privileges to provision the device.

• The Task Application Queue contains more than one task waiting to be 
applied

Procedure
1 In the Task Application Queue, select the task whose order you want to 

change.

2 To move the task up one position in the queue, on the Task menu, click 
Move Task Up:

The selected task moves up one position in the queue. If the task is the 
first in the queue, it moves the last.

3 To move the task down one position in the queue, on the Task menu, click 
Move Task Down

The selected task moves down one position. If the task is the last in the 
queue and the first task status is not in an apply or retry state, then the 
task moves to the first position in the queue. 
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Applying a task
Use this procedure to apply the provisioning actions contained by the task to 
the current Passport view or MPE candidate configuration.

Prerequisites
This procedure requires that the following conditions are met:

• You have opened Embedded Nodal Provisioning.

• You have sufficient privileges to provision the device.

Procedure
1 In the Provisioning Tasks panel, select a task.

2 Select one of the following options:

• On the Task menu, click Apply Task. 

• In the Provisioning Tasks panel, click Apply.

Depending on your user preferences you may be prompted to confirm the 
apply operation. If so, click OK to proceed.

3 Refer to the section “Task Application overview” (page 384) for a 
description of the application process under the following conditions.

• “When a node’s provisioning session is available” (page 384)

• “When the node’s provisioning session is in use” (page 385)

• “When a task or action fails” (page 386)

• “When a service creation fails” (page 387)

4 Optionally, set the context for the application task. Select the task and 
right-click to select Set Context.
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Applying a task without sufficient provisioning privileges
Use this procedure to apply a task when your user ID does not have sufficient 
provisioning privileges.

Prerequisites
This procedure requires that the following conditions are met:

• The Passport Shelf View or MPE Shelf View user ID and password do 
not have sufficient impact to provision a device.

Procedure
1 In the Provisioning Tasks list, select a task.

2 Select one of the following options:

• On the Task menu, click Apply, 

• In the Provisioning Tasks panel click Apply.

Depending on your user preferences you may be prompted to confirm the 
apply operation. If so, click OK to proceed.

3 The Device Authentication dialog box opens.

4 Enter a user ID and password for provisioning and click OK.

The Device Authentication dialog closes. The task icon changes to the 
“Applying” icon. 

5 Refer to the section “Task Application overview” (page 384) for a 
description of the following possible outcomes.

• “When a node’s provisioning session is available” (page 384)

• “When the node’s provisioning session is in use” (page 385)

• “When a task or action fails” (page 386)

• “When a service creation fails” (page 387)
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Setting user preferences for Embedded Nodal Provisioning
Use this procedure to modify the user preferences settings for Embedded 
Nodal Provisioning. Passport user preferences for save and activate options 
take effect immediately; other options take effect the next time the tool starts. 
MPE user preferences for open, commit, and save options take effect 
immediately; admin preferences take effect the next time the tool starts.

Prerequisites
This procedure requires that the following conditions are met:

• You have opened Embedded Nodal Provisioning.

Procedure steps
1 On the Options menu, click User Preferences, and then the appropriate 

tab.

2 Modify the user preference settings as required. 

•  For details about Passport user preferences, see the table “Passport 
user preferences for Embedded Nodal Provisioning” (page 456).

• For details about MPE user preferences, see the table “MPE user 
preferences for Embedded Nodal Provisioning” (page 459).

3 Click OK.

Table 47
Passport user preferences for Embedded Nodal Provisioning

Preference type Preference Use when you want to...

Save/Activate:

Check View Check View Check the provisioning view. You can 
check only the changes made to the view 
or the complete view, depending on the 
option you select in the Type list. 
Checking the complete view is the default 
setting.

 (Sheet 1 of 3)
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Save View Save Save the view. You can save the view in 
ascii, delta, portable, or both portable and 
ascii formats. Name the new service by 
selecting the Keyed, Dated, or User 
specified options. Saving the view in 
portable format with a keyed name is the 
default setting.

• Keyed - Start a key with a number or 
letter. You can use numbers, letters, 
or underscores for subsequent 
characters. The key cannot exceed 6 
characters. If the key contains only 
numbers, then its length must be at 
least three characters. The service 
data view that matches the pattern 
and has the highest index is used, and 
the next view in the sequence is 
created.

• Dated - Type “today” or type a date in 
the format yymmdd (where yy is the 
year, mm is the month, and dd is the 
day). When you save a provisioning 
view with a dated key, Nodal 
Provisioning adds a two-digit index to 
the date to keep track of the number of 
saved views on the same date, for 
example <yymmdd><nn>. When you 
enter a date, the service data view 
with the highest index is used and the 
next view in the sequence is created. 

• User specified - Type a view name. Or, 
click the Browse button and select a 
file name.

• Same as Opened View Name - The 
adjacent field is pre-filled with the 
name of the selected open view and 
the extension full.<nnn>.

Table 47 (Continued)
Passport user preferences for Embedded Nodal Provisioning

Preference type Preference Use when you want to...

 (Sheet 2 of 3)
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Activate View Activate Apply the provisioning tasks to the view 
being modified.

Commit View Commit Make the view the one that opens after 
the node restarts.

Other Option Always Prompt to Save View Open a confirmation box before a view is 
saved. 

Others:

Task Repair 
Timeout

Specify a maximum time to retain a 
provisioning session while repairing a 
task. The default value is 5 minutes.

 Prov Session
Retry Interval

Specify the time interval between 
attempts to obtain the node’s provisioning 
session. The default value is 1 minute.

Server 
Reconnect

 Specify the maximum number of attempts 
to reconnect to the server. The default 
value is 5 attempts.

Communications
Timeout

Specify the maximum time to wait for a 
response. If the response time exceeds 
the maximum specified, a dialog box 
opens and prompts for whether or not you 
want to continue waiting. The default 
value is 45 seconds.

Always prompt for
confirmation 
before applying
task

Open a confirmation dialog box before 
each task is applied. 

Table 47 (Continued)
Passport user preferences for Embedded Nodal Provisioning

Preference type Preference Use when you want to...
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Table 48
MPE user preferences for Embedded Nodal Provisioning

Preference type Preference Use when you want to...

Open:

Access Mode Shared Start a multiple user Embedded Nodal 
Provisioning session.

Sole-commit Start Embedded Nodal Provisioning and 
lock the configuration until you commit or 
exit the provisioning session.

Read only Start Embedded Nodal Provisioning with 
read access only. 

Configuration Running Start Embedded Nodal Provisioning with 
with the running configuration. The 
running configuration reflects the system 
view of configuration data currently in 
effect on the MPE.

Previous Running Start Embedded Nodal Provisioning with 
the rollback configuration. 

Other Start Embedded Nodal Provisioning with 
a specific configuration file. You can 
select the Keyed, Dated, or User 
Specified options. The default is Keyed. 

Always Prompt Before Open 
Configuration

Specify whether or not to open a dialog 
box that lets you select the candidate 
configuration and access mode 
whenever you select a new device. This 
setting is the default option.

Save:

Save 
Configuration

User Specified Save the configuration to a specific file. 
You can specify the filename using the 
Keyed, Dated, or User Specified options. 

Always Prompt Before Save 
Configuration

Open a confirmation box before you save 
a configuration.

Commit:

 (Sheet 1 of 3)
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Commit 
Configuration

Commit confirmation required Specify whether or not you want to 
display a dialog box that prompts before 
making the configuration permanent by 
committing it. The dialog box also lets you 
specify the maximum time to wait for 
confirmation before rolling back to the 
previous configuration. 

With the confirm option in effect, 
whenever you commit a configuration, a 
timer starts. If a confirmation of the new 
running configuration is not specified 
within the time frame, a rollback to the 
previously working configuration occurs.

Wait period for confirmation 
(min.)

Modify the time to wait for a confirmation. 
The default time is five minutes. If no 
confirmation occurs within the specified 
time, then the configuration rolls back to 
the previous running configuration.

Always Prompt before Commit 
Configuration

Specify whether or not to open the 
Commit Confirmation dialog box 
whenever you commit a configuration.

Admim:

Task Repair 
Timeout

Specify a maximum time to retain a 
provisioning session while repairing a 
task. The default value is 5 minutes.

 Prov Session
Retry Interval

Specify the time interval between 
attempts to obtain the node’s provisioning 
session. The default value is 1 minute.

Table 48 (Continued)
MPE user preferences for Embedded Nodal Provisioning

Preference type Preference Use when you want to...
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Server 
Reconnect

 Specify the maximum number of attempts 
to reconnect to the server. The default 
value is 5 attempts.

Communications
Timeout

Specify the maximum time to wait for a 
response. If the response time exceeds 
the maximum specified, a dialog box 
opens and prompts for whether or not you 
want to continue waiting. The default 
value is 45 seconds.

Table 48 (Continued)
MPE user preferences for Embedded Nodal Provisioning

Preference type Preference Use when you want to...
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Applying provisioning changes
When you apply provisioning changes, you may be prompted to confirm the 
apply operation. The prompt depends on your user preferences. If the prompt 
option is set, the dialog box opens before each task is applied so that you can 
modifying the options for applying provisioning changes. If not, the task is 
applied using the existing user preferences. 

When you apply a task, semantic checks are done and, if successful, the 
provisioning changes are made to the current node view or candidate 
configuration. 

Procedure steps
1 To apply your provisioning changes, select one of the following actions: 

• Select a task and then in the Provisioning Task panel, click Apply. 

• Select a task and the on the Task menu, click Apply Task. 

• Right-click a task and then select Apply Task from the pop-up menu.

2 Depending on the user preferences in effect and the type of device being 
provisioned. If set, you may be prompted before 

• an apply process

• a save view or commit configuration process

If these preferences are set, make changes to the preset selections, as 
required, and click OK. If these preferences are not set, the apply 
operation proceeds without any prompts.
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Viewing the Task Application Queue
Use this procedure to display or hide the Task Application Queue in a panel 
at the bottom of the Embedded Nodal Provisioning window. The queue 
displays the tasks that are pending and the order in which they will be applied 
to the device.

Procedure
1 To open the Task Application Queue, on the View menu, click to select 

Task Application Queue.

2 To close the Task Application Queue, on the View menu, click to clear 
Task Application Queue.
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Viewing the state of the provisioning session
Use this procedure to display the state of the provisioning session. 

Procedure
1 On the View menu, click Provisioning Session.... 

If the provisioning session is in use, you are provided details on who is 
using the session.
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Canceling the application of a single provisioning task 
Use this procedure to cancel the application of a single task.

Prerequisites
This procedure requires that the following condition is met:

• The task must be waiting for a provisioning session in the Task 
Application Queue.

Procedure
1 In the Task Application Queue, select the task whose application you 

want to cancel.

2 Complete one of the following steps:

• In the Task menu, select Cancel Application.

• Right-click on the task in the Task Application Queue, and from the 
pop-up menu, select Cancel Application.

The task icon changes to the “Open” icon, and the task is removed from 
the Task Application Queue.
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Canceling the application of multiple provisioning tasks
Use this procedure to cancel the application of one or more tasks showing in 
the Task Application Queue.

Prerequisites
This procedure requires that the following condition is met:

• There is more than one task waiting for a provisioning session in the Task 
Application Queue.

Procedure
1 Complete one of the following steps:

• On the Task menu, click Cancel Applications

• Right-click on the task in the Task Application Queue, and from the 
pop-up menu, select Cancel Applications.

The Cancel Applications dialog box opens. It displays all of the 
provisioning tasks that have been applied, but are waiting for the 
provisioning session to be free.

2 Select one or more of the provisioning tasks.

3 Click OK.

The Cancel Applications dialog box closes. The icons on the selected 
tasks change to the Open icon, and the selected tasks are removed from 
the Task Application Queue.
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Concurrent provisioning conflicts and resolution
See the table “Concurrent provisioning conflicts and resolution” (page 467) 
for information on identifying and resolving conflicts arising from having one 
or more persons provisioning at the same time.

Table 49
Concurrent provisioning conflicts and resolution

Conflict condition Remedial action

Concurrent component creation
Two people try to create the same component on 
the same device, the first person to activate or 
commit the component creation on the device 
succeeds. When the second person tries to 
activate or commit the component creation, the 
activation fails because the component already 
exists in the current view or candidate 
configuration.

The second person can create a different 
component ID, or remove the component 
creation action from the task being applied, or 
create the new change action on the same 
component.

Concurrent component modification 
Two people try to modify the same component on 
the same device, the last person to activate or 
commit the component modification on the device 
succeeds. The first person to activate or commit 
will not know that their modifications may have 
been lost, and the second person to activate or 
commit will not know that they may have 
overwritten another person’s changes.

Reduce the chance of concurrent component 
modification conflict by clicking Refresh on the 
component modification form as close as 
possible to the time of activating or committing 
for that component modification.
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Error messages
The table “Error messages” (page 470) describes the error messages that you 
may encounter while using Embedded Nodal Provisioning.

If error messages are encountered during Passport Check Prov, you are asked 
if you wish to keep the provisioning session open while they fix the problem. 

If an attempt to create a service is only partially successful, a Service Creation 
Errors dialog opens. The provisioning session remains open while the Service 
Creation Errors dialog is open.

In both cases, as long as the provisioning session is held by the task, the task 
repair timeout value is used to limit the amount of time you hold onto the 
provisioning session. If required, you can change the default value for Task 
Repair timeout. See “Setting user preferences for Embedded Nodal 
Provisioning” (page 456).

Concurrent component deletion 
Two people try to delete the same component on 
the same device, the first person to activate or 
commit the component deletion on the device 
succeeds. When the second person tries to 
activate or commit the component deletion, the 
deletion fails.

Remove the component deletion action from 
the task being applied.

Concurrent service template activation
Two people try to create the same service on the 
same device, the first person to activate or 
commit the service creation succeeds. When the 
second person tries to activate or commit the 
service creation, the service creation may fail if 
both of the service templates defines the same 
component creations, deletions, and 
modifications.

The second person needs to change the 
component instance IDs that are set in the 
service template form.

Table 49 (Continued)
Concurrent provisioning conflicts and resolution

Conflict condition Remedial action

 (Sheet 2 of 2)
241-6001-610   15.1RSUP   



Chapter 12 Embedded Nodal Provisioning   469
When the timeout value has elapsed, you are prompted to confirm that you 
still want to hang on the provisioning session. You are given thirty seconds to 
respond to the prompt. If you do not respond in this time frame, the 
provisioning session is released and the entire task application fails. Other 
tasks pending application in the Task Application Queue are not processed 
until you acknowledge the task failure. At this point, you are given the chance 
to cancel one or more of the pending applications.

If the provisioning session to the device is lost, Embedded Nodal 
Provisioning automatically tries to re-establish the connection a specific 
number of times. If required, you can change the default value for the 
provisioning session retries. See “Setting user preferences for Embedded 
Nodal Provisioning” (page 456). If the connection cannot be reestablished, 
Embedded Nodal Provisioning terminates with an error message.

If Embedded Nodal Provisioning is in the process of applying a task when the 
server connection is lost, one of the following occurs:

• If the connection is lost before the new node view is saved or applied, the 
provisioning changes are lost.

• If the connection is lost after the new node view is saved, but before it is 
applied, the provisioning changes are in the saved view, but are not active 
on the device. You need to manually apply the saved view.

• If the connection is lost after the new node view is applied, but before the 
activation or commit is confirmed or, you must manually confirm the 
activation or commit.
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Table 50
Error messages

Error condition Error message Remedial action

Cannot connect to the 
Configuration Manager 
server. This can occur when 
you start Passport Shelf 
View and it cannot connect 
to the ConfigMan server, or if 
the connection to the server 
cannot be established when 
a provisioning action is 
initiated from Passport Shelf 
View.

Unable to connect to the 
Configuration Manger 
Server. Verify that the 
server is running and 
that there is no value 
defined for the server 
port.

Check to ensure that 
Configman, MNSD, and MNSD 
agent are running.

Connection to the 
Configuration Manager is 
lost.

The connection to the 
Configuration Manager 
Server for provisioning 
has been lost. Verify 
that the server is 
running.

Restart the server, if required.

Semantic check completed 
with errors during the 
application of the 
provisioning task. The actual 
node semantic check error 
message is also displayed in 
this dialog

Passport semantic check 
completed with errors.
[Passport Check Prov 
Error Message]
This task will not be 
activated. Do you wish to 
retain the provisioning 
session while you repair 
the problem? 

Click Yes or No to acknowledge 
the error and to optionally retain 
the provisioning session while 
repairing the problem. Click. The 
Task Repair Timeout is applied 
to this dialog. The dialog 
automatically selects No and 
closes after waiting for the 
timeout value. You are shown 
the remaining amount of time 
before timeout on the “No” 
button.

 (Sheet 1 of 5)
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Errors from semantic check; 
provisioning session 
released.

This message is displayed if 
the semantic check 
completed with warnings/
errors during the application 
of a provisioning task. You 
selected to release the 
provisioning session.

Passport semantic check 
completed with errors.
[Passport Check Prov 
Error Message]
This provisioning 
session has been 
released. Do you wish to 
proceed with activation 
of the remaining tasks.

Click Yes or No to optionally 
proceed with other task 
activations in the queue. Until 
you respond, no other tasks in 
the Task Application Queue are 
applied, even though the 
provisioning session has been 
released.

Semantic check completed 
with warnings during the 
application of a provisioning 
task. The actual semantic 
check warning message is 
also displayed in this dialog.

Passport semantic check 
completed with warnings 
[Passport Check Prov 
Warning Message]
Do you wish to retain the 
provisioning session 
while you repair the 
problem?

Click Yes or No to acknowledge 
the warning message and 
optionally retain the provisioning 
session while repairing the 
problem. The Task Repair 
Timeout is applied to this dialog. 
The dialog automatically selects 
No and closes after waiting for 
the timeout value. You are 
shown the remaining timeout on 
the No button.

Semantic check completed 
with warnings during the 
application of a provisioning 
task. You selected to release 
the provisioning session.

Passport semantic check 
completed with warnings 
[Passport Check Prov 
Warning Message]
The provisioning session 
has been released. Do you 
wish to proceed with the 
activation of the 
remaining tasks.

Click Yes or No to optionally 
proceed with other task 
applications in the queue. Until 
you respond, no other tasks in 
the Task Application Queue are 
applied, even though the 
provisioning session has been 
released.

Table 50 (Continued)
Error messages

Error condition Error message Remedial action
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Errors encountered while a 
service is being created on 
the device

Service Creation errors dialog 
box opens.

See the procedure “Repairing 
Passport service creation errors 
overview” (page 194)

Provisioning servers are 
unable to connect to the 
device either to read data 
from the node or provision 
data on the device.

Unable to connect to [Passport 
name] for provisioning. 

Insufficient provisioning 
privileges on the device

The device authentication dialog 
box opens.

See the procedure “Starting 
Embedded Nodal Provisioning” 
(page 412)

Unable to Create/Modify/
Delete Component because 
the provisioning actions in 
the task could not be 
performed on the current 
node view

Activation failed for [task name]. 
Unable to [create/modify/delete] 
[component name].

[Passport error message].

The task will not be activated. Do 
you wish to retain the 
provisioningsession while you 
repair the problem?

Click Yes or No to acknowledge 
the application failure and 
optionally retain the provisioning 
session while repairing the 
problem. The Task Repair 
Timeout is applied to this dialog. 
The dialog automatically selects 
No and closes after waiting for 
the timeout value. You are 
shown the remaining timeout on 
the No button.

Table 50 (Continued)
Error messages

Error condition Error message Remedial action
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Unable to Create/Modify/
Delete Component because 
the provisioning actions in 
the task could not be 
performed on the current 
node view. You have chosen 
to release the provisioning 
session.

Activation failed for [task name]. 
Unable to [create/modify/delete] 
[component name].

[Passport error message].

The provisioning session has 
been released. Do you wish to 
proceed with the activation of the 
remaining tasks?

Click Yes or No to optionally 
proceed with other task 
applications in the queue. Until 
you respond, no other tasks in 
the Task Application Queue are 
applied, even though the 
provisioning session has been 
released.

If a component could not be 
deleted because it does not 
exist in the current view, remove 
the component from the 
provisioning task.

If a component could not be 
created because if already 
existed in the current view, 
remove the component from the 
provisioning task, or assign 
another component instance ID 
to it in the Component Creation 
form, or change the Add action 
into a change action.

If a component could not be 
modified because it does not 
exist in the current view change 
the component modification 
action to a component creation 
action.

Table 50 (Continued)
Error messages

Error condition Error message Remedial action
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In a Component Modification 
form, the Embedded Nodal 
Provisioning is unable to 
retrieve the component data 
from the node, possibly 
because the component to 
be modified has been 
deleted from the current 
node view.

Unable to refresh the form for 
[component name]. 

[Passport error message] 

Check if the component to be 
modified has been deleted from 
the current node view.

An attribute in an applied 
task is invalid according to 
the CDL range and type

An invalid value has been 
specified for [attribute name] in 
[provisioning action name]. Enter 
a value in the valid range and 
apply the task again.

Enter a valid attribute and tgeb 
reapply the task.

Internal software error 
detected in the provisioning 
window.

An internal software error has 
occurred in the ENP provisioning 
window. The provisioning 
window will now close.

The Embedded Nodal 
Provisioning window closes. 
This is unlikely to affect the 
operation of Passport Shelf 
View. Only errors affecting the 
Java virtual machine, such as an 
out of memory error, will cause 
Passport Shelf View to shut 
down.

Table 50 (Continued)
Error messages

Error condition Error message Remedial action
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Starting other MDM tools from Embedded Nodal 
Provisioning

Use this procedure to start a selection of other MDM tools from the 
Embedded Nodal Provisioning window: 

Procedure
1 On the External tools menu, click one of the following:

• Nodal Provisioning

• Nodal Provisioning Template Editor

• Service Provisioning -> ATM 

• Service Provisioning -> Frame Relay 

• Service Provisioning -> IP VPN 

• Service Provisioning -> IP VPN Provider Edge
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Index
A
adding a component 152
adding a link dropsite in template editor 286
adding a service 178
adding groups in template editor form layout 

tree 301
adding subcomponents in the template editor 

component layout tree 277
adding the first top-level component in the 

template editor component layout 
tree 274

ANP nodal provisioning forms 107
component form 107
service form 115

ANP nodal provisioning main window
component pop-up menu 80
service palette 80, 102

architecture 28
attribute descriptive help

accessing 146
attribute details in template editor

modifying 306
attribute range tool tip help

accessing 148

C
CDL version

selecting in template editor 258
component

adding a component 152
Preside 
compressing 125
deleting 165
expanding 124
searching 126

Component Data panel 329, 338
component data report

copying to a text editor 376
on subset of component data 362

component data reports
removing rows 359

component form
about 107

component hierarchy navigation tasks
compressing a component 125
expanding a component 124

component model file 32
component model generator 31, 34
component parent designation

selecting 290
component provisioning procedures

adding a component 152
deleting a component 165

Component Selection panel 338
compound filter 340
compressing a component 125
CONFIGMAN 31

see configuration manager 31
configuration manager 30
configuration server

Passport configuration server 31, 33
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creating a new service template 257
creating and saving service data reports 360

D
date convention 34
deleting a component 165
details panel in component layout tab

description 232
details panel in template editor main 

window 237
device configuration servers

Passport configuration server 31, 33

E
Edit menu for the report generator tool main 

window 333, 334
Embedded Nodal Provisioning

interface description 390
emplate editor procedures

saving service template files 308
expanding a component 124

F
File menu - report generator tool main 

window 332
filter dialogs 339

compound filter 340
simple filter 340
sub-filter

sub-filter 341
form layout tree in template editor

adding groups 301
hiding components 303
removing groups 302
removing tabs 300
showing components 304

H
Help

accessing from the ANP nodal provisioning 
main window 145
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on component forms 147
on service forms 147
on service template forms 147

hiding component in form layout tree in 
template editor 303

hierarchy model file 32

M
menu bar

template editor 231
menu bar for report generator tool 332
model files 32, 34

component model 32
hierarchy model 32
service model 32
service template model 32

modifying attribute details in template 
editor 306

modifying template identification 
attributes 272

O
opening a service template file 256
overview 25

P
Passport configuration server 31, 33
PCSERVER

see Passport configuration server 31, 33

R
removing a component in template editor form 

layout tree 305
removing a dropsite in template editor 289
removing groups from form layout tree in 

template editor 302
removing tabs in form layout tree in template 

editor 300
report generator tool

component data report 376
component data reports on subset of 
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component data 362
compound filter 340
creating and saving service data 

reports 360
filter dialogs 339
menu bar 332
overview 329
procedures 344
removing rows in component data 

reports 359
sub-filter 341
using 344

report generator tool main window 329
Component Data panel 338
Component Selection panel 338
Edit menu 333, 334
File menu 332
menu bar 332
Selected menu 335
Title field 338
Tool bar 337
Tools menu 335

S
sample outputs for version checking tool 316
saving service template files

308
searching for a component 80, 126
Selected menu for report generator tool main 

window 335
selecting a component parent designation in 

template editor 290
selecting a parent dropsite in template 

editor 284
service data reports

creating and saving 360
service form

about 115
service model file 32
service palette

about 80, 102
Preside 
service creation templates 80, 102
service provisioning procedures

adding a service 178
service template

see Service Template Editor
Service Template Editor

overview 32, 33
service template file

opening 256
service template files

location 228
saving 308

service template model file 32
service templates

about 80, 102
showing components in template editor form 

layout tree 304
simple filter

report generator tool
simple filter 340

starting the ANP nodal provisioning application
on a workstation running NMS

with context 46
starting the version checking tool 316
STE

see Service Template Editor

T
tabs and groups in template editor

renaming 297, 298
template editor 227

Choose CDL Version dialog 258
selecting a CDL version 258
starting 251
tabs and groups 297, 298
version checking tool 315

template editor dialogs
Choose CDL Version 258

template editor form layout
adding tabs 299

template editor main window
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after loading a service template file 230
component layout tab details panel 232
details panel 237
form layout tab 240
menu bar 231
template identification panel 236

template editor main window after loading a 
service template file 230

template editor procedures
adding a component attribute 275
adding a link dropsite 286
adding groups to the form layout tree 301
adding subcomponents 277
adding tabs to the form layout tree in 

template editor 299
adding the first top-level component 274
creating a new service template 257
hiding a component in the form layout 

tree 303
modifying attribute details 306
modifying template identification 

attributes 272
opening a service template file 256
removing a component from the form layout 

tree
form layout tree in template editor

removing a component 305
removing a dropsite 289
removing groups from the form layout 

tree 302
removing tabs from form layout tree 300
renaming tabs and groups 297, 298
selecting a component parent 

designation 290
selecting a parent dropsite 284
showing components in the form layout 

tree 304
template identification attributes

modifying 272
template identification panel in template editor 

main window 236
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Tool bar for report generator tool main 
window 337

Tools menu for report generator tool main 
window 335

U
using the report generator tool 344

V
version checking tool

about 315
sample outputs 316
starting 316

Version Selection dialog 61
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